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Floral Meristem Termination in Aquilegia 

ABSTRACT 

The persistent activity of stem cells in meristems is the foundation of continuous growth in plants. 

During the reproductive phase, vegetative meristems that produce leaves will be converted into 

floral meristems (FMs) to produce flowers. Unlike the vegetative meristems, which can generate new 

leaves continuously throughout the lifespan of a plant, the stem cell activity in a FM will always 

terminate at a specific time point, since each flower only has a finite number of organs. Floral 

meristem termination (FMT) is, therefore, one of the defining features of FM identity and variation 

in the timing of FMT is an essential source of generating floral morphological diversity. However, 

how this process is fine-tuned at a developmental and evolutionary level is still poorly understood. 

In this dissertation, I have sought to lay the groundwork for understanding how FMT is regulated in 

Aquilegia and thereby promote Aquilegia as a model system for studying FM regulation. In Chapter 1, 

I conducted in-depth transcriptome sequencing of finely dissected developmental stages of the FM 

of A. coerulea, covering the developmental window before and after FMT, and identified key genes 

that function as hub loci in major genetic modules or mark the transitions between key 

developmental stages. In Chapter 2, I analyzed how the dynamic between cell proliferation and cell 

expansion changes during primordia initiation and FMT using a newly developed quantitative live-

confocal imaging method. This was the first live-imaging application for FMs that produce more 

than four whorls of floral organs with an apocarpous gynoecium and was the first investigation of 
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cell behavioral dynamics during the FMT developmental window in any plant. In Chapter 3, I used 

stamen whorl number as a quantitative trait to represent the timing of FMT and conducted QTL 

mapping in the F2 progeny of a cross between two sister species, A. brevistyla and A. canadensis. I 

discovered that the genetic architecture underlying variation in the timing of FMT consists of 

multiple QTL, each with moderate to small effect. By integrating the results of Chapter 1 and 3, I 

have also been able to generate the first list of candidate genes that may participate in the regulation 

of FMT timing.  
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What happens when stem cells are no longer needed? 
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The aesthetic appeal of the seemingly infinite variety of floral form dates to the earliest days 

of human civilization. From a developmental perspective, flowers are produced by floral meristems 

(FMs), a specific category of plant meristem (Steeves & Sussex, 1989). Meristems are typically domes 

of stem cells that lay the foundation for the continuous developmental processes observed in plants. 

A vegetative shoot meristem, for instance, produces leaves, stems and branches continuously 

throughout the lifespan of a plant. By contrast, FMs produce the floral organs with little or no stem 

and no branching. 

In the early 1800’s, the foundation of understanding the developmental dynamics of plant 

meristems in general and FMs in particular was established using early microscopes to document the 

initiation and development of floral organs (e.g., Guillard, 1835; Duchartre, 1845; Payer, 1857). 

Today we are still seeking to characterize these same processes, but using far more advanced 

microscopes in combination with modern molecular genetics. Although we have gained an 

enormous amount of knowledge concerning the mechanisms regulating floral organ initiation, organ 

identity determination, and organ elaboration, an essential component is still lacking: the 

mechanisms controlling floral meristem termination (FMT), which is the regulated termination of 

stem cell activity in the FM. FMT represents one of the defining features of a FM relative to a 

vegetative meristem, which can produce an indeterminate number of leaves while the number of 

organs produced by a FM is always finite. In this Introduction, I will elaborate on why 

understanding FMT is fundamental to our knowledge of floral development and evolution, 

summarize our current progress in the molecular basis of FMT, and highlight some pressing and 

intriguing questions about the regulation of FMT. In addition, I will explain why Aquilegia is an ideal 

model system for addressing the gaps in our understanding of FMT, and how the studies from this 

dissertation will lay the groundwork for in-depth investigation of FMT in Aquilegia.  
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The nature of FMT and its contribution to floral diversity 

Following the transition to reproductive growth, plants shift from producing vegetative 

shoot meristems to producing those with FM identity, which will give rise to the flowers themselves 

(Steeves & Sussex, 1989). This transition in meristem identity is marked by a number of changes in 

meristem behavior. Many aspects of this behavioral change, such as changes in phyllotaxy and the 

length of internodes, are developmental shifts that the shoot meristems exhibit in other phases of 

vegetative growth. However, some aspects are unique to the FM, particularly the production of 

lateral organs with different floral identities and the timed termination of meristem activity following 

production of a specific number of floral organs, which I have termed FMT.  

Interestingly, the establishment of floral organ identity and the termination of the FM are 

tightly interconnected processes. A typical flower consists of four types of floral organs with defined 

positions relative to each other: sepals are in the outermost positions of a flower, followed by petals, 

then stamens, and finally carpels in the innermost position (Fig. 1). Therefore, unlike the vegetative 

meristems that always maintain a constant pool of stem cells and can theoretically produce organs 

continuously throughout the lifespan of a plant, the activity of a FM will always cease after a period 

of successive initiation of organs, and the remaining cells in the center of the floral apex will 

generally be incorporated into building carpels (the only exceptions being unisexual male flowers 

that never initiate carpels, a very rare phenomenon). The precise timing of FMT ensures that the 

correct number of organs are initiated, and the coordination between FMT and the floral organ 

identity programs ensures that all necessary floral parts are generated.  

Variation in floral form can be generated through FMT in many ways. Floral organs are 

initiated in the peripheral zone of the FM in spirals or whorls (i.e., concentric rings), and thus 

variation in FMT directly gives rise to different numbers of whorls (or the total number of floral 
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organs in the case of spiral phyllotaxy). Consistent with this, an incredible range of floral organ 

numbers is observed in every major lineage of the flowering plants. Although the number of organs 

per whorl can vary, this value typically ranges only from two to five, meaning that significant 

increases in floral organ number are primarily associated with delays in FMT. Furthermore, delays in 

FMT most commonly give rise to an increase in stamen whorl numbers rather than carpels 

(Endress, 2011; Ronse De Craene, 2018). This reflects the fact that the number of carpels in a flower 

seems to be tightly correlated with whether the flower forms a syncarpous or an apocarpous 

gynoecium. A syncarpous gynoecium consists of a whorl of carpels that are fused into a single 

functional unit (Endress, 2014, 2019), while an apocarpous gynoecium is comprised of free carpels 

that remain distinct from each other at maturity. From a developmental perspective, these two 

morphologies have very different implications. In a flower with a syncarpous gynoecium, the floral 

apex is typically consumed by the production of a single, congenitally fused primordium that 

integrates all of the individual carpel primordia. In contrast, in flowers with apocarpous gynoecia, 

the floral apex will not be immediately consumed as the first carpels arise but, rather, will persist 

until the appropriate number have been produced. (Endress, 2014). It is observed that flowers with 

a large number of carpels almost always have apocarpous gynoecia (Endress, 2011). This is 

particularly evident in lineages that are nested within clades that otherwise have very stable carpel 

numbers and syncarpous gynoecia, such that the transition to apocarpous gynoecia is consistently 

accompanied with a dramatic increase in carpel numbers. For instance, many taxa in the Alismatales 

of the monocots, Rosaceae and Malvaceae of rosids, and Apocynaceae of the asterids have 

numerous unfused carpels, while their syncarpous relatives all have no more than five carpels 

(Igersheim et al., 2001; Endress, 2011, 2014; Ronse De Craene, 2018). 

The relationship between carpel numbers, gynoecium structure, and FMT is very interesting 

from a developmental perspective because carpels are always the last organs that are produced in a 
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flower, meaning that different gynoecia types might impose differing constraints on the nature of 

FMT. To construct a syncarpous gynoecium, a tight coordination in the timing of FMT and carpel 

primordia initiation is necessary, which in turn is predicted to impose strong constraints on the 

number of carpel primordia. Any degree of indeterminacy in such a flower has the potential to 

completely disrupt carpel and fruit development, significantly impacting fitness. On the other hand, 

since each carpel is an individual functional unit in an apocarpous gynoecium, the coordination 

between primordia initiation and FMT might be expected to be more flexible. Indeed, in addition to 

the above-mentioned correlation between apocarpy and an increase in carpel numbers, greater 

variation in carpel numbers is also observed in taxa with apocarpous gynoecia compared to those 

with syncarpous gynoecia (Endress, 2011, 2014).  

Although every major lineage of the flowering plants exhibits a large range of floral organ 

whorl numbers, in some clades, the range is set by a few outlier taxa with extremely high whorl 

numbers while the majority of the members have only a few whorls with no variation. In fact, the 

transition from variable to stable whorl numbers in a flower is considered as a critical, consistent 

trend in the evolution of floral form (Endress, 1990). The majority of taxa in the asterids, rosids, and 

monocots have what are considered canalized floral structures, including a fixed number of floral 

whorl numbers (normally four or five whorls only), while the sister lineages of those groups display 

a much wider variation (Endress, 1990, 2011; Endress & Doyle, 2009; Ronse De Craene, 2018). In 

fact, such a variation is not only exhibited between species or genera, but also among plants of the 

same species, same population, and even the same individual (Diggle, 1995; Kitazawa & Fujimoto, 

2014, 2016; Wang et al., 2015), indicating a high degree of flexibility in the timing of FMT. 

Furthermore, lineages with stable whorl numbers tend to have lower whorl numbers compared to 

those with variable whorl numbers (Endress, 1990, 2011). The trend towards reduction in floral 

whorl numbers was also supported by the reconstruction of the ancestral angiosperm flower, which 
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was proposed to have at least nine whorls of organs, but the most probable ancestors of the 

Monocotyledoneae and the Eudicotyledoneae had five and seven whorls of organs, respectively 

(Sauquet et al., 2017). Among the Eudicotyledoneae, ancestral reconstruction revealed additional 

reductions in the total whorl numbers, such that the ancestors of the Pentapetalae, representing 70% 

of all angiosperm species, had five floral whorls while several major lineages within the clade have 

only four (Sauquet et al., 2017). Investigations in how regulations of FMT become canalized in 

different lineages will thus provide us valuable insight into major processes shaping angiosperm 

evolution. 

Of course, stamen and carpel numbers are not merely a phylogenetic trait, they relate directly 

to aspects of plant fitness by determining how much pollen and ovules are produced and may reflect 

adaptation to different pollination strategies. It is observed that excessively high stamen numbers 

occur frequently in brush flowers that are pollinated by large animals, including beetles, bats, and 

birds (Endress, 2011). On the other hand, low and fixed stamen numbers are found in flowers with 

highly specialized structures, such as the gynostemium in Orchidaceae (Endress, 2011). An increase 

in the number of whorls also allows for the evolution of new organ types. For example, staminodes 

in many taxa are originated from modified stamens that have evolved highly elaborated 

morphologies and serve distinct functions such as pollinator attraction (Walker-Larsen & Harder, 

2000). The evolution of such novel organs is not favored to occur when pollen production is 

limiting, meaning that higher stamen numbers are commonly correlated with the evolution of novel 

floral organ identities. 

 

Molecular basis of FMT 

In the FM, the stem cell population is maintained by a negative feedback loop between the 

critical loci WUSCHEL (WUS) and CLAVATA3 (CLV3) (Schoof et al., 2000; Lenhard, 2003; 
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Müller et al., 2006). WUS specifies the stem cell identity and encodes a homeodomain protein, which 

functions non-cell autonomously to activate the expression of CLV3. Meanwhile, the small peptides 

encoded by CLV3 diffuse into the WUS expression domain and activate a signal transduction 

cascade that limits WUS expression. This feedback loop both promotes stem cell identity and 

regulates the homeostasis of the stem cell population so that it is never too large or small. At the 

molecular level, FMT is marked by the cessation of stem cell activity in the FM, which corresponds 

to elimination of WUS expression. At the same time, the floral organ identities are established early 

in the FM by the so-called ABC program, in which three classes of genes function in different 

combinatory codes to determine the four types of floral organs: A-class genes alone specify sepals, A 

and B together specify petals, B and C together control stamens, and C-class genes alone control the 

carpel identity (Coen & Meyerowitz, 1991). The C-class gene AGAMOUS (AG) and WUS also form 

a feedback loop, in which the expression of AG is activated by WUS in the center of the FM, while 

AG is ultimately responsible for FMT by negatively regulating the expression of WUS (Lenhard et 

al., 2001). What is particularly interesting about this feedback loop is that the activation of AG by 

WUS and the termination of WUS by AG do not occur simultaneously, and thus the lag between 

these two regulatory interactions determines how long the stem cells in the FM can proliferate, i.e., 

the timing of FMT.  

Over the past decades, the broad functional conservation of WUS, AG, and the WUS-AG 

feedback loop has been widely demonstrated in various angiosperm model systems (Nardmann & 

Werr, 2006; Litt & Kramer, 2010; Whitewoods et al., 2020). We have also obtained a breadth of 

knowledge about how AG is regulated at all levels, from transcription to protein interactions. 

However, most of these regulatory steps function upstream of the AG-WUS feedback, and most 

studies have focused on loss-of-function mutations that lead to an uncontrolled proliferation of the 
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FM and, therefore, provide little information on how the time lag between the activation of AG and 

FMT is achieved.  

To date, two pathways are known to act through AG to terminate the expression of WUS. 

On the one hand, in A. thaliana, AG has been shown to bind to the WUS locus in vivo and recruit 

Polycomb group (PcG) proteins to directly repress WUS expression (Liu et al., 2011). On the other 

hand, in both A. thaliana and tomato (Solanum lycopersicum), AG also acts to indirectly terminate WUS 

via the C2H2 zinc-finger transcription factor KNUCKLES (KNU). How the activation of KNU is 

used as a “timer” was demonstrated through a series of elegant experiments (Sun et al., 2009, 2014). 

AG activates KNU by occupying the PcG complex binding site on its promoter, which prevents the 

addition of epigenetic repressive markers onto KNU. It takes roughly two rounds of cell divisions (~ 

2d) to sufficiently dilute the repressive markers and allow the expression of KNU, during which the 

stamen primordia initiate, and after which KNU immediately terminates WUS to achieve FMT. 

Either delay or acceleration in the cell cycle also delay or accelerate the induction of KNU and FMT, 

respectively (Sun et al., 2014). In addition, the expression of KNU is necessary to maintain a stable 

epigenetic silencing of WUS at the chromatin level (Sun et al., 2019). 

A third known pathway for FMT in A. thaliana is through the gene SUPERMAN (SUP), 

which appears to function in an AG-independent manner (Xu et al., 2018). SUP encodes a C2H2 

zinc-finger transcriptional repressor and is expressed in a very tight boundary between the stamen 

and carpel whorls (i.e. the B/C boundary) during a limited developmental window early in the FM. 

This expression domain appears to be key to preventing expression of the B-class genes from 

entering the carpel whorl, as sup mutant flowers have extra stamens and defective carpels (Bowman 

et al., 1992; Prunet et al., 2017). At the organ boundary, SUP also directly represses auxin 

biosynthesis genes, an action which appears to have a non-cell-autonomous effect on the stem cell 

population in the FM such that in sup mutants (Xu et al., 2018). Auxin levels are increased at the 
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boundary but decreased in the center of the FM, leading to a slightly enlarged stem cell population 

and slightly prolonged activity of the FM (Xu et al., 2018). 

How can variation in the timing of FMT be generated? 

The above-mentioned studies have provided important insight into the molecular basis of 

FMT, but two key questions are still remaining: 1) Are these pathways are conserved in other taxa? 

and 2) What is regulating the fine-tuning of FMT timing to generate flowers with different whorl 

numbers?  

Although the AG-KNU-WUS pathway has been elegantly demonstrated in A. thaliana and 

tomato (Sun et al., 2009, 2014; Bollier et al., 2018), both systems make flowers with only four whorls. 

Particularly, since the duration of KNU activation only allows for the initiation of one whorl of 

stamens, it begs the question of how this pathway could function in taxa with more than one whorl 

of stamens. Moreover, whether AG directly binds to the WUS locus to recruit epigenetic repression 

markers in other taxa requires further investigation. 

Regardless of whether the AG-KNU-WUS pathway is conserved, the “division-dependent 

epigenetic timer” model deserves attention when considering how FMT can be timed. Given two 

facts, 1) that the ag loss-of-function mutants are always associated with loss of determinacy (Litt & 

Kramer, 2010) and 2) that there always appears to be a lag between AG expression and FMT, it is 

reasonable to assume that, even if the function of KNU is lineage-specific, a functionally analogous 

factor is in place in other taxa, being activated by AG and responsible for repressing WUS. Under 

this circumstance, two components of this pathway can theoretically be modified to achieve flowers 

with additional whorls (Fig. 1a): either the activation of KNU (or other genes) by AG can be 

delayed, or the termination of WUS by KNU (or other genes) can be delayed. The delayed activation 

of KNU would be possible if there are, for instance, more epigenetic repressive markers covering the 

target locus, which would require more rounds of cell division to sufficiently dilute the marks and 



10 

allow for the expression of the negative regulator, allowing time for more whorls of organ initiation. 

Alternatively, it may be that KNU or its functional analog has lower affinity for the WUS promoter, 

requiring more time for protein to accumulate and achieve WUS repression. 

Orthologs of SUP have been described in a small number of plant taxa, such as rice and 

Petunia, all of which display similar mutant phenotypes consistent with the function of SUP 

homologs as B/C organ boundary genes (Nandi et al., 2000; Nakagawa et al., 2004). A recent study 

also demonstrated at the molecular level that the SUP ortholog in Medicago truncatula, MtSUP, 

functions to control both the B/C boundary and FMT, as well as the number of flowers produced 

per node (Rodas et al., 2021). These comparative studies suggest that it is likely that SUP homolog 

functions are conserved to a degree, but despite the studies in A. thaliana linking auxin concentration 

level to FMT via SUP, the molecular mechanism of how SUP regulates the timing of FMT is still 

lacking and no information is available on its conservation.  

The very narrow expression domain of SUP in the FM, both spatially and temporally, is 

quite intriguing because it is only expressed at the boundary between the stamen whorl and the 

carpel whorl immediately before the initiation of carpels, which, as mentioned above, are the last 

whorl of organs to be produced in most flowers. Moreover, the subtle changes in auxin levels 

observed in sup mutants are suggestive that the inception of FMT requires a certain threshold level 

of auxin (Xu et al., 2018). Floral organ initiation is an iterative process: the initiation of a new whorl 

of organs also means the establishment of a new boundary between the adaxial side of the primordia 

and the remaining FM, and this iteration ends with the establishment of a boundary between the last 

whorl of stamens and the carpels. Taking all this information together, one plausible model could be 

that during the early organ initiation process, auxin concentration must remain consistent across the 

most recently initiated whorl of primordia and the remaining FM. When the last whorl of stamen 

primordia is initiating, however, the expression of SUP leads to a decrease in auxin concentration at 
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the boundary and a slight increase in concentration in the FM itself, and this change disrupts the 

consistent iteration and acts as the signal that it is time to stop initiating organs (Fig. 1b). Thus, 

delaying expression of SUP could be critical to delay in FMT. 

Figure 1. Models of how multiple whorls of organs can be theoretically generated based on our current 
understanding of the molecular basis underlying FMT. (a) Models of how modifications on the AG-KNU (or other 
genes)-WUS could generate more than four whorls of organs. The 4 whorls diagram is based on what is known in 
A. thaliana. Flowers with 6 whorls can be generated either by a delayed activation of KNU (or other genes) by AG,
or by a delayed termination of WUS by KNU (or other genes). (b) Model of how SUP could act as the signal for the
initiation of the last whorl organ in a flower by changing the auxin concentrations. The organ-FM boundary
represents the boundary between the adaxial most edge of the newly initiated primordial whorl and the
remaining FM. When the newly initiated whorl is not the last whorl of stamens, relatively high auxin
concentration (indicated in red) can be found at the organ-FM boundary (black dotted lines) and in the newly
initiated primordia. If the newly initiated whorl is the last whorl of stamens, due to the expression of SUP at the
organ-FM boundary (pink dotted lines), the auxin concentration at the organ boundary decreases and while
simultaneously increasing in the FM, which contributes to FMT. Under this scenario, increasing whorl number
requires postponing SUP expression. Note, this diagram does not seek to indicate all potential locations of
increased auxin concentration and the sepal whorls are not shown in any of the FM diagrams (i.e., a single whorl
of sepals was assumed in all scenarios). p: petals; s: stamens; c: carpels.

Alternatively, there are several other molecular mechanisms that are used as “timers” in 

plants and animal development, which can be referred to as inspiration when considering how FMT 
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can be timed and how variation in the timing can be generated. For example, during somitogenesis 

in vertebrates, it has been found that the speed of initiation is partially dependent on the protein 

stability of the key genes and the speed of RNA splicing. By manipulating the number of introns in 

these key genes, the somitogenesis clock can be slowed down or accelerated (Hirata et al., 2004; 

Takashima et al., 2011). Similar complex patterns of transcription, RNA editing, and protein stability 

function in the regulation of the circadian clock in both plants and animals (Rosato et al., 2006; 

Creux & Harmer, 2019), opening the possibility that they could likewise function in other 

developmental processes. 

 

Aquilegia as a model system to investigate FMT 

The main reason for our lack of understanding of the regulation of FMT timing is that all 

currently established model systems belong to three main lineages of the flowering plants, and 

neither they nor their close relatives harbor any natural variation in floral organ whorl numbers. To 

this end, the genus Aquilegia is an ideal model system for providing crucial knowledge regarding 

FMT. Aquilegia belongs to the eudicot family Ranunculaceae, and contains approx. 70 species, which 

resulted from a recent adaptive radiation. Consistent with this, they share low interspecific sequence 

variation and a high degree of inter-fertility (Filiault et al., 2018). An Aquilegia flower consists of one 

whorl of sepals, one whorl of petals, multiple whorls of stamens, two whorls of staminodes (except 

for A. jonesii), and one whorl of carpels that form an apocarpous gynoecium (Munz, 1946; Tucker & 

Hodges, 2005). All of the floral organs initiate in whorls of five organs and initiate successively in 

alternate positions such that a flower contains 10 orthostichies (vertical rows of organs) (Tucker & 

Hodges, 2005). All Aquilegia species share this floral structure, but the number of stamen whorls 

often varies between different species (Munz, 1946; Tucker & Hodges, 2005). This natural variation 

in stamen whorl number provides an outstanding opportunity for investigating natural variation in 
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the timing of FMT: a flower with earlier FMT will have fewer whorls of stamens compared to a 

flower that experiences later FMT. In addition, the model species Aquilegia x coerulea ‘Origami’ has a 

fully sequenced and well-annotated genome, with established molecular tools, such as in situ 

hybridization and virus-induced gene silencing, available for gene functional studies (Kramer, 2009). 

During my Ph.D., I have sought to lay the groundwork for understanding how FMT is 

regulated in Aquilegia and thereby promote Aquilegia as a model system for studying FM regulation. 

In Chapter 1, I conducted in-depth transcriptome sequencing of finely dissected developmental 

stages of the FM of A. coerulea, covering the developmental window before and after FMT. In 

Chapter 2, we developed a quantitative live-imaging method and analyzed how the dynamic between 

cell proliferation and cell expansion changes during primordia initiation and FMT. In Chapter 3, 

utilizing the stable floral structure and the high inter-fertility of the Aquilegia species, I used stamen 

whorl number as a quantitative trait to represent the timing of FMT and conducted QTL mapping 

in the F2 progeny of a cross between two sister species, A. brevistyla and A. canadensis. 

Results from Chapter 1 provided us with broad transcriptomic data on the earliest stages of 

floral development in A. coerulea, including identification of key genes that function as hub loci in 

major genetic modules or mark the transitions between different developmental stages. The live-

imaging analysis in Chapter 2 represents the first live-imaging application for FMs that produce 

more than four whorls of floral organs and with an apocarpous gynoecium and was the first 

investigation of cell behavioral dynamics during the FMT developmental window in any plant. In 

Chapter 3, we discovered that the genetic architecture underlying variation in the timing of FMT 

consists of multiple QTL, each with moderate to small effect. By integrating the results of Chapter 1 

and 3, I have also been able to generate a promising list of candidate genes that may participate in 

the regulation of FMT timing.  



14 
 

REFERENCE 
 

Bollier N, Sicard A, Leblond J, Latrasse D, Gonzalez N, Gévaudant F, Benhamed M, Raynaud C, Lenhard M, Chevalier 

C, et al. 2018. At-MINI ZINC FINGER2 and Sl-INHIBITOR OF MERISTEM ACTIVITY, a Conserved Missing 

Link in the Regulation of Floral Meristem Termination in Arabidopsis and Tomato. The Plant Cell 30: 83–100. 

Bowman JL, Sakai H, Jack T, Weigel D, Mayer U, Meyerowitz EM. 1992. SUPERMAN, a regulator of floral homeotic 

genes in Arabidopsis. Development (Cambridge, England) 114: 599–615. 

Coen ES, Meyerowitz EM. 1991. The war of the whorls: genetic interactions controlling flower development. Nature 

353: 31–37. 

Creux N, Harmer S. 2019. Circadian Rhythms in Plants. Cold Spring Harbor Perspectives in Biology 11: a034611. 

Diggle PK. 1995. Architectural Effects and the Interpretation of Patterns of Fruit and Seed Development. Annual Review 

of Ecology and Systematics 26: 531–552. 

Duchartre PÉS. 1845. Observations sur l’organogénie de la fleur dans les plantes de la famille des Malvacées. 123–161. 

Endress PK. 1990. Patterns of floral construction in ontogeny and phylogeny. Biological Journal of the Linnean Society 39: 

153–175. 

Endress PK. 2011. Evolutionary diversification of the flowers in angiosperms. American Journal of Botany 98: 370–396. 

Endress PK. 2014. Multicarpellate gynoecia in angiosperms: occurrence, development, organization and architectural 

constraints: Multicarpellate Gynoecia in Angiosperms. Botanical Journal of the Linnean Society 174: 1–43. 

Endress PK. 2019. The morphological relationship between carpels and ovules in angiosperms: pitfalls of morphological 

interpretation. Botanical Journal of the Linnean Society 189: 201–227. 

Endress PK, Doyle JA. 2009. Reconstructing the ancestral angiosperm flower and its initial specializations. American 

Journal of Botany 96: 22–66. 

Filiault DL, Ballerini ES, Mandáková T, Aköz G, Derieg NJ, Schmutz J, Jenkins J, Grimwood J, Shu S, Hayes RD, et al. 

2018. The Aquilegia genome provides insight into adaptive radiation and reveals an extraordinarily polymorphic 

chromosome with a unique history. eLife 7: e36426. 

Guillard A. 1835. Sur la Formation et le Développement des Organes Floraux. 

Hirata H, Bessho Y, Kokubu H, Masamizu Y, Yamada S, Lewis J, Kageyama R. 2004. Instability of Hes7 protein is 

crucial for the somite segmentation clock. Nature Genetics 36: 750–754. 



15 
 

Igersheim A, Buzgo M, Endress PK. 2001. Gynoecium diversity and systematics in basal monocots. Botanical Journal of the 

Linnean Society 136: 1–65. 

Kitazawa MS, Fujimoto K. 2014. A developmental basis for stochasticity in floral organ numbers. Frontiers in Plant Science 

5. 

Kitazawa MS, Fujimoto K. 2016. Relationship between the species-representative phenotype and intraspecific variation 

in Ranunculaceae floral organ and Asteraceae flower numbers. Annals of Botany 117: 925–935. 

Kramer EM. 2009. Aquilegia: A New Model for Plant Development, Ecology, and Evolution. Annual Review of Plant 

Biology 60: 261–277. 

Lenhard M. 2003. Stem cell homeostasis in the Arabidopsis shoot meristem is regulated by intercellular movement of 

CLAVATA3 and its sequestration by CLAVATA1. Development 130: 3163–3173. 

Lenhard M, Bohnert A, Jürgens G, Laux T. 2001. Termination of Stem Cell Maintenance in Arabidopsis Floral Meristems 

by Interactions between WUSCHEL and AGAMOUS. Cell 105: 805–814. 

Litt A, Kramer EM. 2010. The ABC model and the diversification of floral organ identity. Seminars in Cell & 

Developmental Biology 21: 129–137. 

Liu X, Kim YJ, Müller R, Yumul RE, Liu C, Pan Y, Cao X, Goodrich J, Chen X. 2011. AGAMOUS Terminates Floral 

Stem Cell Maintenance in Arabidopsis by Directly Repressing WUSCHEL through Recruitment of Polycomb Group 

Proteins. The Plant Cell 23: 3654–3670. 

Müller R, Borghi L, Kwiatkowska D, Laufs P, Simon R. 2006. Dynamic and Compensatory Responses of Arabidopsis 

Shoot and Floral Meristems to CLV3 Signaling. The Plant Cell 18: 1188–1198. 

Munz PA. 1946. Aquilegia: the cultivated and wild columbines. Ithaca. NY. 

Nakagawa H, Ferrario S, Angenent GC, Kobayashi A, Takatsuji H. 2004. The Petunia Ortholog of Arabidopsis 

SUPERMAN Plays a Distinct Role in Floral Organ Morphogenesis. The Plant Cell 16: 920–932. 

Nandi AK, Kushalappa K, Prasad K, Vijayraghavan U. 2000. A conserved function for Arabidopsis SUPERMAN in 

regulating floral-whorl cell proliferation in rice, a monocotyledonous plant. Current Biology 10: 215–218. 

Nardmann J, Werr W. 2006. The Shoot Stem Cell Niche in Angiosperms: Expression Patterns of WUS Orthologues in 

Rice and Maize Imply Major Modifications in the Course of Mono- and Dicot Evolution. Molecular Biology and 

Evolution 23: 2492–2504. 

Payer J-B. 1857. Traité d’Organogénie Comparée de la Fleur. Paris, V. Masson. 



16 

Prunet N, Yang W, Das P, Meyerowitz EM, Jack TP. 2017. SUPERMAN prevents class B gene expression and 

promotes stem cell termination in the fourth whorl of Arabidopsis thaliana flowers. Proceedings of the National Academy of 

Sciences 114: 7166–7171. 

Rodas AL, Roque E, Hamza R, Gómez-Mena C, Minguet EG, Wen J, Mysore KS, Beltrán JP, Cañas LA. 2021. 

MtSUPERMAN plays a key role in compound inflorescence and flower development in Medicago truncatula. The Plant 

Journal 105: 816–830. 

Ronse De Craene L. 2018. Understanding the role of floral development in the evolution of angiosperm flowers: 

clarifications from a historical and physico-dynamic perspective. Journal of Plant Research 131: 367–393. 

Rosato E, Tauber E, Kyriacou CP. 2006. Molecular genetics of the fruit-fly circadian clock. European Journal of Human 

Genetics 14: 729–738. 

Sauquet H, von Balthazar M, Magallón S, Doyle JA, Endress PK, Bailes EJ, Barroso de Morais E, Bull-Hereñu K, 

Carrive L, Chartier M, et al. 2017. The ancestral flower of angiosperms and its early diversification. Nature 

Communications 8: 16047. 

Schoof H, Lenhard M, Haecker A, Mayer KFX, Jürgens G, Laux T. 2000. The Stem Cell Population of Arabidopsis Shoot 

Meristems Is Maintained by a Regulatory Loop between the CLAVATA and WUSCHEL Genes. Cell 100: 635–

644. 

Steeves TA, Sussex IM. 1989. Patterns in Plant Development. Cambridge University Press. 

Sun B, Looi L-S, Guo S, He Z, Gan E-S, Huang J, Xu Y, Wee W-Y, Ito T. 2014. Timing Mechanism Dependent on Cell 

Division Is Invoked by Polycomb Eviction in Plant Stem Cells. Science 343: 1248559–1248559. 

Sun B, Xu Y, Ng K-H, Ito T. 2009. A timing mechanism for stem cell maintenance and differentiation in the Arabidopsis 

floral meristem. Genes & Development 23: 1791–1804. 

Sun B, Zhou Y, Cai J, Shang E, Yamaguchi N, Xiao J, Looi L-S, Wee W-Y, Gao X, Wagner D, et al. 2019. Integration of 

Transcriptional Repression and Polycomb-Mediated Silencing of WUSCHEL in Floral Meristems. The Plant Cell 31: 

1488–1505. 

Takashima Y, Ohtsuka T, González A, Miyachi H, Kageyama R. 2011. Intronic delay is essential for oscillatory 

expression in the segmentation clock. Proceedings of the National Academy of Sciences 108: 3300–3305. 

Tucker SC, Hodges SA. 2005. Floral Ontogeny of Aquilegia, Semiaquilegia , and Enemion (Ranunculaceae). International 

Journal of Plant Sciences 166: 557–574. 



17 

Walker-Larsen J, Harder LD. 2000. The evolution of staminodes in angiosperms: patterns of stamen reduction, loss, and 

functional re-invention. American Journal of Botany 87: 1367–1384. 

Wang P, Liao H, Zhang W, Yu X, Zhang R, Shan H, Duan X, Yao X, Kong H. 2015. Flexibility in the structure of spiral 

flowers and its underlying mechanisms. Nature Plants 2: 1–10. 

Whitewoods CD, Cammarata J, Venza ZN, Sang S, Crook AD, Aoyama T, Wang XY, Waller M, Kamisugi Y, Cuming 

AC, et al. 2020. CLAVATA Was a Genetic Novelty for the Morphological Innovation of 3D Growth in Land 

Plants. Current Biology 30: 2645–2648. 

Xu Y, Prunet N, Gan E-S, Wang Y, Stewart D, Wellmer F, Huang J, Yamaguchi N, Tatsumi Y, Kojima M, et al. 2018. 

SUPERMAN regulates floral whorl boundaries through control of auxin biosynthesis. The EMBO Journal: 14. 



CHAPTER 1. 

Transcriptome profiling and 

weighted gene co-expression network analysis 

of early floral development in Aquilegia coerulea 

Reformatted from the original publication: Min, Y., & Kramer, E. M. (2020). Transcriptome profiling and weighted gene 
co-expression network analysis of early floral development in Aquilegia coerulea. Scientific reports, 10(1), 1-15. 

Article and supplement available at: https://doi.org/10.1038/s41598-020-76750-7



19 

ABSTRACT  

The earliest phases of floral development include a number of crucial processes that lay the foundation for the 

subsequent morphogenesis of floral organs and success in reproduction. Currently, key transcriptional changes 

during this developmental window have been characterized in the model species Arabidopsis thaliana, but little is 

known about how transcriptional dynamics change over the course of these developmental processes in other plant 

systems. Here, we have conducted the first in-depth transcriptome profiling of early floral development in Aquilegia 

at four finely dissected developmental stages, with eight biological replicates per stage. Using differential gene 

expression analysis and weighted gene co-expression network analysis, we identified both crucial genes whose 

expression changes mark the transitions between developmental stages and hub genes in co-expression modules. 

Our results support the potential functional conservation of key genes in early floral development that have been 

identified in other systems, but also reveal a number of previously unknown or overlooked loci that are worthy of 

further investigation. In addition, our results highlight not only the dynamics of transcriptional regulation during 

early floral development, but also the potential involvement of the complex, essential networks of small RNA and 

post-translational regulation to these developmental stages. 

INTRODUCTION 

The earliest phase of floral meristem (FM) development requires exquisite coordination 

among many different developmental processes. These include the proper initiation and patterning 

of the floral organs, maintenance of the size of the FM during organ initiation, the eventual 

termination of the FM activity to ensure the correct number of whorls, and the overlay of the floral 

organ identity programs onto the primordia so that the boundaries of gene expression domains 

synchronize precisely with the physical boundaries between the primordia. Coordination of these 

processes is achieved through crosstalk between numerous regulatory frameworks at multiple levels, 

ranging from transcriptional regulation, to RNA stability, to epigenetic modification, and protein 

stability.  

During the past 30 years, key regulatory mechanisms involved in early floral development 

have been characterized thanks to in-depth studies of model species such as Arabidopsis thaliana. 
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These include the ABCE model of organ identity (Coen & Meyerowitz, 1991; Ditta et al., 2004), the 

WUSCHEL (WUS)-CLAVATA (CLV) feedback loop for meristem maintenance (Schoof et al., 

2000), the AGAMOUS (AG)-KNUCKLES (KNU)-WUS pathway for FM termination (Sun et al., 

2009, 2014), the auxin signaling pathway for primordia initiation (Cheng & Zhao, 2007), as well as 

genes specifying the boundaries between organs or gene expression domains (Yu & Huang, 2016). 

However, novel genes and pathways contributing to these processes are constantly being discovered, 

and it is not yet clear how cross-regulation between different pathways and between different levels 

of the regulatory framework is controlled. Furthermore, although the orthologs of many genes have 

been studied in multiple plant model systems, relatively little is known about the degree of 

conservation of these programs across major lineages of flowering plants. To obtain a 

comprehensive view of the molecular basis of the early floral development, the conventional 

forward and reverse genetics approaches need to be coupled with global analysis at the 

transcriptional and genomic levels.  

In this study, we have conducted the first in-depth transcriptional profiling of early floral 

development in Aquilegia coerulea at four finely-dissected stages (Fig. 2.1). The genus Aquilegia belongs 

to the basal eudicot buttercup family Ranunculaceae and is a model system for floral evolutionary 

developmental studies (Kramer, 2009). Analysis of floral ontogeny (Tucker & Hodges, 2005) has 

shown that Aquilegia floral organ primordia initiate in whorls of five organs each, which are arranged 

in 10 orthostichies (vertical rows of organs), with alternate orthostichies either above the sepals or 

the petals (Fig. 2.1c). Aquilegia flowers all have multiple whorls of stamens, which is one of the major 

differences relative to other established model systems (e.g. A. thaliana, petunia, snapdragon) that all 

have only one whorl of stamens. The flowers of A. coerulea, as well as those of almost all other  

Aquilegia species, possess a fifth type of floral organ, the staminodes, which initiate in two whorls 

positioned between the stamens and carpels (Fig. 2.1). Unlike the syncarpous gynoecium of other 
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Figure 2.1. A. coerulea and the floral developmental stages used for RNA-seq. (a) Side view of a mature A. 
coerulea flower. (b) Front view of a mature A. coerulea flower. (c) Floral diagram of a typical A. coerulea flower. 
(d) Developmental stages, the number of biological replicates per stage, and the number of floral buds used for 
each biological replicate that were used for RNA-seq. Asterisks indicate staminodes and arrowheads indicate 
petals. Scale bar: a,b = 1 cm; d = 100 µm.   

 

model systems, Aquilegia is apocarpous with five distinct carpel primordia (Fig. 2.1). Using a 

candidate gene approach, previous studies have revealed the sub-functionalization of the B-class 

organ identity genes (Kramer et al., 2007; Sharma & Kramer, 2013; Sharma et al., 2019b) and that the 

JAGGED homolog is crucial for initiation of the floral organ primordia (Min & Kramer, 2017), but 

genome scale studies to date have focused on late stage floral organ development (Yant et al., 2015; 

Ballerini et al., 2019; Meaders et al., 2020).  

The current experiment was designed to obtain a broad characterization of the genetic 

pathways acting in early Aquilegia FM development. In order to ensure the power and accuracy of 

our sequencing results, we used eight biological replicates per developmental stage and obtained an 
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average of 18x sequencing depth per sample. The developmental window we sequenced sampled 

stages that started with a late phase of stamen initiation, covered the period of FM termination, and 

ended with the initial stage of morphogenesis of the floral organs. Using differential expression 

(DE) analysis and weighted gene co-expression network analysis (WGCNA), we identified crucial 

genes marking the transitions between developmental stages, and hub genes in co-expression 

modules that are strongly associated with these developmental stages. Our results support the 

potential functional conservation of key genes in early floral development that have been identified 

in other systems, but also revealed a number of previously unknown or overlooked loci that are 

worthy of further investigation. In addition, our results highlight not only the dynamics of 

transcriptional regulation during early floral development, but also the potential involvement of the 

complex, essential networks of small RNA and post-translational regulation in this process. 

MATERIALS AND METHODS 

Plant materials: growing conditions and dissection 

Seeds of Aquilegia x coerulea ‘Kiragami’ were purchased from Swallowtail Garden Seeds (Santa 

Rosa, CA, USA). Seeds were germinated in wet soil and seedlings were grown under conditions of 

16h daylight at 18˚C and 8 h dark at 13˚C. Once the plants developed approx. six true leaves, they 

were transferred into vernalization conditions (16h daylight at 6˚C and 8h dark at 6˚C) for three to 

four weeks, and subsequently moved back to the regular growth condition. Once the inflorescences 

started to develop, axillary FMs were quickly dissected on ice using surgical needles and flash frozen 

in liquid nitrogen. Three sepals were removed from every floral bud collected. 

Scanning electron microscopy 
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Floral buds were dissected using the same method as above, fixed in FAA (10% 

formaldehyde, 50% ethanol, 5% acetic acid), and stored at 4˚C. Prior to imaging, samples were 

dehydrated through a graded ethanol series to 100% and then critical point dried with CO2 

(Autosamdri-815, Tousimis, MD, USA). Images were taken with the JSM-6010 LC Scanning 

Electron Microscope (JEOL, MA, USA) at the Arnold Arboretum of Harvard University.  

RNA extraction, library construction, and sequencing 

The total RNA of all samples was extracted using the RNeasy Micro Kit (Qiagen, 

Netherlands). The integrity of extracted RNA was measured by using a 2200 TapeStation (Aligent 

Technologies, CA, USA). Subsequently, each RNA sample was diluted to a concentration of 1.25 

ng/µl, measured by using Qubit RNA HS Assay Kit (Thermo Fisher Scientific, MA, USA). 

Sequencing libraries were prepared by the Bauer Core facility of Harvard University using the 

SMART-Seq v4 Ultra Low Input RNA Kit (Takara Bio USA, Inc., CA, USA) for cDNA synthesis 

and Illumina Nextera XT (Illumina) for library preparation. Libraries were fragmented to an average 

size of 350 bp. Library concentrations were examined using a Qubit 2.0 (Thermo Fisher Scientific, 

MA, USA) and qRT-PCR, and the insert sizes measured using a Bioanalyzer 2100 (Aligent 

Technologies, CA, USA). Libraries were then pooled and diluted to a final concentration of 3 nmol. 

Sequencing was conducted at Novogene (Beijing, China) using the 150 bp paired-end Illumina 

HiSeq4000 sequencing platform.  

Mapping reads to the reference transcriptome 

The raw sequencing reads were filtered by removing adapters and low-quality reads using 

Trim Galored v0.6.5 (Krueger, 2020) (quality Phred score cutoff = 20) and mapped to the Aquilegia 

x coerulea ‘Goldsmith’ v3.1 reference transcriptome (https://phytozome.jgi.doe.gov/) using Kallisto 
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v0.46.1(Bray et al., 2016). Raw and processed reads are deposited under the GEO accession number 

GSE158507. 

Differential expression (DE) analysis 

Read counts and transcript per million reads (TPMs) were generated using the R package 

tximport v1.0.3 and the lengthScaledTPM method (Soneson et al., 2015). Lowly expressed 

transcripts were filtered based on analyzing the mean-variance trend, and transcripts with more than 

1 counts per million reads in at least one of the 32 samples were retained. Reads were normalized 

using the variance stabilizing transformation (VST) method to perform principal component analysis 

(PCA). Differential gene expression analysis was conducted following the DESeq2 R package 

v1.28.1(Love et al., 2014). For DE genes, the log2 fold change of gene abundance was calculated 

between pairwise groups, and the significance of expression changes was determined using the 

Student’s t-test. P-values were adjusted with the Benjamini-Hochberg Procedure to correct for the 

false discovery rate (Benjamini & Yekutieli, 2001). A gene was considered to be significant if it had 

adjusted p-value < 0.05 and log2 fold change ≥ 1. A heatmap of all DE genes was produced using 

the R package ComplexHeatmap v2.2.0. Hierarchical clustering was used to partition the DE genes 

into two clusters with Euclidean distance and ward.D2 clustering algorithm.  

Gene ontogeny (GO) enrichment and Kyoto Encyclopedia of Genes and Genomes (KEGG) 

pathway analysis 

Gene Ontogeny (GO) analysis for DE groups and WGCNA modules of interest was 

calculated using agriGO v2 (http://systemsbiology.cau.edu.cn/agriGOv2/) (Du et al., 2010; Tian et 

al., 2017) and the KEGG pathway analysis(Kanehisa & Goto, 2000; Kanehisa et al., 2016) was 

performed using the DAVID Bioinformatics Resources 6.8 (https://david.ncifcrf.gov/) (Huang et 
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al., 2009a,b). For both analyses, the identifiers of the top-hit A. thaliana loci were obtained from the 

A. coerulea “Goldsmith” v3.1 reference genome annotation (https://phytozome.jgi.doe.gov/), all of 

the expressed genes in the Aquilegia RNA-seq data were used as the background reference. 

Enrichment in GO terms or pathways was calculated with Fisher’s exact test, and p-values were 

adjusted for the false discovery rate using the Benjamini-Hochberg procedure. The minimum 

number of mapping entries for a GO category was set to be 5, and the count threshold for KEGG 

pathway analysis was set to be 2. Enrichment figures were produced using the R package ggplot2. 

  

WGCNA 

 Weighted gene correlation network analysis (WGCNA) (Langfelder & Horvath, 2008) was 

constructed using the R package WGCNA v1.68 following the package tutorials; the illustrated 

workflow is shown in Fig. S1. To avoid noise from lowly expressed genes, all genes that had read 

counts less than 10 in more than 90% of the samples (i.e. 29 samples) were removed. The 

expression of the resultant 18303 genes was then normalized using the 

varianceStabilizingTransformation function from the R package DESeq2 (Love et al., 2014). The 

adjacency matrix was calculated using a soft thresholding power of 5. Compared to a hard threshold, 

of which the correlation values above or below are considered to be connected or not, respectively; 

the soft threshold is used to raise the correlation to a power so that the difference between strong 

and weak correlations are exaggerated rather than defined into binary terms. The topological overlap 

matrix was calculated using a deepSplit value of 4, minModuleSize was set to 20, and 

mergeCutHeight was set to 0.2. Node and edge information of modules of interest were exported 

using the exportNetworkToCytoscape function of the WGCNA package. The node and edge files 

were then transformed into .json format using the R package jsonlite v1.6.1, and visualized using 

customized scripts modified based on the D3 JavaScript library.  
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Gene phylogenies 

 Neighbor-joining phylogenetic trees for genes that are discussed in the main text were 

constructed if the homologs in A. coerulea and A. thaliana were not each other’s reciprocal top 

BLAST hits. Potential homologs of the genes of interest were identified from the genomes of 

diverse species on Phytozome, all amino acid sequences were aligned using ClustalW (Larkin et al., 

2007) and the neighbor-joining trees were constructed using MacVector v17.5.5 (Gary, NC, USA). 

RESULTS AND DISCUSSION 

Developmental stages and sequencing information for transcriptome profiling 

In order to finely dissect and capture the transcriptional dynamics during early phases of 

Aquilegia floral development, we defined four developmental stages for RNA sequencing (Fig. 2.1d). 

At stage 1 (s1), the dome of the FM is round and visible, and stamen primordia are in the progress 

of initiating. At stage 2 (s2), all the stamen and staminode primordia have completed initiation, the 

five carpel primordia are about to initiate, and the apex of the floral bud is star-shaped and flattened. 

At stage 3 (s3), the outer rim of each carpel primordium is elevated but the development of carpel 

primordia has not consumed all the cells of the apex, and the stamen and staminode primordia are 

still morphologically indistinguishable. At stage 4 (s4), the carpel primordia continue to develop and 

elongate, all the cells in the apex have been consumed by carpel development, and the staminode 

primordia have started to expand laterally, making them morphologically distinct from the stamen 

primordia.  

A total of 72 floral buds were dissected from 30 individual plants for RNA extraction. For 

s1, s2, and s3, each biological replicate contained two floral buds from two individuals, while s4 

contained one floral bud per biological replicate (Fig. 2.1d). The amount of total RNA per extraction 
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Figure 2.2. PCA of normalized reads of all samples (a) and bar plot summary of DE genes between developmental 
stages (b). 

 

varied from 20.2 ng to 138 ng. After quality assessment, eight samples at each stage with the best 

RNA qualities were used for subsequent library construction. All 32 selected samples had RNA 

integrity numbers higher than 8.9.  

  A total of 993.64 million raw reads (323.1G raw data) were generated from the 150 bp 

paired-end Illumina HiSeq4000 sequencing platform. The number of reads generated per sample 

ranged between 25 million to 36 million (Fig. S2), and the average reads per developmental stage 

ranged from 29.3 million to 32.9 million (Fig. S2). After filtering reads by quality (Phred score cutoff 

= 20), the fraction of reads retained ranged from 80.2% to 88.4% (Fig. S2). Retained reads were then 

mapped to the Aquilegia x coerulea ‘Goldsmith’ v3.1 reference transcriptome, generating on average 

17.6x to 19.8x sequencing coverage per developmental stage (Fig. S2), and a total of 30023 raw 

transcripts were mapped. Subsequently, lowly expressed transcripts were filtered if a transcript had 

less than 1 million read count in more than 31 samples, which resulted in 20473 expressed genes in 

all samples. To conduct a preliminary exploration of the 32 samples, normalized reads of all samples 
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were used to perform a principal component analysis (PCA; Fig. 2.2a). The two primary PCs 

explained 76% of the total variance among all samples and a clear clustering by developmental stages 

was observed (Fig. 2.2a). 

 

Differential expression analysis between developmental stages 

 To identify genes that were significantly differentially expressed (DE) between 

developmental stages, the log2 fold change of the gene abundance was calculated between different 

stages. A gene was considered DE if it had an adjusted p-value of <0.05 and an absolute value of 

log2 ratio ≥1. A total of 1944 DE genes were identified, with more genes upregulated at s4 

compared to any other developmental stage (Fig. S3; Supp. Data 1). For each pairwise comparison, 

there were consistently more genes down-regulated at the earlier stage relative to the later stage (Fig. 

2.2b; Supp. Data 1).  

 A small number of DE genes, 67 and 49, were identified when comparing s1 to s2, and s2 to 

s3, respectively. Among these 67 and 49 DE genes, only five loci (Table S1) appeared in both 

comparisons, suggesting that although s2 appeared to be transcriptionally similar to both s1 and s3, 

the similarities lay in different aspects in each comparison. One of the five genes in common, 

Aqcoe7G234000, is the homolog to the ARABIDOPSIS HISTIDINE PHOSPHOTRANSFER 

PROTEIN 6 (AHP6). It is also the top DE gene that is significantly up-regulated in s1 compared to 

s2, and among the top DE genes that are up-regulated at s2 compared to s3 (Table S1). In A. 

thaliana, AHP6 is one of the key genes mediating crosstalk between the auxin and cytokinin signaling 

pathways, and participates in a number of crucial developmental processes, including specifying the 

founder cells for lateral roots, protoxylem, and protocambium (Chandler & Werr, 2015). In shoot 

apical meristems (SAMs), inflorescence meristems (IMs), and FMs, AHP6 is involved in the 

patterning of phyllotaxy and organ initiation (Besnard et al., 2014a, b, p. 6; Chandler & Werr, 2015). 
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In particular, the AHP6 protein functions non-cell-autonomously to create a cytokinin-signaling 

inhibition field that contributes to the robustness of the auxin-signaling inhibition field for 

phyllotaxy and organ patterning (Besnard et al., 2014a). We hypothesize that the AHP6 homolog in 

Aquilegia is functionally conserved since the expression level of AqAHP6 sharply declines as organ 

initiation ceases during the progression of s1 to s4 (Fig. S4) 

Among the 24 genes that were found to be significantly up-regulated at s1 relative to s2, 

Aqcoe3G399500 is the top DE gene after AqAHP6 (Table S1). The A. thaliana homolog of this locus 

is PERIANTHIA (PAN), which has been shown to regulate floral architecture and directly activate 

the expression of the C-class gene AGAMOUS (AG) (Maier et al., 2009). Homologs of other genes 

that specify meristem and organ primordia boundaries during early floral development also appeared 

to be significantly up-regulated at s1, including CUP SHAPED COTYLEDON3 (Hibara et al., 2006) 

(AqCUC3; Aqcoe6G165500) and HANABA TARANU (Ding et al., 2015) (AqHAN; 

Aqcoe5G190300), as well as loci that are known to regulate floral organ size and growth, such as 

STERILE APETALA (Li et al., 2018) (AqSAP; Aqcoe1G384300) and AINTEGUMENTA-like 6 

(Krizek, 2009) (ATL6/PLT3; Aqcoe6G092100). 

Interestingly, two key genes controlling stomata development in various plant lineages, 

AqMUTE and AqEPF1 (Torii, 2015; Hepworth et al., 2018), were both expressed at very low levels 

at s1, but significantly up-regulated in s2 followed by consistent high expression at later stages (Fig. 

S4). This may suggest that although s1 sepals have already achieved reasonable sizes, stomatal 

development does not initiate until s2. Other genes that were shown to be up-regulated in s2 

compared to s1 include the adaxial identity gene AqCRC, which is consistent with previous studies 

showing that strong AqCRC expression coincident with the initiation of the carpel primordia 

(Meaders et al., 2020).  
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The top DE gene that is up-regulated in s2 relative to s3, Aqcoe7G055500, encodes a non-

specific serine-threonine kinase with a predicted RNA-binding domain, which does not appear to be 

a member of any of the better-known serine-threonine classes (Hardie, 1999). Its homolog in A. 

thaliana, AT5G51800, has not been studied functionally but is highly expressed in the shoot apex, 

inflorescence meristem, developing carpels, and stigma (Arabidopsis eFP Browser 2.0). However, 

this gene is highly expressed at s2 in the current study, in which the FM has just completed organ 

primordia initiation, and it will, therefore, be interesting to examine its function in early Aquilegia 

floral development.  

 Gene ontogeny (GO) analysis of DE genes revealed a wide range of enrichment terms for 

every DE comparison except for [s1 vs. s2] and [s2 vs. s3], likely due to the small numbers of DE 

genes in these two comparisons, as mentioned above (Supp. Data 2). In general, there seems to be a 

large portion of overlap in GO terms in DE genes that were up- or down-regulated during early 

stages compared to later stages (Fig. 2.3a). For instance, GO terms that are related to organ 

formation, patterning, and development are enriched for DE genes that are up-regulated at s1 and 

s2. On the other hand, genes that are up-regulated at s3 and s4 are heavily enriched in metabolic and 

enzymatic activities, including active transmembrane transportation, carboxylesterase activity, 

oxidoreductase activity, and glucosyltransferase activity, all of which are involved in broader 

metabolic processes during plant development. 

 Subsequently, we conducted KEGG pathway enrichment analysis with the DE genes, and 

we observed a similar pattern for genes that are up-regulated in s4, in that they participate in various 

metabolic pathways (Fig. 2.3b). For instance, genes involved in nitrogen metabolic pathways are up-

regulated and enriched in s4, indicating active amino acid biosynthesis and protein synthesis at s4 

compared to earlier developmental stages. On the other hand, all the genes that are up-regulated at 
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the earlier stages in each DE comparison are almost exclusively enriched in plant hormone signal 

transduction pathways (Fig. 2.3b).  

 We then examined the hormonal signaling pathways that were enriched for each DE list, 

which revealed several interesting points (Fig. 2.3c). Firstly, all DE lists contained genes in the auxin 

signaling pathways. The DE genes up-regulated in s1 compared to s4 included genes in all major 

components in auxin signaling, while all other DE lists only showed enrichment in a few 

components in the pathway. This indicates a gradual decrease in the number of highly expressed 

auxin signaling genes from s1 to s4. Secondly, as mentioned previously, AqAHP6 appeared to be 

differentially expressed at the earlier stages in all DE comparisons, which was also captured by the 

KEGG pathway analysis as enriched in AHP family members. Besides AqAHP6, homologs of the 

Arabidopsis Response Regulator (ARRs) proteins were shown to be up-regulated in s1 compared to 

s4, and ARRs are downstream of AHPs in the cytokinin signaling pathway, which emphasizes the 

decrease in cytokinin signaling from s1 to s4. Thirdly, genes that are up-regulated at s1 compared to 

s4 are detected from the abscisic acid, brassinosteroid, and salicylic acid signaling pathways, 

suggesting a complex interplay between multiple plant hormone pathways during the early stages of 

floral development. 

We profiled the expression of type-II MADS-box genes (Pabón-Mora et al., 2013; Sharma & 

Kramer, 2014) and class-I KNOTTED-like homeodomain (KNOX) genes (Yant et al., 2015), 

because many members of these families are known to play important roles during early floral 

development, along with additional homologs of genes involved in FM identity and maintenance 

(Fig. 2.4). Among the type-II MADS-box genes, the C-class gene AqAG2 and AGAMOUS-LIKE 

12 (AqAGL12) showed a significant increase in the expression levels from s1 to s4. This might be 

expected for AqAG2, which is known to be strongly expressed in carpels (Kramer et al., 2007), but  
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Figure 2.3. GO term and KEGG pathway enrichment analysis of DE genes. (a) Selected enriched GO terms from 
different DE comparisons. (b) Selected enriched KEGG pathways from different DE comparisons. (c) Enriched 
plant hormone signal transduction pathways from different DE comparisons. % in a and b were calculated as: 
number of genes that hit the specific GO term or KEGG pathway/total number of genes in the input DE list*100. 
Each DE comparison is noted as: earlier stage vs. later stage, up- (U) or down (D)-regulated at the earlier stage.; 
for instance: S1S2U means genes that are DE between s1 and s2 and are up-regulated at s1. 

expression of AqAGL12 has not previously been investigated in Aquilegia. While the majority of the 

MADS-box genes showed a decrease in their expression levels from s1 to s4, this trend was only 

significant for SUPPRESSOR OF OVEREXPRESSION OF CONSTANS 1 (AqSOC1.1), 

FRUITFULL-LIKE 2 (AqFL2), SEPALLATA1 (AqSEP1) and APETALA3-3 (AqAP3-3) (Fig. 

2.4). Similarly, most of the class-I KNOX genes and FM-related genes showed the highest 

expression levels at s1 with a decrease at subsequent stages, but AqKXL3 appeared to be expressed 

at the highest levels at s2 (Fig. 2.4). 



33 
 

Since the meristem stages we sampled captured the transition from organ primordia 

initiation to FM termination (i.e. the end of organogenesis), we also examined the expression of the 

homologs of genes in the known FM termination pathways (Sun et al., 2009, 2014, 2019; Yamaguchi 

et al., 2017, 2018; Bollier et al., 2018) (Fig. 2.4). Interestingly, several lines of evidence suggest limited 

conservation of these pathways, particularly the KNU-WUS pathway, between A. thaliana and A. 

coerulea. In A. thaliana, KNU has been shown to be essential in terminating the expression of WUS in 

the FM, and continuous expression of KNU appeared to be necessary to maintain the suppression 

of WUS via both transcriptional suppression and heterochromatinization (Sun et al., 2019), but the 

expression of AqKNU (Fig. S4, S6) decreased after s2. Furthermore, KNU and SPLAYED (SYD) 

function antagonistically by competing for a binding site in WUS promoter, but AqKNU and 

AqSYD showed similar, rather than the opposite, patterns of expression over s1 to s4 (Fig. S4). 

Additionally, FERTILIZATION-INDEPENDENT ENDOSPERM (FIE) is a key polycomb 

repressive complex2 component, which has been shown to physically interact with KNU to deposit 

repressive H3K27me3 marks and maintain the stable silencing of WUS in later developmental stages 

(Sun et al., 2019). Unlike what was observed in silencing FIE expression in A. thaliana, however, a 

previous study has shown that the silencing of AqFIE did not lead to indeterminacy in the flowers 

(Gleason & Kramer, 2013). MINI ZINC FINGER2 (MIF2) was shown to be a component of a 

protein complex together with KNUCKLES (KNU), TOPLESS (TPL) and HISTONE 

DEACETYLASE-like 19 (HDA19) to suppress the expression of WUS in the FM (Bollier et al., 

2018), but the read counts of the MINI ZINC FINGER2 (MIF2) homolog were extremely low in all 

sample of all stages and this gene is considered as not expressed in our dataset. Besides the KNU-

WUS pathway, TORNADO2 (TRN2) functions downstream of CRC in coordinating FM 

termination and carpel primordia formation in A. thaliana (Yamaguchi et al., 2017), but phylogenetic 
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Figure 2.4. Expression profiles of type-II MADS-box genes, class-I KNOX genes, and genes involved in FM 
maintenance and termination pathways. Expression levels of each gene over the developmental stages were 
scaled as the average expression of all biological replicates per stage subtracted by the average expression of all 
replicates of all stages, then divided by the standard deviation of the expression of all replicates of all stages. DE 
genes were indicated with symbols of each DE comparison.

analysis did not recover any ortholog of TRN2 the Aquilegia genome (Fig. S5). These findings 

suggest that the A. thaliana mechanisms controlling FM termination are not well conserved in 

Aquilegia. 
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Gene co-expression analysis, identification of module hub genes, and network construction 

of modules of interest 

The DE analysis provided us with a good starting point of what genes might be functionally 

relevant to a certain developmental stage based on the changes in their expression levels, but a 

strong limitation for DE analysis is that each gene is considered in isolation while in reality, genes 

and gene products function in networks. In order to discover co-expressed genetic modules that are 

significantly associated with different stages during early floral development in Aquilegia, we 

conducted weight gene co-expression network analysis (WGCNA) using the RNA-seq data (refer to 

Fig. S1 for an illustrated workflow). Using a soft threshold power = 5 (Fig. S7), a total of 24 co-

expression modules were constructed from 18303 genes, with the smallest module (darkgrey) 

containing 21 genes and the largest module (turquoise) containing 6206 genes (Fig. 2.5a). 

Subsequently, we looked at the association between the modules and the four developmental stages 

by correlating the eigengene value (i.e. a value equivalent to the first component of the module; a 

singular value decomposition to summarize the expression levels of all genes in that module) of the 

modules with the stages. Among the 24 modules, we determined three modules to be of particular 

interest based on their correlation (Fig. 2.5a) and close distance in the hierarchical dendrogram 

clustering (Fig. 2.5b): the green module for its strong association with s1, and the brown and 

magenta modules for their strong association with s4. We will refer to the modules as green-s1, 

brown-s4, and magenta-s4 hereafter for clarity.  

To obtain a broad overview of genes in the three modules of interest, we performed GO 

and KEGG pathway analysis on these modules (Fig. 2.5c; Supp. Data 2). GO analysis revealed that 

although the green-s1 module has a moderate size (781 genes) compared to other modules, it has the 

largest number of enriched GO terms, most of which are specific to early floral developmental 

stages, such as stem cell/meristem maintenance and development, axis specification, and organ 
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Figure 2.5. Associating gene co-expression modules with developmental stages. (a) Correlation between module 
eigengene values and the developmental stages. The first number in each cell represents the correlation value, 
and the second number in the parenthesis represents the p-value of the correlation. Arrowheads pointed to 
modules of interest. (b) Hierarchical clustering dendrogram of the eigengenes of modules and the developmental 
stages. (c) Selected GO term enriched from modules of interest. % was calculated as: number of genes hit the 
specific GO term/total number of genes in the input list*100. 

 

formation (Fig. 2.5c; Supp. Data 2). On the other hand, the brown-s4 module has a relatively large 

number of genes (1947 genes) but only two highly related cellular process GO terms are found to be 

significant, microtubule-based processes and movement (Fig. 2.5c; Supp. Data 2). The magenta-s4 

module also shows strong and significant association with s4, but genes in this module are enriched 

in “floral whorl” and “floral organ development”, particularly in androecium, perianth, and 

gynoecium development (Fig. 2.5c; Supp. Data 2). This suggests that the WGCNA has identified 
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modules that are significantly associated with different aspects of floral development at s4: genes in 

the brown-s4 module appear to be focused on the rapid growth of all floral organs in s4, in which 

active mobilization of the microtubules is necessary for rapid cell expansion; while genes in the 

magenta-s4 module are specific to the elaboration and maturation of each floral organ identity.  

KEGG analysis revealed that the green-s1 and brown-s4 modules both contain genes that 

are involved in the starch and sucrose metabolism pathways (Supp. Data 2). In addition, genes in the 

green-s1 module are significantly enriched in the plant hormone signal transduction pathways, and 

genes in the brown-s4 module are significantly enriched in several sugar metabolic pathways, 

including fructose and mannose metabolism, and amino sugar and nucleotide sugar metabolism 

(Supp. Data 2). Sugar metabolism has been implicated in various aspects of plant development, 

especially the amino sugar and nucleotide sugar interconversion pathways that are required for cell 

wall biosynthesis (Seifert, 2004). Together with the GO enrichment in microtubule-based movement 

and processes for module brown-s4, this again emphasizes the initiation of rapid organ growth 

during s4 of floral development in Aquilegia. No pathway enrichment was found for genes in the 

magenta-s4 module, possibly due to the small module size.  

Subsequently, we identified the potential hub genes of each module of interest based on the 

value of signed module membership (MM) and trait significance (TS). The former describes the 

correlation between a gene and the eigengene value of a module, while the latter describes the 

correlation between a gene and the trait of interest; the potential hub genes of a module should have 

significant and strong correlations with both MM and TS (Fig. S1; S8). We, therefore, defined the 

hub genes as having their absolute values of MM and TS above the 90th percentile of the distribution 

of MM and TS of all the genes of the module. This approach identified 33, 56, and 14 hub genes for 

the green-s1, brown-s4, and magenta-s4 modules, respectively (Fig 2.6; Table S2). Moreover, 

although every gene is connected to all other genes in a module, the strengths of the connection 
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between gene pairs vary and the hub genes, by definition, should have the strongest values of 

connectivity. To better visualize the gene co-expression networks of each module, we only retained 

the edges that have the highest weight values (i.e. having the strongest connectivity) with the hub 

genes in the network for visualization (Fig. S8; Fig. 2.6-2.8). To facilitate navigation among a group 

of highly interconnected genes (particularly in the case of the green-s1 and brown-s4 modules), we 

moved all the genes with the largest numbers of connections to the periphery of the visualized 

network and thus genes left in the center of the network had fewer connections compared to those 

of at the periphery. 

 

Hub genes of the green module revealed new candidate genes associated with s1 floral 

development 

 The green-s1 module contains 33 potential hub genes and 17 of these encode transcription 

factors (TFs). The homologs of many of these TF-coding genes are involved in early FM and floral 

development, such as class-I KNOX genes (AqSTM1, AqSTM2, AqKXL2), AqAS1, AqSEP1, 

AqPAN, and the homologs of CUP SHAPED COTYLEDON3 (Aqcoe6G165500; AqCUC3), 

HOMEOBOX-3 (Aqcoe1G245800; AqHB3), PHABULOSA (Aqcoe1G178700; AqPHB), LATERAL 

SUPPRESSOR (Aqcoe1G411100; AqLAS), BLADE ON PETIOLE2 (Aqcoe2G033300; AqBOP), 

and STERILE APETALA (Aqcoe1G384300; AqSAP). Of these, AqPAN also showed the strongest 

association with s1 (Table S2).  

Interestingly, although all the potential hub genes have similarly high MM and TS values 

(Table S2), the number of edges connected to the hub genes in the network appeared to be highly 

variable (Fig. 2.6), indicating a hierarchy of connectedness even among the hub genes. For instance, 

we have identified nine hub genes that have a strong negative association with the module and the 

s1 developmental stage (Table S2), but all of them except one (Aqcoe4G281800) have only a few 
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Figure 2.6. Gene network of module green-s1. Color scale represents the value of MM for each gene. The 
“Aqcoe” prefix of a gene identifier was removed to facilitate the visualization. All the genes with the largest 
number of connections are at the periphery of the network (i.e., genes in the center have fewer connections 
compared to genes at the periphery). Genes that are presented as colored circles (instead of a solid dot) are 
genes that were discussed in the main text.  

edges connecting them with other genes in the network (and thus were not placed in the periphery 

of the network). Aqcoe4G281800 encodes a wax synthase that is involved in constructing cell walls, 

and also only has a moderate number of edges compared to the those associated with other 

periphery hub genes. By contrast, the five periphery hub genes with the largest number of edges are 

(Fig. 2.6): AqVRN1 (Aqcoe2G107800, homologous to VERNALIZATION1, VRN1, in A. thaliana); 

AqHCT (Aqcoe7G354200, codes for a hydroxycinnamoyl-Coenzyme A shikimate/quinate 
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hydroxycinnamoyltransferase, HCT); AqUFO1 (Aqcoe1G161900; UNUSUAL FLORAL 

ORGANS1; Sharma et al., 2019b), AqSAP; and AqEPFL4 (Aqcoe2G352600, homologous to 

EPIDERMAL PATTERNING FACTOR-LIKE4, EPFL4, in A. thaliana). The functional 

implications of some of these loci are unclear. For instance, A. thaliana VRN1 belongs to the 

AP2/B3-like transcriptional factor family, and its function is primarily understood to be the 

regulation of the vernalization locus FLOWERING LOCUS C (FLC; Bastow et al., 2004). However, 

although Aquilegia does require vernalization to flower (Ballerini & Kramer, 2011), it lacks an FLC 

homolog (Sharma et al., 2019a), and AqVRN1 is expressed in the early FM (Fig. S4), which differs 

considerably from the broad expression of AtVRN1 in various organs and developmental stages of 

A. thaliana (Levy, 2002; Bastow et al., 2004). The potential role for AqHCT is equally enigmatic, as

the enzyme appears to function in phenylpropanoid biosynthesis, a pathway that supports highly 

diverse cellular functions (Hoffmann et al., 2004). 

Luckily, the remaining hub genes are better understood. Homologs of UFO encode F-box 

proteins that generally function with LEAFY (LFY) homologs to promote FM identity and activate 

B-class gene expression across diverse dicot model systems (Lee et al., 1997; Samach et al., 1999;

Durfee et al., 2003; Levin & Meyerowitz, 1995; Wilkinson & Haughn, 1995). In Aquilegia, the closely 

related paralogs AqUFO1 and AqUFO2 promote the transition from inflorescence to FM identity in 

conjunction with AqLFY, although there is no clear role in B gene activation (Sharma et al., 2019b). 

In addition to the expected contribution to FM identity, the AqUFO1/2 paralogs also appear to 

promote the initiation of the stamen whorls, as whorl number dramatically decreases in silenced 

flowers from the usual 7-8 whorls to only 4-5. This function is intriguing for several reasons. First, 

the phenotype is only observed in AqUFO1/2-silenced flowers and not with AqLFY-silencing, 

suggesting that this function is specific to the F-box proteins and not a joint function with AqLFY. 

Second, it underscores a critical difference in Aquilegia floral development relative to other model 
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systems in that, like many angiosperm flowers, Aquilegia has multiple whorls of stamens. The 

identification of AqUFO1 as a critical hub gene in early floral development is consistent with this 

novel role in promoting stamen initiation and/or continued FM proliferation and points to other 

loci that may function as novel co-factors for this role.  

In A. thaliana, SAP plays a number of roles, including acting as a cadastral gene that prevents 

AG from entering the perianth whorls, and controlling both inflorescence architecture and ovule 

development (Byzova et al., 1999). Interestingly, similar to UFO, SAP also contains an F-box motif 

and was recently shown to be a component of an Skp1-cullin 1-F-box (SCF) E3 ubiquitin-protein 

ligase complex that controls lateral organ size by promoting cell proliferation, a function that has 

been demonstrated both in A. thaliana (Wang et al., 2016) and cucumber (Yang et al., 2018). To date, 

the only genes that have been identified as the direct targets of the SAP-mediated E3 ligase complex 

are PEAPOD1/2 (PPD1/2), which control organ growth (Wang et al., 2016; Li et al., 2018). The 

homolog of PPD1 and PPD2 in Aquilegia, Aqcoe5G048100, showed relatively stable expression from 

s1 to s4 (Fig. S4) and was assigned to the turquoise module (Fig. 2.5). It will be worth investigating 

whether this interaction is conserved in Aquilegia and what may be the other targets of the ligase 

complex during early floral development.  

AqEFPL4 belongs to the EPFL gene family that encodes small, secreted cysteine-rich 

ligands. The best-studied members of the family are the EPIDERMAL PATTERNING 

FACTORS1/2, which are key regulators in stomata development (Torii, 2015). As mentioned above, 

AqEPF1 was identified as one of the DE genes that is up-regulated at s2 compared to s1 (Table S1). 

In contrast, in A. thaliana the close homologs EPFL4 and EPFL6 have been shown to have distinct 

functions in inflorescence growth (Abrash et al., 2011; Uchida et al., 2012). However, two very recent 

studies revealed that EPFL4 and EPFL6 are also expressed in the periphery of the shoot apical 

meristem (SAM) and function redundantly with EPFL1 and EPFL2 to regulate the meristem size 
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and leaf initiation (Kosentka et al., 2019; Zhang et al., 2020). In particular, signaling downstream of 

EFPL ligands and their receptors confines the WUS-CLV3 pathway to the center of the SAM by 

inhibiting its expression in the meristem periphery (Zhang et al., 2020). In this regard, it is especially 

interesting that AqEPFL4 came out as one of the most connected hub genes in a module that is 

strongly associated with s1, suggesting that our results provide further evidence for the role of the 

EPFLs in the meristem homeostasis.  

Perhaps the most surprising observation regarding the green-s1 module network is that one 

gene, AqAGO5a (Aqcoe5G237200, homologous to ARGONAUTE5, AtAGO5, in A. thaliana; Fig. 

S9), was not initially identified as a hub gene since neither its MM nor TS values were above the 90th 

percentile of distributions (Table S2), but it did come up as a potential hub gene in the network 

visualization due to its strong connections with all the other hub genes. AGO genes encode RNA 

slicers that are involved in post-transcriptional gene silencing by selectively recruiting microRNAs 

and siRNAs. In A. thaliana, AtAGO5 physically interacts with miRNA156 and regulates the phrase 

transition from the vegetative to reproductive state of the meristem (Roussin-Léveillée et al., 2019). 

Other AtAGO genes, such as AtAGO1 and AtAGO10, have also been shown to function in 

establishing polarity in floral organs and regulating meristematic activities in the FM by interacting 

with miRNA165/166 (Kidner & Martienssen, 2005; Tucker et al., 2008; Ji et al., 2011; Zhu et al., 

2011; Roodbarkelari et al., 2015). Moreover, based on our gene phylogeny (Fig. S9a), the Aquilegia 

genome contains a close paralog of AqAGO5a, Aqcoe2G159700 (AqAGO5b), which shares 81.4% of 

similarity with AqAGO5a (Fig. S9b). The expression level of AqAGO5a was the highest at s1 and 

then gradually decreases from s2 to s4, while its paralog AqAGO5b, showed very stable expression 

from s1 to s4 (Fig. S9c). It will thus be intriguing to determine what are the targets of these two 

close paralogs and the potential functional divergence between them.  
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The brown and magenta modules captured different aspects of s4 floral development 

Interestingly, among the 56 potential hub genes for the brown-s4 module, only three genes 

code for transcription factors (TFs), and there seemed to be an over-representation of genes coding 

for key components of the ubiquitination pathways (Table S2). Six out of the 22 hub genes that 

exhibit a negative association with s4 encode key components in the SCF E3 ligase complexes, 

including F-box family proteins (Aqcoe2G310400, Aqcoe7G317700, Aqcoe7G317600), RING/U-box 

family proteins (Aqcoe7G340300, Aqcoe3G311800), and HCP-like superfamily protein 

(Aqcoe5G357900). In addition, two hub genes that have positive associations with s4 code for a 

ubiquitin-related protein (Aqcoe3G298400) and a subunit of the COP9 complex (Aqcoe7G310200), 

respectively.  

The gene network of the brown-s4 module revealed that most of the identified hub genes 

are highly interconnected to each other and thus are mostly placed at the periphery of the network 

(Fig. 2.7). One hub gene, Aqcoe7G340300, however, appeared to have strong connections not only 

to most of the other hub genes but also to a large number of additional module members. 

Aqcoe7G340300 codes for a RING/U-box type protein and its homologs, DA2 and GRAIN 

WIDTH AND WEIGHT2 (GW2) have been functionally studied in A. thaliana (Xia et al., 2013) and 

rice (Song et al., 2007), respectively. Both DA2 and GW2 have E3 ubiquitin ligase activity and 

exhibit conserved functions in regulating organ size by restricting cell divisions in both systems 

(Dong et al., 2017). The expression level of Aqcoe7G340300 steadily declined from s1 to s4 (Fig. S4), 

and if its function in suppressing cell division in lateral organs is conserved, the low expression level 

at s4 may indicate the onset of cell proliferation in the floral organs.  

In contrast to what was observed for the brown-s4 module, in which most of the hub genes 

were directly connected to each other, the 14 hub genes for the magenta-s4 module were connected 

to each other via a number of common non-hub genes in the network (Fig. 2.8). 
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Figure 2.7. Gene network of module brown-s4. Color scale represents the value of MM for each gene. The 
“Aqcoe” prefix of a gene identifier was removed to facilitate the visualization. All the genes with the largest 
number of connections are at the periphery of the network (i.e. genes in the center have fewer connections 
compared to genes at the periphery). Genes that are presented as colored circles (instead of a solid dot) are 
genes that were discussed in the main text.  

 

Among the magenta-s4 hub genes that have negative MMs, Aqcoe2G063200 encodes a small 

ubiquitin-like modifier (SUMO) and is homologous to SUM2 in A. thaliana. Sumoylation mediated 

by SUMOs is an important post-translational protein modification mechanism in plants and is 

involved in regulating diverse plant physiological and developmental processes, including flowering 

time (Park et al., 2011). Interestingly, another hub gene with negative MM, Aqcoe2G315500, codes 

for a copper/zinc superoxide dismutase (CSD) and the protein stability of its A. thaliana homolog 

CSD1 has been shown to be maintained via sumoylation (Chen et al., 2011). This relationship was 

captured in our network analysis, making their function in early floral development an interesting 

target for further study. In addition, Aqcoe5G226900, the Aquilegia homolog of MONOPTEROS 

(AqMP) is another magenta-s4 hub gene with expression level that was highest at s1 and then 
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steadily declining from s2 to s4. In A. thaliana, MP is critical to maintaining stem cell homeostasis in 

the SAM (Luo et al., 2018) so this decline is consistent with the cessation of FM proliferation (Fig. 

2.4). On the other hand, the homolog of Aqcoe2G426800, EXCESS MICROSPOROCYTES1 

(EXS), is expressed during the differentiation of microsporocytes and tapetal cells and controls the 

somatic and reproductive cell fates in A. thaliana anthers (Canales et al., 2002). If functional 

conservation is assumed, the sharp increase in the expression of Aqcoe2G426800 at s4 (Fig. S4) likely 

marks the beginning of microsporogenesis in Aquilegia.  

Figure 2.8. Gene network of module magenta-s4. Color scale represents the value of MM for each gene. The 
“Aqcoe” prefix of a gene identifier was removed to facilitate the visualization. Genes that are presented as 
colored circles (instead of a solid dot) are genes that were discussed in the main text.  

CONCLUSIONS 

The current study is the first in-depth transcriptome profiling of early Aquilegia floral 

development. Similar studies at finely dissected stages of early floral development have only been 

done in the model species A. thaliana (Wellmer et al., 2006; Ryan et al., 2015; Klepikova et al., 2016), 

although analyses have also been performed in tomato SAMs, and early inflorescences of model 
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monocot species (Lemmon et al., 2016; Feng et al., 2017).  In contrast to the previous A. 

thaliana work, the relatively large size of Aquilegia FMs allowed us to visually confirm the 

developmental stage of dissected meristems and perform a large number of biological 

replicates.  Overall, our results reveal similar themes to the A. thaliana analyses, with down-regulation 

of meristem maintenance corresponding to a shift towards primordium proliferation and 

differentiation. For the developmental window on which we chose to focus, the morphological 

changes between successive floral developmental stages are subtle, which helped us to tease apart 

the dynamic transcriptional changes between the stages. In particular, we have uncovered small 

numbers of DE genes when comparing s1 to s2 (67), and s2 to s3 (49), with only five genes 

appearing in common between both DE lists (Table S1). These two groups of DE genes mark two 

important processes during early floral development: the DE genes between s1/s2 appear to 

correspond to the termination of the FM and the end of organogenesis, while the DE genes 

between s2/s3 as associated with the onset of floral organ morphogenesis. Analyzing the homologs 

of known genes in the FM termination pathway (Fig. 2.4) provided evidence that the A. thaliana 

mechanisms are likely not conserved in Aquilegia. We have also identified a number of key genes that 

are likely of importance for different stages of early floral development in A. coerulea, including 

AqPAN, AqSAP, AqEFLP4, and AqAGO5, as well as many top DE genes and hub genes for 

which the homologs have not been studied in A. thaliana. Thus, our study is the third study to date 

to indicate that the EPFLs play a previously overlooked role in the meristem homeostasis (Fig. 2.6), 

as supported by its identification as one of the core hub genes for the green-s1 module.  

 In addition, understanding the mechanisms leading to functional divergence of close 

paralogs is an important component of understanding gene evolution in general. Utilizing DE 

analysis and WGCNA, we have uncovered evidence of potential functional divergence between the 

close paralogs of several key genes expressed during early floral development in Aquilegia.  
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These include the close paralogs of AqSTM1 and AqSTM2, AqUFO1 and AqUFO2, and AqAGO5a 

and AqAGO5b, of which only AqSTM2, AqUFO1, and AqAGO5a were recovered as core hub 

genes of the green-s1 module (Fig. 2.6; Table, S2). These observations help to direct future 

investigations on the mechanisms and consequences of the functional divergence between close 

paralogs; for instance, whether or not AqAGO5a and AqAGO5b function in different tissues or 

have the same miRNA targets. 

Finally, our results highlight the dynamics and potential role of several post-transcriptional 

and post-translational regulatory mechanisms during early floral development in A. coerulea. In terms 

of post-transcriptional regulation, in our network analysis for the green-s1 module, AqAGO5a 

appeared as a hub gene due to its strong connections to all the other hub genes in the network, 

suggesting an important role in small RNA regulation in s1 (Fig. 2.6). The Argonaute protein family 

is a critical player in the RNA silencing process as an essential component of the RNA-induced 

silencing complex (Fang & Qi, 2016). Homologs of the AGO1/5/10 clade have been studied in A. 

thaliana, rice, tomato, and tobacco, all of which participate in various important aspects in plant 

development, including regulation of SAM, FM, germ cell development, and stress responses (Jones 

et al., 2006; Hendelman et al., 2013; Zhang et al., 2015; Fang & Qi, 2016). Nonetheless, small RNA 

regulation has not yet been explored in Aquilegia, making AqAGO5a a good starting point for 

further exploration. It is also clear that post-translational regulation via protein stability plays a major 

role in the transition from primordium initiation to floral organ morphogenesis in the Aquilegia FM. 

This is supported by the ubiquitination-related hub genes of the brown-s4 module coding for 

RING/U-box proteins, as well as an abundance of hub genes for both the green-s1 and the brown-

s4 modules coding for F-box proteins, which are the components of the SCF E3 ligase complex 

(Table S2). Some of these genes, such as UFO and SAP, are long known to participate in floral 

development in A. thaliana(Samach et al., 1999; Durfee et al., 2003; Wang et al., 2016; Li et al., 2018), 



48 

but the connection between other F-box coding genes and floral development still needs further 

investigation. For instance, only recently BOP2 was discovered to serve as the substrate adaptor in 

an SCF E3 ligase complex to regulate LFY post-transcriptionally (Chahtane et al., 2018). 

Sumoylation is another important post-translational regulation mechanism that stabilizes proteins 

rather than promoting their turnover, and one of the hub genes for the magenta-s4 module codes 

for a SUMO (Fig. 2.8; Table, S2). SUMOs have been studied in the context of environmental stress, 

nitrogen assimilation, and flowering time, but little is known about their role in floral development 

(Park et al., 2011). GO term enrichment analysis showed that genes in the magenta-s4 module are 

significantly involved in floral organ development (Fig. 2.5c; Supp. Data 2), including the SUMO 

hub gene, making it interesting to explore their connections.  
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ABSTRACT 

In-depth investigation of meristem behavior requires not only knowledge of different molecular regulatory 

networks, but also how such networks directly control precise patterns of cell division and expansion over time. 

Floral meristem development is crucial to the reproductive success of a plant and is distinct from shoot meristem 

development for many reasons, including the fact that these meristems are determinate and undergo floral 

meristem termination (FMT). Using a recently developed live-imaging approach in the eudicot species Aquilegia 

coerulea (Ranunculaceae), we have characterized developmental dynamics during the initiation of stamen, 

staminode and carpel primordia, as well as FMT. Our results reveal how the dynamics between cell proliferation and 

expansion change as the FM transitions from production of stamens to staminodes to carpels, and uncover distinct 

patterns of primordium initiation between stamens and staminodes compared to carpels as well as subtle 

distinctions between the two whorls of staminodes. This study has also provided insight into the process of FMT, 

which is discernible based on cell division dynamics preceding carpel initiation. To our knowledge, this study is both 

the first cellular characterization of FMT in any flowering plant and the first quantitative live imaging of meristem 

development in a non-conventional model system. Our results will lay the foundation for investigating gene 

expression in A. coerulea FMs in real time, providing crucial information for our understanding of how the spatial-

temporal regulation of floral meristem behavior is achieved in both an evolutionary and developmental context. 

 

 

INTRODUCTION 

The spatial-temporal regulation of cell proliferation and expansion is a fundamental aspect 

of development in all multicellular organisms. It is particularly crucial in plants because programmed 

cell death and cell migration play no role in most developmental processes, while morphogenesis 

and organogenesis occur throughout the entire lifespan of a plant (Steeves & Sussex, 1989). The 

foundation of continuous growth in a plant is the presence of meristems, which are groups of cells 

that possess stem cell properties and are typically located at the tips of all growing axes. Meristem 

activities must be well regulated to maintain a pool of pluripotent cells and give rise to differentiating 

cells. Based on the types of tissues and organs produced, meristems can be categorized into several 

types. For instance, vegetative meristems produce vegetative organs such as leaves; root apical 

meristems are responsible for the growth of roots; and in flowering plants, there are inflorescence 
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meristems, which give rise to reproductive branches, and floral meristems (FMs), which produce 

floral organs. Meristems that produce leaves and roots are indeterminate by nature and can make 

new organs and tissues continuously. The properties of the inflorescence meristems are more 

variable, and whether they grow indeterminately or determinately differs across plant lineages 

(Kirchoff & Claßen-Bockhoff, 2013; Bartlett & Thompson, 2014). FMs, however, are always 

determinant because every FM is responsible for the production of one flower, and every flower 

terminates after the production of a relatively finite number of organs, typically culminating in 

carpels. These consistently determinate meristems are particularly interesting to study in terms of the 

spatial-temporal regulation of cell behaviors in plants. On the one hand, just like other meristems, 

FMs need to maintain homeostasis of their stem cell pools to ensure the successive production of 

organs. On the other hand, this proliferation must be terminated at a specific time point during 

floral organ initiation, a process called floral meristem termination (FMT). FMT results in the loss of 

pluripotency of all the cells that remain in the FM, which will then be incorporated into production 

of the innermost organs of the flower. 

Over the past few decades, studies using mitotic index and clonal sectors have revealed that 

most meristems are highly organized structures, composed of a central zone (CZ) and a peripheral 

zone (PZ), which harbor the stem cells and organogenic cells, respectively (Stewart & Dermen, 

1970; Marc & Palmer, 1982; Steeves & Sussex, 1989). Thus, the maintenance of stem cell identity in 

the CZ is key to meristem indeterminacy, and many key genes controlling meristem homeostasis 

have been identified. Perhaps the most critical is the stem cell identity gene WUSCHEL (WUS), 

which is exclusively expressed at the base of the central zone (also called the organizing center (Laux 

et al., 1996; Mayer et al., 1998). The WUS protein functions non-cell autonomously to induce the 

expression of the gene CLVATA3 (CLV3), which codes for a small peptide that in turn diffuses 

back to repress WUS expression (Schoof et al., 2000; Yadav et al., 2011). This WUS-CLV3 feedback 
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loop is critical for maintaining the homeostasis of stem cells in the meristems and was found to be 

widely conserved among land plants (Schoof et al., 2000; Lenhard, 2003; Yadav et al., 2011; 

Whitewoods et al., 2020). Therefore, when we consider the FMT process, we are explicitly asking 

when and how WUS expression is permanently down-regulated, a process that is best understood in 

the model systems Arabidopsis thaliana and tomato (Sun et al., 2009, 2014; Bollier et al., 2018). 

However, it remains to be seen whether these genetic pathways are more broadly conserved and, 

perhaps most importantly, both of these models have rather simple flowers with only four whorls of 

organs, representing only a small fraction of the diversity seen in angiosperms (Endress, 1990).  

Another key component of investigating FMT from a developmental perspective is 

achieving a detailed understanding of cell division and expansion dynamics. Most previous work has 

relied on histology, scanning electron microscopy, in situ hybridization, or immunolocalization, all of 

which require fixation and, in most cases, sectioning of the tissues, rendering the dynamics static 

(Sappl & Heisler, 2013; Prunet & Duncan, 2020). Recent advancements in live imaging techniques 

have allowed researchers to analyze how gene activities regulate the spatial-temporal dynamic of 

cellular behaviors quantitatively, at unprecedented resolutions and in real time (Sappl & Heisler, 

2013; Prunet & Duncan, 2020). Implementation of quantitative live imaging has provided answers to 

many long-standing questions in plant development, such as the timing of the establishment of 

adaxial/abaxial polarities during primordium initiation (Zhao & Traas, 2021), functions of the gene 

SUPERMAN in regulating organ boundaries and FMT (Prunet et al., 2017), and mechanisms 

generating the giant cells in the A. thaliana sepals (Roeder et al., 2010). Therefore, to gain an in-depth 

understanding of the dynamics of meristem function, we need both knowledge of different 

molecular regulatory networks and an understanding of how such networks directly control the 

precise actions of cell division and expansion over time, ideally in as many plant taxa as possible. So 

far, quantitative live imaging of meristems has only been developed for and applied to a small 
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number of model species: the vegetative meristems of tomato, moss, and A. thaliana (Reddy & Roy-

Chowdhury, 2009; Harrison et al., 2009; Hamant et al., 2019); the inflorescence meristems of Gerbera 

hybrida, Brachypodium distachyon, and A. thaliana (Heisler & Ohno, 2014; O’Connor, 2018; Zhang et al., 

2021); the root meristems of A. thaliana (Rahni & Birnbaum, 2019); and the early FMs of Cardamine 

hirsuta and A. thaliana (Prunet et al., 2016; Monniaux et al., 2018).  

In this study, we have applied a recently developed live confocal microscope imaging 

technique (Appendix A) to produce the first quantitative characterization of the cellular dynamics in 

the FMs of Aquilegia coerulea, with a particular focus on FMT. Aquilegia coerulea is a member of the 

buttercup family (Ranunculaceae) and is a model system for evolutionary developmental studies with 

a well-annotated genome and a number of functional tools (Kramer, 2009; Filiault et al., 2018). We 

chose to focus on the developmental window of FMT because of its crucial role in flower 

development, but also because the cell dynamic changes during FMT have not yet been described 

quantitatively in any model systems. In addition, the FMs of A. coerulea have several significant 

differences compared to the FMs of A. thaliana, one being that they are maintained for a longer 

period before FMT to allow for the production of 15 to 17 whorls of floral organs compared to the 

four whorls of organs in A. thaliana. Moreover, FMT is very different between these two systems 

from a morphological perspective. After FMT, the carpel primordia of A. thaliana arise as a single 

syncarpous gynoecium (Hill & Lord, 1989), incorporating all of the cells that remained in the apex of 

the FM. By contrast, carpels of A. coerulea are formed from five distinct primordia (i.e., an 

apocarpous gynoecium) such that the apex of the FM is not spontaneously consumed by their 

emergence (Tucker & Hodges, 2005). Currently, we have no information regarding how different 

patterns of carpel primordia initiation influence FMT in flowering plants. 

By imaging the same A. coerulea FMs in tissue culture at repeated time intervals and using the 

software MorphoGraphX (Barbier de Reuille et al., 2015), we conducted lineage tracing of cells and 
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quantified the rate and distribution of cell division, as well as the degree and direction of cell 

expansion, over multiple developmental stages. Our results have revealed how the dynamics 

between cell proliferation and expansion change as the FM transitions from production of stamens 

to staminodes to carpels, allowing a detailed description of the initial developmental stages of floral 

organ primordia. To our knowledge, this study is both the first cellular characterization of FMT and 

the first quantitative live imaging development in a non-conventional model system. Our results will 

lay the foundation for investigating gene expressions in the A. coerulea FMs in real time, providing 

crucial information for our understanding of how the spatial-temporal regulation of meristem 

behavior is achieved in both an evolutionary and developmental context.  

Figure 3.1. Floral morphology of A. coerulea flowers. (a) Side view of a mature flower. (b) Front view of a mature 
flower. (c) Floral diagram of a typical A. coerulea flower. (d) A young FM in the process of producing stamens. (e) 
A young floral bud in the initial stage of carpel development. (f) In situ hybridization of abaxial gene AqFIL in a 
young A. coerulea FM. Expression pattern was obtained by C. Meaders. se: sepals, pe: petals, st: stamens, sd: 
staminodes, car: carpels; FM: floral meristem; ICP: incipient primordia; NEP: newly initiated primordia. Scale bars: 
a, b = 1 cm; d-f = 100 µm.  
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MATERIALS AND METHODS 

 

Plant materials, growth conditions, and dissection 

Seeds of Aquilegia x coerulea 'Kiragami' were purchased from Swallowtail Garden Seeds (Santa 

Rosa, CA, USA) and germinated in damp soil. The regular growth condition for seedlings and young 

plants is 16 h daylight at 18 °C and 8 h dark at 13 °C, with humidity under 40%. Once the plants 

developed approx. six true leaves, they were transferred into vernalization conditions (16 h daylight 

at 6 °C and 8 h dark at 6 °C) for three to four weeks, and then moved back to the regular growth 

conditions. When the primary inflorescences started to develop, young side branches with axillary 

meristems were cut off from the plant, washed in 10% bleach for 20 min, and then thoroughly 

rinsed with double-distilled water three times. Axillary meristems on the branches were then 

dissected using a surgical needle under a dissecting microscope. After all the sepals were removed, 

the floral meristems placed on a petri dish with tissue culture medium composed of 0.5X Linsmaier 

& Skoog medium (Caisson Labs, Smithfield, UT), with 3% sucrose, 0.8% UltraPure Agarose 

(Invitrogen), 10-6 M kinetin (MilliporeSigma, Burlington, MA), and 10-7 M gibberellic acid (GA3, 

MilliporeSigma, Burlington, MA). The Petri dishes were placed in a tissue culture growth chamber 

with 16 h light at 20 °C and 8 h dark at 13 °C.  

 

Imaging 

FMs were stained with 0.5mg/mL propidium iodide solution in double-distilled water 

(Sigma-Aldrich, Inc, St. Louis, MO) by immersing the tissue in stain solution for 2.5 minutes for the 

initial timepoint and then 2 minutes for subsequent timepoints. The stain was removed, and the 

tissue washed in double distilled water three times. Meristems were imaged immediately after 
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staining using a LSM 980 NLO Multi-photon confocal laser scanning microscope (Ziess, Germany) 

equipped with a water immersion objective (W Plan-Apochromat 20x/1.0 DIC UV-IR M27 75mm, 

Ziess). A DPSS 514nm laser was used for excitation and emission was collected between 580-

670nm. Scans were frame averaged 2x and z-sections taken at 2µm intervals. After imaging, the 

remaining water in the petri dishes was carefully removed using a pipette and the petri dishes were 

returned to the issue culture growth chamber. All samples were imaged every 48 hours, and most of 

the samples were imagined up to three to four times (i.e., 3 to 4 TPs). Since in the current study we 

have covered a developmental window covered 6 TPs in total, we have stacked multiple 

independent time-lapse imaging series to cover the 6 TPs. For instance, there are four independent 

time-lapse imaging from spanning stages that were equivalent from TP1 to TP4, and four 

independent time-lapse imaging spanning stages that were equivalent from TP3 to TP6. Every 

successive TP interval had at least three biological replicates (i.e., independent time-lapse imaging), 

which were also used as biological replicates to construct the growth alignment graphs (Fig. 3F). 

Stacking several time-lapse experiments (with replicates) to achieve a larger developmental window 

is common in long-time live imaging studies (e.g. Kuchen et al., 2012; Kierzkowski et al., 2019). 

 

Imaging processing and data analysis 

 The confocal image files were transformed into .tif files in ImageJ 

(https://imagej.nih.gov/ij/) and processed in MorphoGraphX (https://morphographx.org/) 

following the steps listed in (Appendix A). Briefly, all image stacks were Gaussian Blurred twice with 

a radius of 1 on all X/Y/Z sigma, and all meshes were subdivided and smoothed (with 10 passes for 

each smooth) three times. Cells on the surfaces were segmented by using auto-segmentation, and all 

the segmentation errors were corrected manually. Heatmap graphs and values were generated by 

MorphoGraphX, and statistical analysis (ANOVA, Tukey's HSD) was done in R (version 1.1.456). 



64 

For the growth alignment graphs, we had four biological replicates for every developmental interval 

except TP5-TP6, which had three biological replicates. The distance between the center of each 

floral apex to the edge of the newly emerged primordia (NEP; defined in Results below) was 

normalized and divided into six equal bins. For each bin, the biological replicates were pooled and 

means for cell area expansion and cell division were calculated. 

RESULTS 

The developmental window covered in the study 

The A. coerulea flower is composed of five organ types, which, arranged from outermost to 

innermost, are the sepals, petals, stamens, staminodes, and carpels (Fig. 3.1). The five sepals are 

initiated in spiral phyllotaxy while all other organs are produced synchronously in whorls of five (Fig. 

3.1d). Each adjacent whorl initiates in alternating positions, either directly above the sepals or the 

petals, resulting in 10 orthostichies (i.e., vertical rows of organs) (Fig. 3.1c-e). Each flower consists 

of one whorl of sepals, one whorl of petals, an average of 10 to 12 whorls of stamens, two whorls of 

staminodes, and one whorl of carpels. Since we have focused on the later stages of FM development 

in the current study, the FMs we dissected for live imaging had typically initiated 8 to 10 whorls of 

stamens. For each stage, we designate the youngest primordial whorl as 1 and the subsequent whorl 

as 1+n; therefore, sd1 represents the inner whorl of staminodes that are produced after sd2, and st1 

represents the last whorl of stamens initiated in the flower (Fig. 3.1e). In addition, we define "newly 

emerging primordia (NEP)" as the youngest organ primordia of the floral bud, which just bulges out 

at the periphery of the meristem and can be distinguished morphologically; while the "incipient 

primordia (ICP)" are the primordia that are initiating after the NEP but cannot be distinguished 

morphologically yet. Both NEP and ICP can be visualized by examining expression of the 
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previously studied abaxial polarity gene FILAMENTOUS FLOWER (AqFIL) in Aquilegia (Fig. 3.1f; 

Meaders et al., 2020). 

We used a 48-hour imaging interval because we have observed that a new whorl of stamen 

or staminode primordia became visible roughly every 48 hours in our experimental conditions, and 

almost all cells that underwent a cell division during this imaging interval only divided once. Based 

on this imaging interval, we defined six time points (TP) in our study, resulting in five comparative 

developmental windows (Fig. 3.2). The first four TPs are distinguished by the successive initiation of 

floral organ whorls: st1 during TP1; sd2 during TP2; sd1 during TP3; and carpels during TP4. At 

TP5, the five carpel primordia formed a completely flat, star-shaped apex. At TP6, the carpel 

primordia each form an elevated ridge at their distal periphery. The meristematic dome was 

maintained until TP4, at which point the initiation of the carpel primordia resulted in flattening of 

the apex (Fig. 3.2). The overall distribution of observed cell sizes was consistent with previous 

observations (Steeves & Sussex, 1989) that cells in the center of the apex are generally larger than 

the cells in the periphery regions (Fig. 3.2).  

Overall growth dynamics over the developmental windows 

We used the imaging data to conduct lineage tracing of the epidermal cells of the floral 

apices to quantify their growth dynamics (Fig. 3.3). To determine whether there were any 

quantifiable differences in the patterns of growth between the TPs, we constructed growth 

alignment graphs by plotting the cell area expansion rates and the average number of cell divisions 

based on the locations of cells along the radial axis of each apex (Fig. 3.3, B1). For each apex, these 

radial transects were calculated from the center of the floral apex to the inner edges of the NEP 

whorl based on the curvature heatmap, dividing the transects into six equal bins (Fig. B1).  
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Figure 3.2. Developmental windows covered in the current study. Columns from the left to the right are the front 
view, side view, front view with curvature heatmap, and cell area heatmap of each time point (TP), respectively. 
Scale bars = 50 µm.  
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Figure 3.3. Overview of growth dynamics in each developmental window.  (a-e’) Heatmaps showing the area 
expansion rates of all cells between two successive TPs. If a cell has divided during the imaging interval, the sum 
of the cell areas of the daughter cells is compared to the cell area of the mother cell. All cells that experienced 
cell division during the interval are outlined in white. (f) Transects of cell growth from the center of the meristem 
to the most recently initiated primordia. These growth alignment graphs compare the cell area expansion rates 
(upper panel) and the average number of cell divisions (lower panel) between different developmental intervals. 
Error bars represented the standard error of biological replicates for each developmental interval. All 
developmental intervals had four biological replicates except for TP5-TP6, which had three biological replicates. 
Scale bars = 50 µm. 
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All developmental windows showed a general pattern that cell area expansion rates were 

lower at the center and higher at the periphery close to the NEP, but the overall expansion rates 

after TP4 (i.e., carpel primordia initiation; Fig. 3.3d-e', f) were significantly lower than the earlier 

developmental windows (Table B1). The area expansion rates were relatively consistent across the 

entire meristem between TP2 to TP3 (Fig. 3.3b, b', f), during which the sd1 primordia initiate. The 

cell area expansion rate displayed the largest difference between cells at the center and the periphery 

during the transition from TP4 to TP5 (Fig. 3.3d, d', f), when the newly initiated carpel primordia 

were forming the flat star apex. Interestingly, the TP5 to TP6 (Fig. 3.3e, e') window showed very 

similar cell area expansion patterns compared to TP4 to TP5 (Fig. 3.3d, d'), only differing in cells 

close to the periphery, in which the cell area expansion rates are significantly higher in TP4 to TP5 

(Fig, 3.3f; Table B1).  

Overall, rates of cell division were uniformly low in the center of the meristems across all 

time points (Fig. 3.3d-e', f), although there was a significant uptick between TP3-TP4 preceding 

initiation of the carpel primordia (Fig. 3.3c, c’; Table B1). Moving outward in the meristems, rates of 

cell division generally increased progressively, regardless of the stage (Fig. 3.3). The one distinct 

exception was in TP5-TP6, during which rates were dramatically low in the center but sharply 

increased in the third bin domain, a pattern that was statistically different from the other stages (Fig. 

3.3f; Table B1).  

Floral organ primordia initiation 

Subsequently, we analyzed how the initial outgrowth of organ primordia was achieved. Using 

st1 primordium initiation as an example, at TP1 the physical bulging of the primordia became visible 

(Fig. 3.4a, d, g). To precisely describe the growth each primordium, we defined the lateral axis as the 

axis that is parallel to the circumference of the dome of the FM, and the radial axis as the axis that  
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Figure 3.4. Initiation of st1 primordia. (a-c) Front view of a st1 primordium at TP1, TP2, and TP3, respectively. 
Cells outlined in green show the highest growth rates at TP1-TP2 (h) while cells outlined in blue show the highest 
curvature at TP1 (d). (d-f) Surface curvature heatmaps of A, B, and C, respectively. (g) Side views of the FM at the 
equivalent TPs. The white line outlines the overall shape of the FMs while the blue/green lines indicate the side 
view of the st1 primordium. (h, i) The cell area expansion heatmaps between TP1 to TP2, and TP2 to TP3, overlaid 
on B and C, respectively. Cells outlined in white are cells that experienced cell division during the interval. (j, k) 
Cell expansion anisotropy heatmaps between TP1 to TP2, and TP2 to TP3, overlaid on b and c, respectively. The 
color of a cell represents the value of the ratio between the changes in the longest axis and the shortest axis 
during the interval, and lines inside of the cell represent the degree and direction of cell expansion. White and 
red lines show the expansion, or compression, of the cell shape along the indicated axis, respectively. r-axis: radial 
axis; l-axis: lateral axis. Scale bars: a, b, c = 20 µm; g = 50 µm.  
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runs from the center of the meristem to the center of the primordium (Fig. 3.4a). At TP1, Fig. 3.4A 

shows 10 cells of this NEP that are outlined in blue, representing the majority of the cells that 

exhibited positive surface curvature (i.e., are physically bulging out) compared to their surrounding 

cells, while the 10 cells outlined in green mainly had negative surface curvature (Fig. 3.4d). This 

includes part of the boundary region that separates this NEP from the primordium in the whorl 

positioned below (Fig. 3.4d). At TP2, the cells of the green domain, which have become the abaxial 

surface of the primordium (Fig. 3.4e), were the only cells that exhibited high growth rates during this 

developmental window (Fig. 3.4h). Cell division occurred on both the abaxial and adaxial sides (Fig. 

3.4h), suggesting that this higher growth rate was mainly driven by cell expansion, which was 

supported by the cell anisotropy map (Fig. 3.4j). Cells on the abaxial side exhibited strong anisotropy 

along the radial axis, while cells on the adaxial side almost exclusively showed cell expansion along 

the lateral axis (Fig. 3.4j). At TP3, cell division occurred on both adaxial and abaxial sides of the 

primordium, and almost all cells in the primordium were exhibiting relatively high growth rates (Fig. 

3.4i). The direction of cell expansion for the abaxial cells were more isotropic at this point (Fig. 

3.4k). Interestingly, the adaxial-most layer of the cells at TP3 experienced significant compression 

along the radial axis while continuing to expand along the lateral axis (Fig. 3.4k), indicating these 

cells were incorporated into the formation of the organ boundary. 

This phenomenon, that the initial outgrowth of the primordium was mainly achieved by high 

growth rates of the abaxial cells, was also observed for the initiation of staminode and carpel 

primordia (Fig. 3.5). Before entering the rapid growth phase, the abaxial cells were initially 

comprised of only one or two layers and were less than 10 cells wide (e.g., sd1 in Fig. 3.5a and car in 

Fig. 3.5b). These cells were located at the abaxial-most position of the ICP, and many (if not most) 

of them had negative surface curvatures (e.g., sd1 in Fig. 3.5d and car in Fig. 3.5e). They then 

exhibited substantial, directional cell expansion along the radial axis, coupled with cell divisions so  
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Figure 3.5. Initiation of staminode and carpel primordia. (a-c) Front view of the sd1, sd2, and car primordia at 
TP2, TP3, and TP4, respectively. The cells outlined in green are the abaxial cells of interest of the initiating 
primordia, as defined by high growth rates during TP2-TP3 (h) or TP3-TP4 (i). (d-e) Surface curvature heatmaps of 
A, B, and C, respectively. (g) Side views of the FM at different TPs. The white line outlines the overall morphology 
of the FMs and the green line indicates the position of the primordia of interest. (h, i) Cell area expansion 
heatmaps between TP2 to TP3, and TP3 to TP4, overlaid on B and C, respectively. Cells outlined in white resulted 
from cell division during the interval. (j, k) Cell expansion anisotropy heatmap between TP2 to TP3, and TP3 to 
TP4, overlaid on b and c, respectively. The color of a cell represents the value of the ratio between the changes in 
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(Continued) the longest axis and the shortest axis during the interval, and lines inside of the cell represent the 
degree and direction of cell expansion. White and red lines show the expansion, or compression, of the cell shape 
along the indicated axis, respectively. (l) Comparisons of the number of cells with growth rates > 1.8 in primordia 
of different stages and developmental windows. Different letters above the boxplots represent significant 
differences between different primordia (p < 0.05, using ANOVA followed by Tukey’s pairwise multiple 
comparisons). (m) Comparisons of percentages of cells that had growth rates > 1.8 and also experienced cell 
division during different time points. No significant difference was detected between different primordia using 
ANOVA. (n) Comparisons of the orientation of cell division among the cells that both had growth rates >1.8 and 
experienced cell divisions. No significant difference was detected between different primordia using ANOVA. For 
(l-m), each data point is a primordium, and for each developmental window, at least three FMs were quantified. 
Note that for each time period, the identity of the ICP and NEP shift. For instance, sd2 are the ICP at TP1-TP2 but 
become the NEP at TP2-TP3. Scale bars: A, B, C = 20 µm; G = 50 µm. 

that they quickly made up half of the primordium (e.g., sd1 in Fig. 3.5h, j and car in Fig. 3.5i, k). 

Subsequently, the cells on the adaxial side started to exhibit relatively strong growth, and the 

direction of expansion of most of the cells in the primordium became more isotropic (e.g., sd1 in 

Fig. 3.5k).  

In addition, we observed that after the initial strong growth phase in the abaxial cells, the 

primordia of sd1 displayed a lower overall growth rate than other NEP; for instance, sd1 in Fig. 3.5h 

vs. sd2 in Fig. 3.5i. This observation was confirmed by quantifying the number of cells that exhibited 

growth rates above 1.8 in ICP and NEP of different developmental windows (Fig. 3.5l). During the 

developmental window TP2 to TP3, in which the sd1 was the ICP, these primordia had similar 

numbers of cells exhibiting high growth compared to ICP and NEP of other stages. However, once 

the floral buds enter the TP3 to TP4 window, in which the carpels were the ICP and sd1 was the 

NEP, the number of sd1 cells exhibiting high growth decreased significantly (Fig. 3.5l).  

Among the cells that exhibited high growth rates in the ICP and NEP of different 

developmental windows, we asked what percentage of these cells experienced cell division during 

the interval. We did not observe any significant difference between primordia of different windows 

(Fig. 3.5m) and, on average, about 50% of the cells exhibited both high growth and experienced cell 

division. We also examined the orientations of the division planes among these cells, and found that 
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while there was no significant difference between primordia of different stages and developmental 

windows, most of the cell divisions occurred parallel to the lateral axis (Fig. 3.5n).  

Early carpel development 

We then analyzed the initial development of the carpel primordia, with a particular focus on 

three regions: the distal edge, the primordial boundary, and the adaxial fold (Fig. 3.6a). From TP4 to 

TP6, the width of the distal edge increased both along the lateral axis and the radial axis, and the 

curvature of most cells increased (Fig. 3.6b-d). Over the same period, the primordial boundary 

became more folded towards the center of the apex (Fig. 3.6e-g). At TP4 and TP5, the regions that 

would become the adaxial folds transition from having positive surface curvature to having close to 

zero (i.e. flat) surface curvature (Fig. 3.6h, i). At TP6, invagination of the adaxial fold appeared to 

initiate at the base of the primordium and propagate outward such that the proximal region was 

more deeply folded than the distal at this stage (Fig. 3.6j). 

Once the five carpel primordia were initiated, two processes occurred simultaneously to 

achieve the flat star shape (Fig. 3.6). First, cells at the distal edges of the carpel primordia continued 

to display relatively high growth rates (Fig. 3.6c'), while cells at the center of the floral apex exhibited 

much lower overall growth rates (Fig. 3.3). This had the effect of elevating the carpel primordia to 

the same level as the center of the floral apex. However, unlike the early initiation of the carpel 

primordia, during which growth was mainly driven by the strong anisotropic expansion from the 

abaxial cells (Fig. 3.5i, k), the overall anisotropy of the cells on the carpel primordia distal edges was 

lower and less directional (Fig. 3.6c"). Meanwhile, numerous cells underwent cell division during this 

developmental window, suggesting that growth was mainly driven by cell division (Fig. 3.6c'). 

Second, cells at the primordial boundaries experienced strong compression along the lateral axis 

(Fig. 3.6f"), which helped to define the primordial boundary regions of the flat star shape.  
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Interestingly, at this stage, although the floral apex was flat and the adaxial folds were not yet 

physically visible (Fig. 3.6i), minor compression of cells in the future location of the adaxial fold can 

already be observed (Fig. 3.6i").  

Figure 3.6. Early carpel primordia development. (a) Front view and side view of an A. coerulea FM at TP6 to 
indicate different regions of interest. (b-d) Side views of the surface curvature heatmaps of the distal edges of 
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(Continued) carpel primordia at TP4, TP5, TP6, respectively. (e-g) Side views of the surface curvature heatmaps of 
the primordial boundaries between carpels at TP4, TP5, TP6, respectively. (h-j) Front view of the surface 
curvature heatmaps of the adaxial folds of carpel primordia at TP4, TP5, TP6, respectively. (c’, c’’) Heatmaps of 
cell area expansion and anisotropy of distal edges between TP4 to TP5, respectively, overlaid onto TP5. (d’, d’’) 
Heatmaps of cell area expansion and anisotropy of distal edges between TP5 to TP6, respectively, overlaid onto 
TP6. (f’, f’’) Heatmaps of cell area expansion and anisotropy of primordial boundaries between TP4 to TP5, 
respectively, overlaid onto TP5. (g’, g’’) Heatmaps of cell area expansion and anisotropy of primordial boundaries 
between TP5 to TP6, respectively, overlaid onto TP6. (i’, i’’) Heatmaps of cell area expansion and anisotropy of 
adaxial folds between TP4 to TP5, respectively, overlaid onto TP5. (j’, j’’) Heatmaps of cell area expansion and 
anisotropy of adaxial folds between TP5 to TP6, respectively, overlaid onto TP6. Cells outlined in white in all cell 
area expansion heatmaps were cells that experienced cell divisions during the intervals. Green dashed boxes in i, 
i’, i’’, j, j’, j’’ indicate the adaxial folds. All distal edge panels are the side view of the distal edge, all primordial 
boundary panels are the side views of the primordial boundary, and all adaxial fold panels re the front view of the 
adaxial fold. Scale bars = 20 µm. 

After formation of the flat star apex, the carpel primordia began to elevate along their distal 

ridges, which was mainly achieved by concentrated cell divisions on the ridges (Fig. 3.6d', j') while 

the anisotropic expansion rates of cells on the ridges remained low (Fig. 3.6d"). The growth 

alignment graphs in Fig. 3 also support this observation of concentrated cell divisions in the 

peripheral region relative to the earlier developmental windows (Fig. 3.3). Meanwhile, the cells at the 

primordial boundaries continued to experience strong compression along their lateral axis. We did 

not observe any further cell division in the primordial boundaries (Fig. 3.6g', g"). In addition, the 

adaxial folds of the carpels have become morphologically visible (Fig. 3.6j), exclusively achieved by 

modifications in cell shape since no cell division occurred in the region (Fig. 3.6j'). Specifically, cells 

of the adaxial fold located closer to the center of the floral apex experienced strong compression, 

while those in the distal region of the adaxial fold exhibited strong anisotropic expansion along the 

radial axis (Fig. 3.6j"). 

DISCUSSION 

Cellular dynamic change during FMT in A. coerulea 
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Despite its essential role in floral development, little is known about meristem dynamics 

during FMT at a cellular level, and the molecular basis of FMT has only been investigated in A. 

thaliana and tomato (Sun et al., 2009, 2014; Bollier et al., 2018). In A. thaliana, FMT is marked by 

down-regulation of the gene WUS, which determines stem cell identity; this shift also coincides with 

the initiation of carpel primordia (Sun et al., 2009, 2014). Therefore, FMT defines the transition from 

being pluripotent to organogenic for the cells in the central zone, and thus the precise timing of 

WUS repression is considered a key factor that determines the number of cells produced for carpel 

development (Sun et al., 2014; Sun & Ito, 2015).  

Previous transcriptomic sequencing in young A. coerulea FMs indicated that the expression of 

AqWUS is maintained during the developmental stages equivalent to TP1 through TP3 in the 

current study, with expression dropping rapidly to undetectable levels during the developmental 

stages equivalent to TP4 to TP6 (Min & Kramer, 2020). If we examine the central region of the FM 

(i.e., bin1 and bin2 in the growth alignment graphs, Fig. 3.3f), which roughly corresponds to the 

central zone, we did observe similarly low numbers of cell divisions between TP1 to TP3 (Fig. 3.3f; 

Table B1), with bin2 being higher than bin1. During TP4 to TP6, which corresponds to the early 

stages of carpel development, the average number of cell divisions in the center of the floral apex 

was close to zero (Fig. 3.3f; Table B1). However, most strikingly, we observed a higher number of 

cell divisions in the center of the floral apex between TP3 to TP4, during which the carpel primordia 

are initiated (Fig. 3.3c, c', f), with the bin1 values being statistically significantly higher than all other 

stages (Fig. 3.3f; Table B1).  

This observation raises some intriguing questions: Why is there an increase in cell division in 

the central zone when the carpel primordia are initiating, and what is responsible for the pattern? 

This period also appears to correspond with the onset of FMT based on the decline in AqWUS 

expression, so is this the last flush of CZ cell divisions or are the divisions related more directly to 
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initiation of the carpel primordia? Answering these questions will require a better understanding of 

how AqWUS down-regulation is controlled in Aquilegia, particularly the nature of any “timer 

mechanism” regulating the number of cell divisions before FMT. In the FMs of A. thaliana and 

tomato, the gene KNUCKLES (KNU) is activated in a cell division-dependent manner, which 

determines the temporal control of FMT, since once KNU is activated, it terminates the expression 

of WUS. Manipulation of cell cycles in the FM can accelerate or delay the activation of KNU, which 

results in the premature or delayed termination of the FM, respectively (Sun et al., 2014). We 

currently do not know whether the KNU-WUS pathway is conserved in other angiosperm systems, 

especially taxa with more than one whorl of stamens and unfused carpels but, even if it is not 

conserved, it will be interesting to examine whether a division-dependent timing mechanism is used 

for FMT in general. Overall, the combined patterns of cell behavior we observe at the center of the 

meristem during TP3-TP4 then transitioning into TP4-TP5, which include a sudden uptick in 

divisions during TP3-TP4 and a sharp decline in cell expansion following this phase, appear to be 

markers for a loss of stem cell identity in this zone in conjunction with the FMT. 

 

Floral organ primordia initiation in A. coerulea 

In examining the initiation of the stamen, staminode, and carpel primordia, we observed 

interesting dynamics in the relative growth behavior of the adaxial and abaxial cells (Fig. 3.4; Fig. 

3.5). First, only some of the cells that initially exhibited positive curvature in the NEP end up as 

adaxial cells in the primordium proper, with the adaxial-most cells being incorporated into the 

primordium boundary. Second, cells with negative surface curvature that were mainly located in the 

boundary region below the initial bulge ultimately become the cells exhibiting the highest growth 

rates. These high growth rates were mainly driven by the high anisotropic cell expansion, which 

coupled with later cell division quickly promotes outgrowth of the abaxial surface of the 
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primordium. This pattern is consistent with a previous study of expression of the abaxial polarity 

gene AqFIL, which is detected broadly across the entire ICP and most of the NEP (Fig. 3.1f), 

similar to the expression patterns of FIL in A. thaliana FMs (Meaders et al., 2020; Zhao & Traas, 

2021). It is curious that cells exhibiting the highest growth rates are along the extreme abaxial margin 

of the primordium, representing only a portion of the typical abaxial domain, a pattern that has also 

been observed during leaf and sepal primordium initiation in A. thaliana (Zhao & Traas, 2021). A 

close examination of the spatial-temporal expression patterns of other polarity genes in A. coerulea 

will be a good starting point to decipher any potential difference in the abaxial cells, as well as the 

transition of cells that were originally in the adaxial surface but ended up in the organ boundary 

regions.  

The observed difference in the growth dynamics between sd1 and sd2 was more surprising. 

Once the primordia initiate as NEP, the growth rates of sd1 appeared to be lower than other NEP 

and ICP in other developmental intervals (Fig. 3.5l). Although the sd1 and sd2 whorls have the same 

staminode identity (Kramer et al., 2007; Sharma & Kramer, 2013), a previous study has observed 

subtle morphological differences that are apparent when the primordia are as small as 1-2 mm in 

length, most notably lateral marginal curling that facilitates late-stage adhesion between the organs 

(Meaders et al., 2020). In that study, the authors raised the question of whether these differences 

were developmentally determined from the earliest stages or were due to some kind of inductive 

interaction of the tissues. Our observation of differences from inception may suggest that they do 

harbor distinct developmental trajectories from their earliest stages, possibly implicating identity-

based differences. 

In addition, we examined the early developmental processes of the carpel primordia in detail, 

capturing a transition from growth that is mainly driven by strong anisotropic cell expansion to one 

that is promoted by concentrated cell divisions (Fig. 3.6). The initial cell expansion phase helps to lift 
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the carpel primordia up, while the cell division phase appears to sculpt their shape (Fig. 3.5i, k; Fig. 

3.6). The first phase of cell expansion seems to be very similar to the initiation of the stamen and 

staminodes, which was likewise driven by strong anisotropic expansion by a small number of abaxial 

cells (Fig. 3.5). However, the second phase of carpel growth is quite different from the other organs 

in that there is a much stronger reliance on accumulation of cell divisions while the cell areas did not 

expand significantly (e.g., st1 in Fig. 3.4 compared to Fig. 3.6). This observation could suggest that 

we observed a transition between two sets of molecular programs during early carpel primordia 

growth: one for the earliest phase of primordia initiation that is common to all floral organs and the 

subsequent program that is specific to sculpting carpel primordia.  
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ABSTRACT 

Floral meristem termination (FMT) is one of the defining features of a floral meristem (FM). Unlike vegetative 

meristems, which possess persistent stem cell activity and can generate new leaves continuously throughout the 

lifespan of a plant, the stem cell activity in a FM will always terminate at a specific time point during primordia 

initiation, since each flower only has a finite number of organs. Variation in the timing of FMT is an essential source 

of generating floral morphological diversity, but how this process is fine-tuned at a developmental and evolutionary 

level is still poorly understood. Aquilegia is a well-suited system for investigating this fundamental process, since 

flowers from different Aquilegia species have identical numbers of all floral organs except for stamens. Therefore, 

variation in the timing of FMT can be represented by consistent differences in stamen whorl numbers between 

species. We conducted quantitative trait loci (QTL) mapping of this phenotype by crossing two sister species, A. 

canadensis and A. brevistyla. Our results reveal a complex genetic architecture with seven major QTL underlying 

variation in FMT. Each QTL has a small effect, which together account for 46.5% of the phenotypic variation. Utilizing 

previously published RNA-sequencing data, we identified potential candidate genes under every QTL, and used in 

situ hybridization to reveal novel expression patterns of select candidate genes. To our knowledge, this is the first 

study to attempt to dissect the genetic basis of how natural variation in the timing of FMT is regulated, and our 

results provide critical insight into the regulation of FMT and how floral morphological diversity can be generated at 

the meristematic level.  

INTRODUCTION 

Indeterminate growth is the foundation of development in all vascular plants and is achieved 

by the persistent activity of stem cells in the meristems (Steeves & Sussex, 1989). Apical meristems 

in the shoots and roots are highly organized structures that maintain a delicate yet robust balance 

between the production of cells that give rise to organs and the renewal of the stem cell population. 

In the flowering plants, when a plant enters the reproductive phase, the vegetative meristem 

transitions from producing leaves to reproductive identity, which results in the production of floral 

organs. Although the overall cellular organization of the vegetative meristem and the floral meristem 

(FM) is highly similar, the transition to the FM identity is accompanied by a number of changes in 

the properties of the meristem, including changes in the rate of organ production, the patterns of 

primordia initiation, and an eventual loss of indeterminacy.  
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 The establishment of determinacy in the FM is a well-regulated process, termed floral 

meristem termination (FMT), which is crucial and universal in the development of all flowers (Fig. 

4.1). A typical flower has four types of floral organs: sepals, petals, stamens, and carpels, which are 

arranged from the outermost to the innermost positions of a flower (Fig. 4.1). Although the central 

stem cells stay active in the initial phase of floral organ primordia initiation, this activity will cease at 

a specific time point, after which all cells will be incorporated into the development of the terminal 

carpels (Steeves & Sussex, 1989). The precise control of FMT is critical to ensuring that the flower 

has the correct number of organs, but it is also important to note that variation in the timing of 

FMT is an important source of floral morphological diversity and novelty. For some species, such as 

Arabidopsis thaliana, FMT occurs relatively quickly, and only four whorls of floral organs are 

produced. In many other taxa, FM activity is maintained for a more extended period; species from 

the Magnoliaceae, Monimiaceae, Nelumbonaceae, Nymphaeaceae, Papaveraceae, and 

Ranunculaceae, for instance, can have hundreds of spirally-arranged or whorled floral organs 

(Endress, 1990; Fig. 4.1). Moreover, increased numbers of floral organs can create the raw materials 

for the evolution of new organ types, such as the sterile staminodes observed in Aquilegia 

(Ranunculaceae) or Mentzelia (Loasaceae) (Walker-Larsen & Harder, 2000). Understanding how FMT 

is regulated in different angiosperm lineages is, therefore, interesting from both developmental and 

evolutionary perspectives. The diversity in floral morphology of the ~400,000 angiosperm species is 

seemingly infinite, but one of the few major evolutionary trends from the early-diverging 

angiosperms to both the core eudicot and monocot lineages is the transition from variable to stable 

whorl numbers in a flower (Endress, 1990), which is directly determined by the timing of FMT. 

 Currently, we have relatively good knowledge of the genes that are responsible for 

maintaining and terminating stem cell activities in the A. thaliana FM, but how the timing of FMT is 

fine-tuned at the developmental and evolutionary level is poorly understood. In the FM, the  
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Figure 4.1: FMT is an important and fine-tuned developmental process that occurs in all flowers. Upper panel: 
diagram of floral organ initiation and FMT during flower development. Organs of the same whorl share the same 
colors. Lower panel: example of four flowers with different whorl numbers. From left to right: Crocus vernus 
‘Pickwick’, Pyrus communis, Helleborus orientalis, and Franklinia alatamaha. Numbers in the parentheses indicate 
the number of whorls of floral organs in each flower. Photos of Crocus and Pyrus were taken by Ya Min, and 
photos of Helleborus and Franklinia were taken by Evangeline S. Ballerini and Jacob Suissa, respectively.  

maintenance of the stem cell population is achieved by a feedback loop between the homeodomain 

protein WUSCHEL (WUS) and the CLAVATA (CLV) ligand-receptor system, in which WUS 

promotes central stem cell activity and induces the expression of the CLV3 peptide, while activation 

of the CLV signaling pathway, in turn, represses the expression of WUS (Schoof et al., 2000; 

Lenhard, 2003; Müller et al., 2006). In the early developing FM, the expression of the C class organ 

identity gene AGAMOUS (AG) is induced by WUS acting as a co-factor with the FM identity gene 

LEAFY. AG, in turn, specifies the identity of stamens and carpels in the inner whorls of a flower 

and is also responsible for the down-regulation of WUS expression (Lenhard et al., 2001). While the 

broad conservation of the WUS-CLV and WUS-AG feedback loops have been demonstrated in 
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diverse plant taxa (Nardmann & Werr, 2006; Litt & Kramer, 2010; Whitewoods et al., 2020), the 

exact mechanisms by which AG controls the precise timing of WUS down-regulation have only 

been investigated in A. thaliana and tomato (Solanum lycopersicum). Specifically, AG activates the 

expression of a C2H2 zinc-finger transcription factor, KNUCKLES (KNU), which directly represses 

WUS together with adaptor proteins from the MINI ZINC FINGER (MIF) protein family (Payne, 

2004; Sun et al., 2009; Bollier et al., 2018). Accurate timing of FMT is achieved in A. thaliana because 

the activation of KNU by AG takes approximately two rounds of cell divisions, during which the 

stamen primordia are initiated. After FMT is achieved, all of the cells remaining in the center of the 

FM are incorporated into the carpel primordia (Sun et al., 2009).  

 However, integral to the precise mechanism of KNU activation is that it only allows for the 

production of one whorl of stamens and one whorl of carpels in a flower. This begs the question of 

whether this pathway is conserved in systems that have more than just four whorls of floral organs. 

Nonetheless, all currently established model systems (and their close relatives) belong to lineages in 

the core eudicots or monocot grasses that exhibit no variation in their floral whorl numbers, while 

most of the plant taxa exhibiting variation in whorls do not have the genomic or genetic resources 

nor functional tools. Thus, they cannot provide a useful starting point for the investigation of the 

degree of conservation in this known pathway, or how natural variation in the timing of FMT is 

regulated in general.  

 To that end, Aquilegia from the buttercup family (Ranunculaceae) is exceptionally well-suited 

for investigating this fundamental developmental process. There are approximately 70 Aquilegia 

species, which share a low interspecific sequence variation and a high degree of inter-fertility due to 

a recent adaptive radiation (Filiault et al., 2018). All Aquilegia species but one (A. jonesii, which lacks 

staminodes; Munz, 1946) have the same floral organ arrangement, consisting of one whorl of five 

sepals, one whorl of five petals, many whorls of stamens, two whorls of five staminodes (i.e., 10 in 
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total), and one whorl of five carpels (Fig. 4.2a). These floral organs are arranged in 10 orthostichies 

(vertical rows of organs), with alternate orthostichies either positioned directly above the sepals or 

the petals (Fig. 4.2a). 

Figures 4.2: Phenotyping SWN in the parental and F2s populations. (a) Photos of flowers and floral diagrams of A. 
brevistyla and A. canadensis. (b) Examples of three F2 flower buds with different SWN. (c) Flowers that were 
sampled per inflorescence. (d) Developmental stages for which SWN were counted. (e) Histogram and summary 
statistics of SWN distribution in parental species and the F2s. In (a) and (b), stamen whorls positioned above the 
sepals are colored in blue while stamen whorls positioned above the petals are colored in green. Scale bar in (b) = 
100 µm. se: sepals; pe: petals: st: stamens; sd: staminodes; car: carpels.

Aquilegia brevistyla and A. canadensis are North American sister species (Bastida et al., 2010; 

Fior et al., 2013; Fig. 4.2a) and, based on previous empirical field observation, their flowers differ in 

their number of stamen whorls (Munz, 1946). Given that the number of whorls of all the non-

stamen floral organs (i.e., sepals, petals, staminodes, and carpels) is identical in these two species, the 

variation in what we term Stamen Whorl Number (SWN) can be directly translated into variation in 

the timing of FMT: if the FM is terminated earlier, it will have a smaller SWN compared to a flower 

of which the FM stays active longer. Using SWN as a quantitative trait, we crossed A. brevistyla and 

A. canadensis and conducted quantitative trait locus (QTL) mapping in the resultant F2 generation.
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Our results reveal a complex genetic architecture with seven major QTL underlying the variation of 

FMT. To our knowledge, this is the first study to attempt to dissect the genetic bases of how the 

natural variation in the timing of FMT is regulated, and our results highlight several potential 

candidate genes and molecular pathways that may contribute to the regulation of FMT in Aquilegia.  

 

MATERIALS AND METHODS 

 

Plant material and growth conditions 

 A. brevistyla and A. canadensis seeds were collected from wild populations in Alberta (Canada) 

and Ithaca (NY, USA), respectively. One A. canadensis (pollen recipient) was crossed with one A. 

brevistyla (pollen donor) to generate the F1 generation. Five F1s were self-fertilized to generate the F2 

population. All F2 seeds were stratified at 4 ˚C in the dark for two to four weeks, germinated in wet 

soil, and transplanted in individual pots. All plants were vernalized at 4˚C for two months to induce 

flowering. The parental and F1 individuals were grown in the greenhouse of the University of 

California Santa Barbara, and the F2 populations were grown in the greenhouses of Harvard 

University. All greenhouses used the same light and temperature conditions to achieve a 16h/8h 

(day/night) photoperiod at 18˚C and 13˚C. 

Seeds of Aquilegia x coerulea 'Kiragami' were purchased from Swallowtail Garden Seeds (Santa 

Rosa, CA, USA), germinated in wet soil, and grow under the same 18˚C /13˚C (day/night) condition 

as described above. Once the plants developed approx. six true leaves, they were transferred into 

vernalization conditions (16 h daylight at 6 °C and 8 h dark at 6 °C) for three to four weeks, and 

then moved back to the regular growth conditions to promote flowering. 

 

Meristem size measurement 
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 The entire inflorescences of at least six individuals of each parental species were collected 

and fixed in FAA (10% formaldehyde, 50% ethanol, 5% acetic acid), and stored at 4˚C. Samples 

were then dehydrated through a graded ethanol series to 100%, transferred to 100% CitriSolv, and 

embedded in Paraplast Plus (Sigma-Aldrich). Embedded tissues were sectioned to 8 µm thick 

ribbons with a rotary microtome, stained in 0.1% Toluidine Blue O solution following the protocol 

described in Ruzin (1990), and mounted in Permount Mounting Medium (Fisher Scientific). Sections 

were then imaged using the Axio Zoom Microscope at the Harvard Center for Biological Imaging. 

The width of each floral meristem section was measured using ImageJ. Three to six serial sections 

were measured for each FM, and at least three FMs were measured for each developmental stage of 

each species. All FMs that were measured were non-terminal flowers. Early developmental stages 

were divided into five stages based on the number of stamen whorls that had initiated in the FM. 

During very early stages, it was not possible to morphologically distinguish the petal and stamen 

primordia based on the histological sections. Therefore, the stages were defined with a range of 

numbers to include the possibility of including zero to one whorls of petals.  

 

Phenotyping 

For each plant, the SWN of the terminal flower and lateral flowers 1 to 4 from the first three 

inflorescences were counted (Fig. 4.2c). If flowers of these positions in an inflorescence were 

damaged/undeveloped, flowers at other positions were counted to achieve a total number of five 

flowers per inflorescence. If an inflorescence produced less than five flowers, all flowers were 

counted. SWN were counted when the flowers reached approx.1-2 cm in length (Fig. 4.2d) because 

at that developmental stage, all the stamens were arranged in vertical rows, which simplified 

counting. 
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Genotyping 

Detailed genotyping information can be found in (Edwards et al., 2021). Briefly, the DNA of 

the two parents that generated the cross was extracted from flash-frozen young leaves using 

NEBNext Ultra II kit (NEB) and sequenced to ~40x coverage as 150 bp reads on an Illumina 

MiSeq at the Biological Nanostructures Lab in the California NanoSystem Institute at UC Santa 

Barbara. DNA of F2s was extracted from silica dried young leaves using Qiagen DNEasy reagents 

and Magattract beads (Qiagen, Inc.), libraries were prepared following the protocol of RipTide High 

Throughput Rapid DNA Library Preparation kit (iGenomX, CA, USA). The F2 libraries were 

pooled and sequenced at the Vincent J. Coates Genomics Sequencing Laboratory (UC Berkeley) 

using NovaSeq 6000 platform to generate 150bp paired-end reads. Samples were multiplexed to 

generate about 1-2x coverage. All sequence data are deposited in the Sequence Read Archive under 

BioProject ID PRJNA720109. Scripts and genotype/phenotype data are available at: 

https://github.com/anjiballerini/can.x.brev/. 

Sequences were aligned to the A. coerulea ‘Goldsmith’ v3.1 reference genome 

(https://phytozome.jgi.doe.gov) using the Burrows-Wheeler aligner (Li & Durbin, 2009) and 

variable sites in the parents were identified using SAMtools 0.1.19 (Li et al., 2009a) with custom 

scripts were used to identify the positions and genotypes at which the parents were homozygous for 

different alleles. These sites were used to assign reads in the F2s as having either A. canadensis or A. 

brevistyla ancestry. To determine the genotypes of the F2s, the genome sequences were binned into 

0.5 Mb regions with moderate to high recombination frequencies and 1 Mb in regions with low or 

no recombination, and the frequency of reads with ancestry for each F0 parent was used to 

determine the genotype of the bin. These bins and genotypes were used as markers to construct a 

genetic map and conduct QTL mapping. This genotyping method has been implemented in Filiault 

et al., 2018, Ballerini et al., 2020, and Edwards et al., 2021. 
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Mapping 

After filtering out individuals and markers with more than 10% of information missing due 

to sequencing quality, we retained a total of 366 individuals and 620 markers. A genetic map of the 

seven chromosomes was then constructed following the protocol of the R/qtl package v1.46-2 

(Broman et al., 2003), with an error probability rate of 0.001 and “kosambi” map function. Standard 

interval mapping with Haley-Knott regression (function scanone) was used for the initial mapping 

searching for potential QTL. The best multi-QTL models are produced and selected by using 

function stepwiseqtl, which implement penalties on different interactions and drop one of the current 

main effects or interactions in each round of model comparison. Interactions among potential QTL 

and between QTL and covariance were detected with a two-dimensional genome scan (function 

scantwo). Using the estimated positions of QTL from scanone, stepwiseqtl, and scantwo as the input, the 

positions of QTL were refined by using the function makeqtl and refineqtl, which then fit with a 

defined multiple-QTL model (function fitqtl) with all detected interactions. F1-parent-of-origin was 

used as covariance in all the tested mapping models. Position and effect size of QTL were estimated 

using drop-one-term ANOVA in the best-fitting model. Chromosome diagram with candidate genes 

(Fig. 4.4) was produced by using the LinkageMapView (Ouellette et al., 2018). 

In situ hybridization of candidate genes 

Variable regions of the genes of interest were amplified by PCR (primers in Table C6) from 

young inflorescence cDNA of Aquilegia x coerulea ‘Kiragami’. The PCR products were cloned into the 

pCRTM4-TOPO vectors, sequenced to confirm identity, and reverse transcribed using T3 or T7 

RNA polymerase and DIG RNA labeling mix (Sigma-Aldrich). Probe qualification and in situ 

hybridization steps followed (Kramer, 2005). Slides were stained in calcofluor white for 5 min before 
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imaging, and pictures were taken using the ZEISS Axio Zoom at the Harvard Center for Biological 

Imaging. 

Statistical analysis 

All statistical analyses (e.g. ANOVA, Tukey’s HSD) were performed using R (version 

1.1.456). 

Gene trees 

Homologs of AqROXYa and AqATH1 from various taxa were obtained by using BLAST 

on Phytozome (https://phytozome-next.jgi.doe.gov/). Multiple sequence alignments and neighbor-

joining phylogenetic trees were constructed using Geneious Prime (v2021.1.1). We did not construct 

phylogenetic trees for other candidate genes because their homologs in A. coerulea and A. thaliana 

were each other’s reciprocal top BLAST hits.  

RESULTS 

SWN variation in the parental species and the F2s 

We counted the SWN from 357, 197, and 4265 flowers from 27, 16, and 364 A. brevistyla, A. 

canadensis, and F2 individuals, respectively (Fig. 4.2). The SWN per individual of the parental species 

did not overlap: the mean SWN of A. brevistyla ranges from 6.69 to 7.57; that of A. canadensis, from 

8.54 to 10; and that of the F2s, which overlapped with the range of both parental species, from 6.20 

to 9.50 (Fig. 4.2e). The mean SWN for all A. brevistyla, A. canadensis, and F2s were 7.16, 9.16, and 

8.06, respectively. Subsequently, we analyzed whether the position of flowers on the inflorescence is 

associated with their SWN (Fig. 4.2c). Flower position had a significant effect on the SWN for both 
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parental species but not for the F2s (Fig. C1). Post hoc tests revealed that only the SWN of the 

terminal flower (TF) vs. first lateral flower (LF1) were significantly different for both parental 

species, suggesting that the significant positional effect was mainly driven by the difference in SWN 

between the TF and the LF1 (Fig. C1). Moreover, due to the severe inbreeding depression of 

Aquilegia species (Montalvo, 1994; Yang & Hodges, 2010), each F1 individual only produced a 

limited number of viable seeds. Therefore, the 364 F2s individuals were the progenies of five self-

pollinated F1 individuals. One-way ANOVA revealed that the SWN of the F2s differed significantly 

between the F1 parents (Fig. C2). Lastly, we also analyzed the variation of SWN among flowers of 

the same plants. Interestingly, a small portion of A. brevistyla (7.4%), A. canadensis (18.8%), and F2s 

(6%) showed no variance in the SWN across all flowers counted within an individual, and this 

phenomenon was dependent on neither the number of flowers counted per individual plant (Fig. 

C3; Pearson's correlation = 0.052, t = 0.98418, df = 345, p = 0.3257) nor the F1-parent-of-origin of 

the F2s (Fig. C3). No significant correlation between the mean SWN per individual and the standard 

deviation of SWN per individual was detected (Pearson's correlation = 0.035, t = 0.70438, df = 404, 

p = 0.4816). 

 

Floral meristem size  

To determine whether the initial FM sizes were different between the parental species, we 

measured the widths of FMs of the parental species at their earliest developmental stages (Fig. 4.3). 

In general, the FMs of A. canadensis appeared to be slightly, but significantly wider, than those of A. 

brevistyla throughout the early developmental stages (Fig. 4.3; Table C1). The average FM widths of 

A. canadensis and A. brevistyla before the initiation of carpel primordia were 174.68 µm and 191.67 

µm, respectively (Table C1). Interestingly, the developmental windows for significant FM size 

expansion seemed to be longer in A. canadensis than A. brevistyla (Fig. 4.3; Table C1). The significant 
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increase in widths of A. brevistyla FMs occurred when there were 0 to 4 whorls of non-sepal floral 

organs initiating, while the significant increase in the widths of A. canadensis FMs encompassed a 

larger developmental period, ranging from the stages that there were 0 to 6 whorls of non-sepal 

floral organs initiating (Table C1). 

 
Figure 4.3. FM widths measurements of the parental species during the early developmental stages. (a) Examples 
of FM morphologies in A. brevistyla and A. canadensis at early developmental stages. Numbers in the parenthesis 
indicate the number newly initiated stamen whorls in each FM. Scale bars = 100 µm. (b) Comparison of FM width 
of difference developmental stages between A. brevistyla and A. canadensis. Each data point represents a 
measurement of a FM width from a section. Three to six continuous sections were measured for each FM, and at 
least three FMs were measured for each developmental stage of each species. Comparison of FM widths of each 
stage between the parental species was done using Tukey’s HSD. ns: not significant; ***: p-value < 0.001; ****: 
p-value < 0.0001; se: sepal; B: A. brevistyla; C: A. canadensis.  

 

Genetic architecture underlying stamen whorl variation 

The genetic map was constructed using a total of 620 genetic markers, which fell into seven 

linkage groups (Fig. C4). We recovered seven major QTL using the mean SWN per individual as a 
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phenotype and the F1-parent-of-origin as a covariate, with one QTL on each chromosome (Fig. 

4.4a; Table 3.1). The difference in LOD scores between models that included or excluded the 

covariate are diminutive on all chromosomes (ranging from -0.3 to 0.49; Fig. C5a), indicating no 

significant interaction between the QTL and the covariate. We also performed a two-dimensional 

genome scan to search for evidence of the presence of more than one QTL on each chromosome 

but did not obtain any significant evidence (Table C2).  Although the initial standard interval 

mapping seemed to indicate the presence of two QTL, the presence of only one true QTL on 

chromosome 2 was further confirmed by controlling the two potential QTL: when the true QTL 

(i.e., Q2) was controlled, the presence of the second peak also disappeared (Fig. C5b). We did detect 

significant interactions between two pairs of QTL: Q3 and Q7, and Q1 and Q6 (Fig. C5c), and thus 

incorporated these interactions in the full QTL model (Table 3.1).  

The full QTL model had a total LOD score of 48 and explained 46.5% of the observed 

phenotypic variation (Table 3.1). Q3, Q4, and Q5 exhibit larger additive effects than dominant 

effects, while the remaining QTL have larger dominant effects on the phenotypic variation (Fig. 

4.4a, C6; Table 3.1). The phenotypic variation explained by each QTL and the QTL interactions was 

very similar, with Q4 and Q6 haing the largest additive and dominant effects, respectively, and each 

explained 8.8% of the phenotypic variation (Table 3.1). This suggested the genetic architecture of 

SWN is a complex trait controlled by multiple loci, each with small effect.  
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Figure 4.4: Genetic architecture and candidate genes. (a) LOD scores across seven chromosomes. Red line: α = 
0.05 genome-wide significance cutoff based on 1000 permutations. (b) Locations of QTL interval (pink regions on 
the chromosomes and magenta vertical bars), candidate genes, and genetic markers. All the genetic markers 
were named in numeric forms (e.g., 1.67 and 2.25) and only markers with the highest LOD scores under each QTL 
are shown. 
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Table 4.1: Summary statistics for QTL. Chr: chromosome; PVE: percent variance explained; Add./(a): additive affects; 
Dom./(d): dominant effects. 
 

  Full model result:   
  y ~ Q1 + Q2 + Q3 + Q4 + Q5 + Q6 + Q7 + Q1:Q6 + Q3:Q7   
   df SS MS LOD PVE Pvalue(F)   
  Model 22 61.87 2.81 48.04 44.47 0   
  Error 331 71.27 0.22      
  Total 353 133.14       
           
Drop one QTL at a time ANOVA table 
 Chr  Position 

(cM) 
df Type III 

SS 
LOD PVE F value Pvalue 

(F) 
Add. Dom. 

Q1 1 44.233 6 5.87 6.1 4.4 4.6 <0.001 0.05 -0.16 
Q2 2 19.676 2 4.89 5.1 3.7 11.4 <0.001 -0.07 0.2 
Q3 3 24.050 6 7.43 7.6 5.6 5.7 <0.001 -0.11 -0.01 
Q4 4 25.406 2 11.73 11.7 8.8 27.3 <0.001 -0.27 0.07 
Q5 5 30.155 2 6.89 7.1 5.2 16.0 <0.001 -0.25 0.17 
Q6 6 34.828 6 11.72 11.7 8.8 9.1 <0.001 -0.14 -0.27 
Q7 7 20.944 6 7.38 7.6 5.6 5.7 <0.001 0 0.15 
Q1 * Q6 4 5.45 5.7 4.1 6.3 <0.001   
Q3 * Q7 4 5.39 5.6 4.1 6.3 <0.001   

 
Estimated effects for QTL interactions 
Q1 (a) * Q6 (a): 0.01 Q1 (d) * Q6 (a): -0.23 Q1 (a) * Q6 (d): -0.38 Q1 (d) * Q6 (d): 0.45 
Q3 (a) * Q7 (a): 0.19 Q3 (d) * Q7 (a): 0.09 Q3 (a) * Q7 (d): -0.16 Q3 (d) * Q7 (d): -0.24 

  

Candidate genes  

In order to identify potential candidate genes underlying these QTL, we examined the 

genomic regions defined by markers that flanked the 95% Bayesian credible interval of each QTL, 

which was calculated by using the posterior distribution of 10^LOD on a given chromosome. The 

genomic regions of Q1, Q4, Q6, and Q7 were less than 6 Mb in size, while those of Q2, Q3, and Q5 

were more than 20 Mb (Table C3). Among all the QTL, Q6 and Q2 had the smallest (1.5 Mb) and 

the largest (36.5 Mb) intervals, containing 226 and 3242 genes, respectively (Table C3). We narrowed 

down the list of candidate genes by using a previously published RNA-sequencing (RNAseq) data 

for early FMs of A. coerulea, which sampled developmental stages covering the FMT window (Min & 

Kramer, 2020). We found that all of the QTL intervals, with the exception of Q4, had approx. 70% 
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of their total genes expressed in at least one of the RNAseq developmental stages; only 46.21% of 

the total Q4 genes were expressed in early developmental stages (Table C3).  

Subsequently, we sought to identify candidate genes under each QTL based on 1) the 

locations of the candidate genes relative to the location of the markers with the highest LOD scores, 

2) gene expression levels during early FM developmental stages, and 3) homology to previously

studied loci related to meristem function (i.e., not just restricted to FM). Because our genotyping 

method used 0.5 Mb or 1Mb binned genomic regions as the genetic markers rather than single 

nucleotide markers (see details in Materials and Methods), we gave the highest priority to genes 

located in the region of the marker with the highest LOD scores. 

Within the highest LOD bin of Q1, we identified a homolog of LATERAL SUPPRESSOR 

(LAS), AqLAS. LAS encodes a member of the GRAS family of putative transcriptional regulators, 

and mutations in the LAS orthologs in A. thaliana and tomato lead to a loss of axillary meristems 

(Schumacher et al., 1999; Greb, 2003; Wang et al., 2014). Moreover, one additional gene within the 

interval that was located 3 Mb away from AqLAS also caught our attention: AqPETAL LOSS 

(AqPTL). PTL is a floral organ boundary gene in A. thaliana that controls cell proliferation in a non-

cell autonomous fashion (Griffith et al., 1999; Brewer et al., 2004; Lampugnani et al., 2012). We 

considered AqPTL interesting for two reasons. First, PTL has been shown to physically interact 

with and be transcriptionally regulated by C2H2 transcription factor JAGGED (JAG) (Sauret-Güeto 

et al., 2013). In addition, silencing of AqJAG led to early FM arrest in A. coerulea, indicating that it is 

an important gene in maintaining the Aquilegia FM (Min & Kramer, 2017). Second, PTL and the 

gene product of HANABA TANARU (HAN) interact by sharing JAG as direct protein partners to 

regulate floral morphogenesis in A. thaliana (Ding et al., 2015), and the homolog of HAN is a 

candidate gene under our Q6 (Fig. 4.4b).  
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Figure 4.5. In situ hybridization of AqWUS and candidate genes. (a-e) Expression patterns of AqWUS (a-c) and its 
negative control (e). (a) A young FM that has not produced any floral organs. (b) A young FM that is in the process 
of initiating either a petal primordium or the outer most stamen primordia (and thus indicated by an arrow with a 
question mark). (c) A FM that has at least eight whorls of stamens initiated; AqWUS expression can also be seen 
at the axillary meristem below this FM (arrowhead). (d) A FM that has at least 11 whorls of stamens produced. (e) 
Sense probe on a FM with 3-4 whorls of stamens. (f-l) Expression patterns of AqZPR3a (f-k) and its negative 
control probe (l). (f) A young FM that has not produced any floral organs. (g) A young FM that has just started to 
produce sepal primordia (asterisk). (h, h') Serial sections through the same young FM that has only produced 
sepal primordia (asterisks). (i) A slightly tangential section through a FM that has produced 1-2 whorls of stamens. 
(j, j', j'') Serial sections through the same young floral bud that has initiated all floral organs. Expression of 
AqZPR3a is also e seen in the central zone of the axillary meristem in (j'') (arrowhead). (k) A young floral bud in 
which all floral organs are differentiating. (l) Meristem at same stage as (f) hybridized with sense probe. (m-p) 
Expression of AqROXYa (m-o') and its negative control (p). (m) A young FM that has not produced any floral 
organs. (n) A young FM that is in the process of initiating petal or the outer-most stamen primordia. (o, o') Serial 
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(Continued) sections through the same FM showing AqROXYa is only expressed on the abaxial side of the newly 
emerging primordia (brackets). (p) Meristem at the same stage as (p) hybridized with sense probe.  (q-u) 
Expression of AqATH1 (q-t) and its negative control (u). (q) A young FM that has not produced any floral organs. 
(r) A young FM that is in the process of initiating petal and stamen primordia. (s) A FM initiating stamen primordia 
and an associated axillary meristem (arrowhead). (t) A floral bud with carpel primordia just initiated and an 
axillary meristem, which has just initiated the sepal primordia. (u) Meristem at the same stage as (t) hybridized 
with sense probe.  All scale bars = 100 µm.  

 

Interestingly, AqWUS is within the 95% Bayesian credible intervals of Q2, located at the 

edge of the interval (Fig. 4b). Since the expression of AqWUS has not been examined in situ, we 

analyzed its expression pattern during the early developmental stages of A. coerulea FM (Fig. 4.5a-e). 

AqWUS is expressed in a small population of cells in the center of the FM from the earliest stages 

(Fig. 4.5a-e). The expression in these central zone cells persists during the initiation of floral organs 

and disappears when carpel primordia start to initiate. These observations are consistent with the 

expression of WUS orthologs in all taxa examined to date (Nardmann & Werr, 2006; Galli & 

Gallavotti, 2016), suggesting functional conservation of AqWUS as well. However, the marginal 

position of AqWUS in Q2 makes it a less compelling candidate. 

Under Q2, 8.7 Mb away from AqWUS within the highest LOD interval, we identified 

another candidate, the gene AqLITTLE ZIPPER 3a (AqZPR3a) (Fig. 4.4). AqZPR3a encodes a 

small-leucine zipper-containing protein and is the homolog of the previously identified gene ZPR3 

in A. thaliana (Weits et al., 2019). Homologs of the ZPR genes have been shown to regulate leaf 

polarity and shoot apical meristem maintenance in A. thaliana and tomato (Wenkel et al., 2007; Kim 

et al., 2008; Weits et al., 2019; Xu et al., 2019), but little is known about whether they are involved in 

any FM-specific functions in these plant systems. In Aquilegia, AqZPR3a exhibits very intriguing and 

dynamic expression patterns during early FM development (Fig. 4.5f-l). At the earliest stages of the 

FM, before floral organ primordium is initiated, concentrated expression of AqZPR3a is detected 

across the central epidermal layer of the FM, and moderate expression is found in the central zone 

(Fig. 4.5f). This strong expression in the FM epidermal layer persists until the FM has initiated 
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several whorls of floral organs, but the width of the domain seems to contract as FM development 

proceeds (Fig. 4.5f-i). On the other hand, the expression in the central zone disappears rapidly after 

initiation of the sepal primordia (Fig. 4.5f, g, h’, j’’). Strong expression of AqZPR3a is also detected 

at the adaxial boundary of all initiating floral organ primordia (Fig. 4.5h-j’’). However, these adaxial 

expression domains are restricted to the median region of the primordia, rather than the entire 

abaxial surface, which can be seen in serial sections through the same FM in Fig. 4.5h, h’, as well as 

in Fig. 4.5j, j’, j’’. Moreover, strong but patchy expression of AqZPR3a is detected in the adaxial 

epidermal layer of slightly older lateral organs, such as the sepals (Fig. 4.5i, j, j’), petals (Fig. 4.5k), 

stamens (Fig. 4.5k) and carpels (Fig. 4.5k). Intriguingly, expression of the ZRP genes across the 

epidermal layer of the early meristems has never been observed in any other plant systems.  

Under Q3, we identified the candidate gene AqROXYa which codes for a thioredoxin 

superfamily protein and is a homolog of A. thaliana genes ROXY1 and ROXY2 (Fig. 4.4; Fig. C7). In 

A. thaliana, ROXY1 appears to be a negative regulator of AG and functions to regulate petal

initiation (Xing et al., 2005; Quon et al., 2017), and ROXY2 with other members of the thioredoxin 

family members have been shown to regulate both floral organ development and stress responses 

(Xing & Zachgo, 2008; Murmu et al., 2010; Li et al., 2019). However, the homolog of ROXY in 

maize has been shown to regulate shoot meristem size and phyllotaxy (Yang et al., 2015). In 

Aquilegia, expression of AqROXYa is detected across the FM at the earliest developmental stages 

(Fig. 4.5m), but this broad expression disappears once the primordia begin initiating. Likewise, 

AqROXYa is detected in a restricted abaxial region of emerging floral organ primordia but quickly 

declines once they are initiated (Fig. 4.5m-o’). For instance, in a FM with several whorls of initiated 

stamen primordia, the expression of AqROXYa is only detected in the abaxial side of the innermost 

two whorls of emerging organ primordia (Fig. 4.5o, o’).  
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The confidence interval of Q4 spanned 3.8 Mb but only contained 176 annotated genes that 

were expressed in the RNAseq dataset (Table C3, C4). The only loci with homologs that are likely to 

function in meristems are two closely related tandem duplicates of the AGAMOUS homolog 

AqAG1 (Fig. 4.4b). However, AqAG1 is located at the edge of the genomic interval, quite distant 

from the marker with the highest LOD score (Fig. 4.4b). Within the 1Mb region 

(4,800,000...5,800,000) that contained the marker with the highest LOD, there were only 40 

expressed genes, eight of which are Aquilegia-specific without any annotated A. thaliana homologs, 

with most of the remaining genes annotated to be involved in plant defense and basic metabolic 

functions (Table C4). We also searched for potential microRNA-encoding loci and found that within 

the region with the highest LOD, there are three of the 11 annotated clusters of microRNA2275 

(miR2275) precursors in the Aquilegia genome (Pokhrel et al., 2021). MiR2275 is the only known 

microRNA that triggers phased, secondary, small interfering RNAs (phasiRNAs) of 24 nucleotides 

in length, and the production of 24-nt phasiRNAs requires both miR2275 copies and 24-PHAS loci 

as their targets (Liu et al., 2020). We also found that the 3.8 Mb region of Q4 is enriched in 24-

PHAS loci, containing 91 24-PHAS loci in total, comprising 31.7% of all 24-PHAS loci on 

chromosome 4 (~45.8 Mb) and 14.1% of such loci in entire genome (~300 Mb) (Pokhrel et al., 

2021). Almost half of the 24-PHAS loci in Q4 are targeted by miR2275 copies in the same interval.  

For Q5, there are two genes located within the highest LOD interval that have homologs 

that are known to function as FM regulators: AqSEUSS (AqSEU) and AqARGONAUTE 5a 

(AqAGO5a). In A. thaliana, SEU is known to repress AG to regulate FM and organ patterning 

(Pfluger & Zambryski, 2004; Grigorova et al., 2011; Wynn et al., 2014), while in Aquilegia, AqAGO5a 

has been identified as a core hub gene associated with early FM development (Min & Kramer, 2020). 

Q6 spans 1.5 Mb with only 226 genes in total, 170 of which are expressed in the RNAseq 

dateset (Fig. 4.4; Table C4). Within the bin of the highest LOD score, there is one gene for which a 
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homolog has been functionally studied: HANABA TANARU (AqHAN). HAN codes for a GATA 

type zinc finger transcription factor, and in A. thaliana, HAN is expressed at the organ boundaries, is 

known to regulate WUS expression, and directly interacts with a number of key genes in FM 

regulation and primordia initiation (Zhao et al., 2004; Ding et al., 2015). As mentioned above, we 

have detected significant interaction between Q1 and Q6 (Fig. C5). We found it intriguing that HAN 

and PTL interact through JAG to control FM morphogenesis in A. thaliana (Ding et al., 2015), since 

their Aquilegia homologs are located within the confidence interval of Q1 and Q6, respectively.  

Lastly, Q7 also has a very narrow interval of only 2.5 Mb in the genome with 242 expressed 

genes in the RNAseq dataset. AqHOMEOBOX GENE 1 (AqATH1) is the only gene with a 

homolog that has been functionally studied that is also located within the highest LOD interval. 

AqATH1 is the ortholog of gene ATH1 in A. thaliana (Fig. C8) and belongs to the BELL1-like 

homeodomain gene family. ATH1 regulates the boundary between the stem and the lateral organs, 

but is also involved in stem cell regulation in meristems by maintaining the expression of the 

meristem marker gene SHOOT MERISTEMLESS via a self-activation loop (Gómez-Mena & 

Sablowski, 2008; Li et al., 2012; Cao et al., 2020). AqATH1 is broadly expressed across the Aquilegia 

FM throughout the early developmental stages (Fig. 4.5q-t), in all early floral organ primordia (Fig. 

4.5r-t), and at the distal tip of the young lateral organs such as the bracts (Fig. 4.5q), sepals (Fig. 4.5r, 

s), and petals (Fig. 4.5t).  

DISCUSSION 

Aquilegia is an ideal system for studying FM regulation and termination 

Over recent decades, we have gained significant insight into various aspects of plant 

meristem development and function, but the regulation of FMT remains a poorly studied subject. 
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This is despite the fact that FMT is an indispensable process in floral development and variation in 

FMT timing is a key component of the generation of floral morphological diversity. Progress in 

understanding the regulation and evolution of FMT is hampered due to the lack of natural variation 

in floral organ whorl numbers in all of our currently established model systems (and their close 

relatives), while taxa with such a variation generally lack the genomic and molecular resources to 

investigate this question further. To this end, Aquilegia can be an ideal system for studying FMT 

thanks to its recent adaptive radiation, which means that Aquilegia species share relatively low 

interspecific sequence variation combined with a high degree of inter-fertility (Hodges & Arnold, 

1994; Filiault et al., 2018). At the same time, they all share a consistent floral bauplan that only varies 

in SWN (Munz, 1946), and possess a fully sequenced and well-annotated genome along with RNAi-

based methods for functional studies (Kramer, 2009; Filiault et al., 2018). Recognizing that floral 

SWN is the best available quantitative trait to represent the timing of FMT, we utilized a genetic 

cross between two sister species differing in SWN and sought to take the first step to explore the 

molecular basis of naturally occurring variation in the FMT timing. The interfertile A. brevistyla and 

A. canadensis species pair are highly suited to this study since their respective mean SWN of 7.16 and

9.16 do not overlap. Further, the mean SWN of their F2 progeny was found to encompass the entire 

range of the parental species (Fig. 4.2e). 

One question we sought to explore was whether the differences in ultimate floral size 

between the two sister species is reflected by differences in early FM growth dynamics. By analyzing 

developmental histological series of FMs in the parental species, we detected a subtle yet significant 

difference. Although the FMs of both species exhibit similar growth dynamics - increasing in size 

during their earliest developmental stages and then staying relatively constant during the later stage - 

the FMs of A. canadensis tend to be larger at inception and grow to a larger size, even before 

differences in SWN are evident (Fig. 4.3; Table C1). Overall, we observe that 1) the A. canadensis 
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FMs are larger in general, 2) have a longer developmental window to increase FM size, and yet, 3) 

still make five stamens per whorl. There are numerous previous studies showing that an increase in 

FM size is often associated with an increase in floral organ number per whorl, rather than an increase 

in the number of whorls (e.g., Carles et al., 2004; Fan et al., 2014; Chu et al., 2019). Of course, these 

studies typically rely on mutagenesis or gene over-expression rather than natural variation. This 

suggests that natural variation in meristem size relies on a greater degree of coordination such that 

meristem size changes in conjunction with the size of primordia inhibitions fields, allowing merosity 

to stay constant. The current data does not allow us to distinguish between whether the A. canadensis 

FM is growing for a longer period (e.g., perhaps plastochrons are slower, allowing more mass to be 

accumulated between subsequent whorls) or proliferating at a faster rate. Given what we know 

about the role of cell division timing in influencing FMT, answering this question is important to 

understanding the FMT mechanism in Aquilegia. Future studies using a recently developed live 

imaging technique in Aquilegia (Chapter 2), may allow us to compare growth rates between the 

initiation of successive whorls in these two species and better characterize this phenomenon.  

Another curious observation regarding SWN is that we observed a small portion of 

individuals in both parental species as well as the F2s that exhibited no variation in SWN, regardless 

of how many flowers were counted on the plants. In contrast, most other individuals exhibited 

variation in SWN within an individual plant (Fig. C3). This seems to suggest that there is variation in 

the robustness of this trait between different individuals. Unfortunately, the fact that there was no 

significant divergence in this pattern between the parent species meant that we could not map it in 

the current study, but we hope that examination of within-inflorescence SWN canalization in other 

Aquilegia species will allow the identification of suitable models and the dissection of its genetic 

basis.  
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Variation in the timing of Aquilegia FMT is controlled by multiple loci of small effects 

 We recovered seven major QTL that are responsible for variation in SWN, with one QTL 

located on each chromosome and the percent of phenotypic variance explained by each QTL 

ranging from 3.7% to 8.8% (Fig. 4.4; Table 3.1). These results are comparable to previous studies in 

meristem-related traits of domesticated crops, particularly maize, which also revealed multiple QTL 

of small effects (Vlăduţu et al., 1999; Upadyayula et al., 2006; Bommert et al., 2013; Thompson et al., 

2014, 2015). Interestingly, although all the meristem-related traits measured in maize were highly 

heritable, the total percentage of variance explained by all the QTL was never higher than 50% (e.g., 

Bommert et al., 2013; Thompson et al., 2014, 2015), suggesting there are other loci with even smaller 

effects that were not picked up by the QTL mapping, which is a likely scenario for our current study 

as well. 

 We have identified a number of candidate genes under the QTL (Fig. 4.4; Table C5) and, 

further, uncovered novel FM expression patterns of AqZPR3a and AqROXYa, which were the 

candidate genes under Q2 and Q3, respectively (Fig. 4.4, 4.5). In A. thaliana and tomato, expression 

of the ZPR genes is restricted to the adaxial region of lateral organs and the central zone of the 

shoot meristem, and the ZPR genes function in both establishing organ polarity and restricting the 

stem cell domain in the meristems by acting as post-translational suppressors of the class III HD-

ZIP abaxial identity genes by inhibiting their homodimerization (Wenkel et al., 2007; Kim et al., 2008; 

Weits et al., 2019; Xu et al., 2019). However, we have also observed strong expression of AqZPR3a in 

the central epidermal layer of FMs throughout their early developmental stages (Fig. 4.5f-i), which 

has not been observed in any previous studies. It will be very interesting to determine whether this 

novel expression pattern indicates a novel function or related to known ZPR functions in 

modulating meristem regulation. In the case of ROXY homologs in other models, expression has 

been found to be restricted to incipient and newly emerged organ primordia (Xing et al., 2005; Li et 
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al., 2009b; Yang et al., 2015), but abaxialized expression such as what was found for AqROXYa has 

not been observed before. In A. thaliana, ROXY1 is known to interact with PTL to regulate floral 

primordium initiation, while in maize, a ROXY homolog controls meristem size primordia (Xing et 

al., 2005; Li et al., 2009b; Yang et al., 2015); either of these functions could be important for 

controlling FMT in Aquilegia. 

The Q4 locus is of particular interest because it explains the highest relative percentage of 

phenotypic variation, but it is also the QTL with the fewest obvious candidate genes to investigate 

(Table C3, C4). Chromosome 4 of Aquilegia appears to have followed a distinct evolutionary path 

from the rest of the genome and displays many unique features compared to the remaining six 

chromosomes, including having a higher proportion of genes arrayed in tandem and segmental 

duplicates, more genetic polymorphism and transposable elements, lower gene density, and reduced 

gene expression (Filiault et al., 2018; Aköz & Nordborg, 2019). Although the AqAG1 tandem 

duplication is included in the 95% Bayesian credible interval, it may be less likely to be the causative 

gene compared to other genes that were located closer to the highest LOD score marker. The lack 

of potential candidate genes under Q4 led us to consider other factors besides protein coding genes, 

yielding the finding that the highest Q4 LOD interval harbors a large number of miR2275 

precursors and 24-PHAS loci. As the only microRNA that triggers 24-nt phasiRNA, a pathway that 

is conserved across the angiosperms, miR2275 has been shown to be expressed in the reproductive 

tissues of various monocot and dicot lineages, particularly in developing anthers (Zhai et al., 2015; 

Fei et al., 2016; Kakrana et al., 2018; Pokhrel et al., 2020, 2021). However, besides their functions in 

anthers, relatively little is known about 24-nt phasiRNAs in general. 

Certainly, it is also possible that the causal gene underlying Q4 is one of the Aquilegia-specific 

loci that did not have a direct A. thaliana homolog, which equally applies to the other QTL as well. 

Next steps in evaluating these candidate genes will include comparative expression between A. 
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canadensis and brevistyla, functional studies, and population-based allelic analyses to identify fixed 

differences. The current study is a key first step in identifying a promising list of candidate genes for 

regulating natural variation in FMT, which will provide insight into both the developmental and 

evolutionary mechanisms underlying FMT.  
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In this dissertation, I sought to promote Aquilegia as a model system for studying FM 

development and lay the groundwork for understanding how FMT is regulated in Aquilegia from 

three different perspectives: Chapter 1 provided us with broad transcriptomic data covering the 

period before, during and after FMT; Chapter 2 generated a cellular description of the FMT process 

at unprecedented resolution; and Chapter 3 revealed the complex nature of the genetic architecture 

underlying variation in the timing of FMT by utilizing the natural variation in the floral structures of 

different Aquilegia species, yielding a promising list of candidate genes that potentially contribute to 

the regulation of FMT variation. In addition to this wealth of novel information regarding FMT in 

Aquilegia, my dissertation also revealed that several key aspects of FMT appear to be different in 

Aquilegia relative to what has previously been shown in A. thaliana, which also emphasizes the 

necessity of pursuing a diverse set of model systems for studying FMT.  

 First, based on the transcriptomic profiling in Chapter 1, we found that several key genes 

that are involved in the regulation of the AG-KNU-WUS pathway in A. thaliana either do not have 

orthologs in the Aquilegia genome, or have expression profiles during early FM developmental stages 

that are inconsistent with their functions in A. thaliana, suggesting that the pathway is not conserved 

in Aquilegia. We have also observed a much longer expression window of AqWUS relative to WUS 

in A. thaliana at the comparable developmental stages, which may be related to Aquilegia’s 

apocarpous gynoecium.  

 Second, detailed observation of cell proliferation and expansion dynamics in Chapter 2 

revealed that there is an increase in cell division in the center of the floral apex after the physical 

initiation of the carpel primordia. This is inconsistent with what has been observed in A. thaliana - 

that cell divisions cease in the center of the floral apex before the initiation of carpels (Sun & Ito, 

2015). Such a difference could again be due to the difference in gynoecial structures, that carpels 

form a syncarpous gynoecium in A. thaliana but an apocarpous gynoecium in Aquilegia. Further 



120 

investigations in more taxa with apocarpous gynoecia are necessary to examine the connection 

between gynoecia structures and the regulation of FMT.   

Furthermore, in A. thaliana, it has been shown that the size of the FM will enlarge when the 

vegetative meristem transitions to FM identity, but that then the size of the FM will rapidly decrease 

over the course of organ initiation and eventually be consumed by the initiation of carpel primordia 

(Kwiatkowska, 2004, 2008). This notion that the FM will only enlarge upon identity transition and 

then be consumed has sometimes been assumed to be a general phenomenon (e.g., Remizowa, 

2019). A previous study has shown that meristem size also increases in Aquilegia upon the transition 

from being vegetative to reproductive identity (Ballerini & Kramer, 2011), but careful measurements 

of FM sizes in A. brevistyla and A. canadensis in Chapter 3 showed that these FMs continue to enlarge 

rapidly during the early FM developmental stages, and then stay at a relatively constant size until the 

production of carpels. Although the A. canadensis FMs were significantly larger, they also appeared to 

need a longer developmental window (as measured in plastochron, time interval between two 

successive whorls) to increase in size. In fact, ontogenetic studies of taxa that produce numerous 

floral organs have also documented significant increases in FM size during organ production. For 

instance, in Pulsatilla chinensis (Ranunculaceae), which produces more than 250 stamens and 250 

carpels in a flower, the FM enlarged to a degree that was described as “exceedingly convex and 

becomes almost spherical” during the initiation of stamens (Ren et al., 2010). All of these 

observations clearly suggest that FM behavior varies depending on the number of whorls in a flower 

and that likewise, regulation of FM proliferation and the eventual termination could also vary widely. 

Last but not least, different degrees of variation in the timing of FMT in Aquilegia reveal 

both flexibility and complexity in the FMT program. QTL mapping in Chapter 3 demonstrated that 

stamen whorl number is a quantitative trait and a good representation of the timing of FMT. The 

mean stamen whorl number of both parental species and the F2 population showed a relatively 
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normal distribution, indicating variability in the timing of FMT, but also a tight crosstalk between 

the FMT program and other molecular programs controlling the floral morphogenesis, since organ 

identity was consistently coordinated across these flowers. Moreover, perhaps the most surprising 

was the observed patterns of variation within an individual. The systematic counting of stamen 

whorl numbers in A. brevistyla, A. canadensis, and their F2 progeny showed an intriguing phenomenon 

that has not been observed before: for each group, there was a small portion of individuals that 

showed no variation in stamen whorl numbers, regardless of how many flowers were counted in a 

plant, while the remaining members of the cohorts displayed a range in stamen whorl number 

variation among the flowers of the same individual. This intriguing observation suggests variation in 

the robustness of FMT timing between different individuals.  

The results from this dissertation offer us many exciting directions for future research. 

Together Chapters 1 and 3 have provided a list of candidate genes for FM and FMT regulation that 

are worthy of further functional studies. The quantitative live-imaging technique in Chapter 2 is 

likely applicable to other Aquilegia species or taxa from closely related genera, and comparative 

studies of FMs with different whorl numbers and different gynoecial structures will provide us with 

valuable information regarding cell behavior during FMT. In addition, detailed allelic analysis is 

necessary for the candidate genes from Chapter 3 to dissect the regulation of FMT. It will also be 

interesting to analyze the heritability of variation in stamen whorl number within an individual to 

determine the relative contribution from environmental vs. genetic factors to this phenotype. If it is 

a highly heritable trait, I will be particularly keen to perform a genetic cross between plants that 

show no individual variation in stamen whorl number and those that show large variation, which 

could uncover the mechanisms of canalization in FMT timing. Furthermore, the development of 

stable transgenic transformation methods will also help to greatly accelerate and expand the scope of 

future research. For instance, with the combination of live-imaging and stable transformation, we 
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will be able to observe the expression patterns of key genes and quantify their functions in cellular 

behavior in real-time, while chromatin immunoprecipitation sequencing will reveal the direct targets 

of key genes and help us to construct the regulatory network in FMT. 
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BACKGROUND 
 

Meristems are groups of pluripotent stem cells typically located at the tips of shoots. Many 

fundamental features of meristems are shared across all vascular plants, e.g. the maintenance of a 

pool of undifferentiated cells, regulated cell proliferation and expansion, and control of post-

embryonic organogenesis. However, there remains a great deal of unexplored variation in meristem 

structure and behavior across land plants. Exploring this diversity is hampered by the reliance on 

common developmental techniques, such a fixed tissue sectioning and imaging that do not allow 

processes such as spatial and temporal patterns of cell division and expansion to be directly 

observed. In model systems such as Arabidopsis thaliana, genetic and molecular tools have been 

coupled with advancements in live imaging techniques that allow analyses of both cell behaviors and 

gene expression in real time, and these tools have provided considerable progress in our 

understanding of meristem development.  However, these advancements are currently limited to a 

small number of model species and there is a pressing need to develop quantitative live imaging 

techniques in non-model systems, and specifically, approaches that may be broadly practical across a 

range of plant taxa. Here we present a detailed protocol for live imaging and analysis of floral 

meristems in Aquilegia coerulea, a member of the buttercup family (Ranunculaceae). This protocol 

provides a powerful tool to study the development of the meristem and initiation of floral organs 

and should be easily adaptable to many plant lineages, including other emerging model systems. This 

protocol will allow researchers to explore questions outside the scope of our common model 

systems.  

 

MATERIALS AND REAGENTS 
 

1. Petri dishes (35 x 10 mm; Corning, NY, USA) 
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2. Agar (Invitrogen, catalog number: 16500-100) 

3. Linsmaier & Skoog medium (Caisson Labs, catalog number: L2P03) 

4. Sucrose (Macron Fine Chemicals, catalog number: 57-50-1) 

5. NaOH (Sigma-Aldrich, catalog number: 221465) 

6. Kinetin (Sigma, catalog number: K0753-1G) 

7. Gibberillic Acid (Sigma, catalog number: G7645-1G) 

8. Eppendorf tubes 

9. Parafilm 

10. 100% EtOH 

11. Aluminum foil 

12. Microscope slides 

13. Razor blades 

14. Propidium Iodide (Sigma-Aldrich, catalog number: P4864) 

 
EQUIPMENT 
 

1. Scalpel with No. 10 blade (BioQuip Products, #2723A) 

2. Straight dissecting needle (Carolina, #627201) 

3. Precision Watchmaker's Forceps, Extra-Fine Point (Carolina, #624791) 

4. Glass beads (Sigma-Aldrich, # 18406) 

5. Microscope (Zeiss Stemi DV4 Stereo) 

6. Microscope (LSM 980 NLO Multi-photon with a water immersion lens W Plan-Apochromat 

20x/1.0 DIC UV-IR M27 75mm) 

 

SOFTWARE 
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1. MorphographX (MGX) https://morphographx.org/software/.

RECIPES 

Culture medium 

1. To make up 1L of the culture medium, dissolve 2.375 g of Linsmaier & Skoog medium

(Fisher Scientific; final strength: 0.5X) and 30 g of sucrose (final concentration: 3%) in 1L of

ddH2O. The Linsmaier & Skoog medium should provide buffering capacity such that the pH

of the solution should be about 5.8. If the pH is too high, adjust it with 1N NaOH solution.

Then add 8 g of agar (final concentration: 0.8%) and autoclave.

2. Once the autoclaved medium has cooled to a degree that is not too hot to be touched by a

bare hand, add in 10-6 M kinetin (Sigma) and 10-7 M gibberellic acid (GA3, Sigma). Mix well

and pour the plates in a fume hood to avoid contamination. 10-6 M kinetin and 10-7 M GA3

can be diluted as follows:

a. 10-6 M kinetin

o Make 10-1 M stock solution: dissolve 21.52 mg kinetin in 1ml of 1N NaOH in an

Eppendorf tube. Seal the tube tightly with parafilm. This stock solution can be

stored at 4°C for a few months.

o Add 1 µl of the stock solution in 100 µl ddH2O to reach the concentration of 10-3 M

o Add 1 µl of 10-3 M solution in every 1 ml of culture medium to reach the

concentration of 10-6 M

b. 10-7 M GA3:
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o Make 10-1 M stock solution: dissolve 34.64 mg GA3 in 1ml 100% EtOH in a 1.6 ml 

Eppendorf tube. Seal the tube tightly with parafilm. This stock solution can be 

stored at 4°C for a few months. 

o Add 1 µl of the stock solution in 1 ml ddH2O to reach the concentration of 10-4 M 

o Add 1 µl of 10-4 M solution in every 1 ml of culture medium to reach the 

concentration of 10-7 M 

 

PROCEDURE 

 

A. Plant materials and growth conditions 

 

1. Seeds of Aquilegia x coerulea ‘Kiragami’ can be purchased from Swallowtail Garden Seeds 

(Santa Rosa, CA, USA) and germinated in wet soil in plug trays, which generally takes two to 

three weeks.  

2. When the seedlings develop their first two true leaves, they are transplanted from plug trays 

to five-inch pots. Seedlings and young plants are grown in growth chambers with 16 h 

daylight at 18 °C, 8 h dark at 13 °C, and humidity under 40%. In these regular growth 

conditions, the plants are watered twice per week. 

3. Once the plants develop five to six true leaves, they are transferred into the vernalization 

chamber which is set at 16 h daylight at 6 °C and 8 h dark at 6 °C. They should be well 

watered (i.e., the soil is fully hydrated) before being moved into cold conditions and are 

generally not watered during the vernalization period.  

4. Plants stay in vernalization for three to four weeks and then are moved back into regular 

growth chambers for flowering. We usually put a small amount of controlled-release 
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fertilizer in each pot post vernalization. Inflorescences generally start to develop three weeks 

after vernalization.  

5. Dead leaves should be actively removed to pretend fungal or pest infections.

B. Preparation of culture/imaging plates

1. Take an empty 1000µL pipette rack and gently press each foil square into one of the holes to

create a round well (Fig. A1a-c). Cut small squares of aluminum foil (1x1cm). Carefully store

foil squares in an autoclavable container (such as a glass petri dish) and autoclave (Fig. A1c).

2. Autoclave glass beads and ddH2O.

3. Prepare the media according to Recipe 1.

4. While still molten, fill petri dishes half way with agar, quickly place one foil square in the

center of the petri dish, concave side up. With sterile tweezers place a glass bead into the

depression in the foil square (Fig. A1d). This is sufficient to ensure that the convex side of

the foil is pressing into the agar. Once the bead is put on the foil square, the foil will

automatically gravitate to the center of the plate. Let the plates cool and solidify inside of the

sterile hood. Once solid, using tweezers, remove the glass beads and carefully peel off the

foil square. This leaves a shallow well in the agar for mounting the meristems (Fig. A1e, 1f).

5. Solidified plates can be stored at 4°C for 2 months.
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Figure A1. Making plates for live-imaging. (a) Take an empty 1000µL pipette rack and gently press each foil square 
into one of the holes to create a round well. (b) A strip of wells. (c) Foil squares are autoclaved and stored in a 
glass petri dish. (d) Examples of plates solidifying in a sterile hood with foil squares and glass beads in place. (e) A 
plate with blue dye to show the well in the center, where the meristems will be positioned. (f) The plate then will 
be glued onto a microscope slide. The slide was labelled with dates, while A1-A4 were the meristem labels and 
their relative locations in the well. 

C. Tissue dissection and mounting

1. The forceps, surgical needles, and dissection blades are all sterilized in 10% bleach, washed

in ddH2O, and dried with Kimwipes before dissection.

2. Young axillary inflorescences or whole inflorescences are excised off the plant using forceps

or scissors for meristem dissections (Fig. A2).
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3. Inflorescences are washed in freshly prepared 10% bleach for 20 min. Any leaves and bracts 

on the stem should be removed using the forceps, but the attachment points of the petioles 

should be left on the stem (Fig. A2); if the petiole is completely removed from the stem, we 

found that the bleach solution will enter the wound and spread through the cells quickly, 

which kills the axillary meristems as well.  

4. The stems are then washed with double-distilled water (ddH2O) three times to completely 

remove the bleach residue, after which stems are kept immersed in ddH2O.  

5. When dissecting, put one stem under the microscope (the rest remaining in distilled water), 

and carefully remove the bracts and sepals of each floral meristem using the tip of a 

dissecting needle. Then excise the meristem off the branch with the scalpel and transfer it 

onto a 35 x 10 mm petri dish (Corning, NY, USA) with the culture medium. Make sure the 

base of the stem (usually there is about 1 mm of stem remaining) holding the meristem is 

pushed into the agar. We typically mount four floral meristems per dish. 

6. Glue the petri dish to a microscope slide and label the date and the meristems on the slide 

(Fig. A1c). 

 

Figure A2. Developmental stages for dissecting FMs for imaging. Axillary meristems can be obtained from either a 
lateral inflorescence branch (a, b) or a young inflorescence (c, d). Scale bars = 1 cm. Leaves that should be remove 
before or after the 10% bleach wash are indicated. Red dash lines indicate the locations where the floral axis will 
be excised for the bleach wash. 
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D. Staining 

 

1. Meristems should be stained for 1-3 minutes in the petri dish by applying 50 μL propidium 

iodide (0.5mg/mL) directly to the meristems. The mounting well should sufficiently contain 

the stain so that it creates a dome over the meristems. Take care that there is sufficient stain 

so that the meristems are fully immersed in stain throughout the whole staining period. It is 

important to note that the staining time will likely be specific to the plant and tissue being 

imaged, so here we just give a general time range and it is recommended that the staining 

time be optimized for each experiment. We would recommend starting with a low 

concentration for 1 minute and add time only if the tissue seems under-stained. Another 

important optimization is the staining for subsequent imaging time points. Aquilegia 

meristems were stained for 2.5 minutes for time point 1, then 2 minutes for time point 2 and 

3, and 2-3 minutes for timepoint 4.  

2. Carefully remove the stain and wash the meristems with ddH20 three times by pipetting. 

 

E. Imaging 

 

Notes: Imaging will differ depending on the type of confocal and objective lenses available, as well as the type of tissue 

or stain used. 

 

1. Meristems were imaged immediately after staining using a LSM 980 NLO Multi-photon 

confocal laser scanning microscope (Ziess, Germany) equipped with a water immersion 

objective (W Plan-Apochromat 20x/1.0 DIC UV-IR M27 75mm, Ziess).  
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2. The petri dishes were filled with ddH2O while imaging and the water was immediately

removed after imaging.

3. A DPSS 514nm laser was used for excitation and emission was collected between 580-

670nm.

4. Scans were frame averaged 2x and z-sections taken at 2 µm intervals. This interval will vary

depending on the size of the tissue We found that 2 µm was sufficient for downstream

analysis while also minimizing the time the tissue was subjected to the laser.

5. After imaging, the remaining water in the petri dishes was carefully removed by pipetting

using a P20 pipette and the petri dishes were returned to the tissue culture growth chamber.

6. Samples were imaged every 48 hours, typically 3-5 timepoints.

IMAGE PROCESSING 

Note: The following protocol for conducting segmentation and lineage tracing of the confocal images are adapted from 

(de Reuille et al., 2014; Strauss et al., 2019) and the user manual at 

https://www.mpipz.mpg.de/MorphoGraphX/help, all of which detailed the structure of MorphoGraphX (MGX), 

including how the image data are stored, extracted, and processed. Here, we focus on the steps and parameters that are 

specific to processing confocal images of Aquilegia floral meristems and steps to reproduce figures in Chapter 2. We 

will use two original .czi files from our study as an example, which can be downloaded from this google drive link: 

https://drive.google.com/drive/folders/1WjaCieLGrnTW7d51143b8HOn-dYmsMU-?usp=sharing  

A. Software installation and equipment setup

Download the newest version of MGX from https://morphographx.org/software/. Since 

the software improvements have mostly been implemented in the Linux versions, installation of the 

Linux operation system is preferred. To run MGX requires a computer nVIDIA graphics card that 
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supports CUDA, with at least 2 Gb of video memory and 8 Gb of the main memory of the 

computer itself. A larger video memory, a larger main computer memory, and/or a multi-core CPU 

can significantly shorten the processing time of some of the steps. 

Processing a large amount of imaging data with MGX can be time-consuming so we strongly 

recommend readers have a comfortable workstation with proper office ergonomics if possible. An 

ultrawide monitor, or a dual-monitor setup, can be extremely helpful especially during the parental 

lineage tracing error correction process.  

 

B. Load image into MorphoGraphX (MGX) 

1. Convert the format of the stack image: Open the stack image (e.g. the 20210207_r8_A1.czi 

files) with FIJI (https://imagej.net/Fiji) or ImageJ: (https://imagej.net/Welcome), adjust the 

brightness and contrast, and save the image as 20210207_r8_A1.tif format. 

Note: The images we acquired from the confocal microscope can be dim because we wanted to minimize tissue damage 

from both laser power and laser exposure time (which in turn slows down the growth), and thus the adjustment in 

brightness and contrast was almost always needed. Slightly over-saturated images usually look very good when loaded 

in MGX (Fig. A3). 

 

Figure A3. Comparison of how a confocal stack looks in ImageJ and MGX before and after adjusting the brightness 
and contrast. Images that appear to be slightly over-saturated in ImageJ generally look good in MGX. 
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2. Load the stack into MorphoGraphX: either drag the 20210207_r8_A1.tif file directly onto 

the MGX interface (Fig. A4), or Stack1 → open → choose the image. 

 

Figure A4. Overall layout of MorphgraphX interface. 

 

3. If the stack still appears to be dark, there are two ways to directly adjust the brightness in 

MGX instead of adjusting the brightness/contrast in Fiji and loading the stacks again: 1) 

under the Main tab, under Work, change Opacity; 2) go to the View tab, and change the 

brightness and contrast under View Quality. 

4. You can rotate the stack by using the left click of your mouse, move the stack to different 

parts of the screen with the right-click, and zoom in and out with the scroll wheel. By 

default, Stack 1 will appear green (and Stack 2 will be red), the setting of the colors can be 

changed using the Main Stack Colormap  under the Main tab.  
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C. Extract the surface

1. Go to tab, Process → Stack → Filters → Gaussian Blur Stack; change all the X/Y/Z Sigma

parameters (appears at the right bottom corner; double click the cell to change) to 1; run the

process twice (either by double-clicking the processor or hitting the “Run” arrow  on the

upper right corner).

Note: It is important to blur each stack the same number of times, especially when dealing with images for lineage 

tracing.  

2. Run Process → Morphology → Edge Detect, which creates a solid global shape of the

object.

3. Optional: remove unwanted parts. For example, if we only want the top part of the meristem,

we could remove the extra stamen/staminode primordia by clicking on “Voxel Edit ”

on the top bar; Press Alt-key and left click of the mouse to erase parts that you don’t want.

Note: 1) If the Alt-key is not working, it is likely due to a conflict in the hotkey setting in your operating system, 

which already assigned a function to the Alt-key and thus prevents it from being used for selection in MorphoGraphX. 

You can change this setting in your operating system by assigning other keys to avoid the conflict. 2) Removing 

unwanted parts using the voxel edit can increase the speed of downstream processes, but the removal of parts is not 

reversible, so this step is generally not recommended unless there is a significant constraint on the computer capacity. 

4. Optional: If there are holes on the shape, run Stack → Morphology → Fill Holes. Skip if no

hole is observed.

Note: The adjustable parameters in this step are the X/Y-Radius. The bigger they are, the better they can fill the 

holes. However, the bigger they are, the more possible it is going to change your surface shape. 

5. Go to Mesh → Creation → Marching Cubes Surface, change the threshold parameter to

20000, run the process.
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6. Trim off the bottom. In the Main tab, ensure that the Mesh checkbox and “View” option 

are set to “All”. This will enable the visualization of the mesh. Click the “Select points in 

mesh (Alt+V) ”  tool on the left toolbar and hold the Alt-key to select the bottom 

vertices of the apex. The selected vertices should turn red. Hit the delete key on the 

keyboard to remove them. To make this easier, it is nice to have the apex in a horizontal 

position. You can do this by left-double clicking on it. Try to delete the bottom cleanly. Save 

the mesh as “20210207_r8_A1_s.c6.mgxm” 

7. Run Mesh → Structure → Subdivide. Then go to Mesh → Structure → Smooth Mesh, 

change the Passes number to 10 (the default is 1), and run the process. Repeat this subdivide 

step and then smooth the process two more times (i.e. three times in total). By now the total 

vertical number (shown in the bottom left window) in the mesh for an early stage FM should 

be above 500,000, while for an older stage FM should be about 1,000,000.  

Note: Each subdivision increases the total vertical numbers by roughly four times. The last round of subdividing and 

smoothing can be demanding on computational power.  

8. Save the mesh as “20210207_r8_A1_s.c8.mgxm” 

9. Go to the Main tab, Unselect “Mesh”. Make sure “Main” and “Surf” are selected, but 

“Work” is not. Then run Process → Mesh → Signal → Project Signal to project the signals 

to the surface. 

Note: The default Max Dist (µm): 6.0 is good for Aquilegia floral meristems since they have relatively large cells 

especially compared to Arabidopsis meristem cells. If visualizing a tissue with smaller cells, the Max Dist can be 

decreased accordingly. 

10. Save the mesh as “20210207_r8_A1_s.c10.mgxm” 
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D. Cell segmentation. 

1. Go to Process → Mesh → Segmentation → Auto-segmentation and change the following 

parameters from default: normalize to “No”, auto-seeding to 3.0, blur cell radius to 3.0, 

combine to 1.1. Run the process.  

Note: The auto-segmentation process can be demanding to the computational power. For Aquilegia floral meristems, 

depending on the developmental stages, we got good results by changing the auto-seeding and blur cell radius to 2.0, 

2.5, or 3.0. The radius for auto-seeding and blur cells should be the same.  

2. Save the mesh as “20210207_r8_A1_s.d2.mgxm” 

 

E. Correct segmentation errors 

No matter how good the image stack is, there are likely to be segmentation errors, especially 

with samples such as Aquilegia floral meristems that contain hundreds to thousands of cells in a 

stack. It is very important to correct as many errors as possible at this step since it will greatly reduce 

the time that will likely be needed in future processes to correct parental labeling errors (which is 

relatively more time-consuming compared to correcting segmentation errors). It is also important to 

constantly save the newer version of the mesh (e.g. 20210207_r8_A1_s.e0.mgxm). The two processes with 

opposite functions, “Watershed Segmentation” and “Segmentation Clear”, are located right next to 

each other on the list, and it is not impossible to click the wrong button during processing. If the 

“Segmentation Clear” is run by accident on the whole mesh while the newest version of the 

corrected mesh has not been saved, it means starting over again.  

Checking segmentation errors can be done by zooming in on one part of the mesh and 

selecting “Vtx” under the Surface panel of the Main tab and then accessing the Mesh panel under 

the “Cells” option. By toggling back and forth between the checked and unchecked options in the 

Mesh checkbox, you can compare the cell wall positions and segment boundaries. Correct all the 
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possible errors in that region, then move to another part of the mesh and repeat the process. There 

are a few types of common segmentation errors (Figs. A5-A7): 

1. If a cell is over-segmented: If cell A is over-segmented into A1 and A2, select “Add label to

selection ” on the left toolbar, press Alt-key and click on A1 (or A2). Then select “Fill

label (Alt+M) ” on the left toolbar, press Alt-key and click on A2 (or A1) (Fig. A5).

Figure A5. Examples of over-segmented cells. (a) How over-segmented cells (outlined in red) look under the 
Surface/Cells view. (b) How over-segmented cells (outlined in red) look under the Surface/Vtx view. (c) How the 
mesh looks. Over-segmented cells can be easily spotted by comparing between (c) and (b). (d) How cells look 
after over-segmentation has been corrected. 

2. If a cell is under-segmented: This is a relatively common situation for cells at the boundary

of the stack (due to faint signals) and at the organ boundaries (because the cells at the

boundary are much smaller than the auto-segmentation radius). Click “Select points in mesh

(Alt+V) ” on the left toolbar, press Alt-Key and select parts of the cell that needs to be
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corrected (as long as some vertices in that cell were selected it is fine), then under the 

Process tab, run Mesh → Selection → Extend to Whole Cells, which selects all the vertices 

in that target cell (Fig. A6). On the left toolbar, click on “Erase selected ” to remove the 

labels from the cell. Labels can also be removed by running Mesh → Segmentation → 

Segmentation Clear under the same Process tab (Fig. A6). Then choose “Add new seed 

(Alt+B) ” from the left toolbar, press the Alt-key, and the left click of the mouse to draw 

the outlines of the cells (Fig. A6). Theoretically, the cells can be segmented as long as there is 

at least one seed inside, but drawing out the rough outlines of the cells can help with correct 

segmentation because sometimes the cell boundaries are faint. Lastly, under the Process tab, 

run Mesh → Segmentation → Watershed Segmentation (Fig. A6). 

 

Figure A6. Examples of under-segmented cells. (a) A under-segmented cell outlined in red. (b) Under-segmented 
cells can be easily spotted by comparing the segmented outlines to the original mesh. (c) The label of the under-
segmented cell being cleared. (d) The two cells being re-seeded. (e) How the labels look after the under-
segmentation is corrected. 

 

3. If the boundary of a cell is incorrect: This is most likely due to a faint signal in the cell wall 

staining (Fig. A7). On the left toolbar, click “Add label to selection ”, then press the Alt-

key and click the cell that needs to be corrected. Then choose “Add current seed (Alt+N) 

” from the left toolbar, use the left click of the mouse to fill in the gaps, and draw the 

correct boundary (Fig. A7). Then under the Process tab, run Mesh → Segmentation → 

Watershed Segmentation (Fig. A7). 
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Figure A7. Example of a cell with incorrect boundary. (a) Red arrow pointing to the incorrect boundary of a cell. 
(b) How the original segmentation looked. (c) How the corrected segmentation looked.

4. Remove the cells on the boundary of the mesh: After all visible errors are corrected on the

mesh, run Mesh → Cell Mesh → Fix Corners Classic under the Process tab. Then click

“Select points in mesh (Alt+V) ” on the left toolbar, press Alt-key and select cells on the 

boundary of the mesh, then under the Process tab, run Mesh →selection → Extend to 

whole cells. After the cells are selected, click “Delete selected” on the left toolbar, then save 

the mesh as “20210207_r8_A1_s.e4.mgxm”.  

This last step is important because the sizes of the cells on the boundary are likely to be 

inaccurate due to several reasons: 1) the confocal Z-stack may have stopped scanning at this point 

without including the entire cell on the boundary; and 2) we arbitrarily trimmed off the bottom of 

the stack in step C6, which may have trimmed off parts of cells located on the boundary (Fig. A8). 

After the first layer of cells on the boundary is removed, run Mesh → Cell Mesh → Fix 

Corners Classic under the Process tab again, and save the mesh again. This will be the mesh (i.e. 

20210207_r8_A1_s.e4.mgxm) that is used to conduct lineage tracing.  



142 
 

 

Figure A8. Removing cells on the boundary of the mesh.  (a, b) How the labels look before removing the cells on 
the boundary, which had unnatural shapes. (c) How the labels looked after removing the cells on the boundary. 

 

PARENT LABELING & LINEAGE TRACING 

After processing the stacks and meshes from both time-point 1 

(20210207_r8_A1_s.e4.mgxm) and time-point 2 (20210209_r8_A1_s.e4.mgxm), they are ready to 

conduct parental labeling and lineage tracing. 

A. Parental labeling 

1. Go to the Main toolbar, load the segmented mesh for time point 1 on Mesh 1, and the 

segmented mesh for time point 2 on Mesh 2. Both meshes are now loaded as meshes of 

Stack 1 and 2 under the Main tab respectively. The main stacks (i.e., the original .tif files) can 

also be loaded using the Main toolbar for Stack 1 and 2. It is a personal preference whether 

or not to load the main stacks because they are not required for the lineage tracing process, 

but it might look nicer to have the main stack shown when taking pictures.  

2. Go to the View tab, and check “Stack1” in the Control-Key-Interaction panel. This allows 

you to move the meshes separately. Using the right click of the mouse alone will move both 

meshes together, but using the right click of the mouse while pressing the Control-key on 

the keyboard will only move the Stack 1. Use the control key and the mouse to move Stack 

1 and 2 side by side on the screen.  



143 
 

3. Go to the Main tab Stack 1, next to the Mesh checkbox, click Colors Editor  to 

change the colors of Mesh 1 and/or Mesh 2 so that they are different from each other. 

4. Go to the Main tab Stack 1, make sure the checkboxes of Main, Work, and Surface panels 

are all unchecked, but the one for Mesh is checked. Make sure that “Cells” is selected as the 

view option for both the Mesh and the Surface panels, and the view option for Cells is 

selected as “Label”. 

5. Go to the Main tab Stack 2, uncheck Main and Work, but check Surface and Mesh. The view 

options for Surface and Mesh should be “Label” and “Cells” as well, respectively. Then 

check the checkbox of Parents to the right of the Surface checkbox. The colored segmented 

cells of Stack 2 should disappear after this.  

6. When the meshes of the meristems are first loaded, we see the front view of the meristems. 

Use the left click on the mouse and the Control key to adjust the orientations of both 

meshes so that the side views are shown. 

7. Use the left click of the mouse and the Control key to move the Mesh 1 above the Mesh 2. 

Then use the left click of the mouse alone to rotate both meshes so that the front views are 

shown again.  

8. Look for a few cells on Mesh 1 and 2 that appear to be the same. Usually, the large cells at 

the center of the meristems are the most easily recognizable. Transfer the Mesh 1 on top of 

Mesh 2 by pressing the Control-key and using the right click of the mouse to match those 

recognized cells on both meshes.  

9. Adjust the orientation and angles of Mesh 1 using the left click of the mouse and the 

Control-key to make more cells on both meshes overlap. If the growth between the two time 

points is rather large, adjust the size of the Mesh 1 by going to the Main tab Stack 1, check 
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the Scale checkbox, and increase the X values (adjusting Y or Z is also fine since all axes are 

linked). 

10. To transfer labels from Mesh 1 to Mesh 2, go to the Main tab Stack 2 so that Stack 2 is 

active. Select “Grab Label ” from the left toolbar, hold the Alt-key, and click on the cells 

that are aligned on both meshes. If a cell at time-point 1 appears to have divided at time-

point 2, click both cells and they will appear to be the same color.  

11. Transfer labels of all possible cells from Mesh 1 to Mesh 2. Because of the meristem’s 3D 

structure, it is impossible to grab labels of all matching cells without adjusting the angles and 

orientation of the meshes. We recommend that users deal with one subregion of the mesh at 

a time (just like when correcting the segmentation errors): start from the center of the 

meristem, move down from the center to one edge of the mesh, label all possible cells in that 

region, then move on to the adjacent region. It is also possible that different regions of the 

samples require independent adjustments to the mesh sizes, which will require the user to 

use the Scale function (Step A9) repeatedly. For example, when tracing cells on the newly 

initiated primordia, the size of Mesh 1 will likely need to be scaled up greatly to match the 

cells on the Mesh 2; but when tracing cells on the boundary regions, Mesh 1 will most likely 

not need to be scaled. A video demonstration of lineage tracing can be found on: 

https://www.youtube.com/watch?v=KDiCyGrALYk&t=26s 

12. Save the parents' labels by running Mesh → Lineage Tracking → Save Parents under the 

Process tab. Make sure Stack 2 is active when saving the parents (otherwise an empty file will 

be saved). Use caution when saving because the Save Parents option is listed adjacent to 

Reset Parents, and the consequences of accidentally running the wrong process can be 

detrimental. Make sure to label the lineage tracing file informatively and identify the version, 
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since multiple versions may need to be saved when correcting lineage tracing errors (because 

there is no undo button!). For instance: r8-A1-0207to0209-v1.csv. 

B. Correcting lineage tracing errors

Although it is not necessary to correct lineage tracing errors to generate a growth heat map, 

it is important to correct all errors before running any analysis to ensure the accuracy of the results. 

To check the correspondence of the traced cells, make sure Stack 1 is active, and under the Process 

tab, run Mesh → Cell Axis → PDG → Check Correspondence. The cells with errors will be 

highlighted in red on both meshes. To correct the errors, the original meshes of time-point 1 and 

time-point 2 need to be opened in two additional, separate MorphoGraphX windows, which is why 

we have recommended that users have an ultrawide monitor or a dual-monitor setup. Opening the 

meshes in additional windows is necessary because the meshes in the lineage tracing window have 

been simplified, so that only the vertices at the junctions between cells are present. Therefore, any 

modification of the meshes should be done on the original mesh rather than the mesh being 

checked for correspondence. 

The error correction process consists of repetitive steps of 1) zoom in on one region of the 

meshes of the lineage tracing window, 2) identify the sources of errors, 3) correct the error on the 

original mesh 1 or 2, 4) save the updated versions of the original mesh and load it in the lineage 

tracing MorphoGraphX window again, 5) re-run “Check Correspondence” to make sure all the cells 

in the region are blue, and 6) move on to the next region with errors in the lineage tracing window 

until all the errors are corrected. 

There are a few common types of errors in check correspondence: 

1. Parental labeling error or segmentation error on the original meshes. If either kind of error

occurs, the area on Mesh 1 will look like (Fig. A9a). Turn on the checkbox for Surface for
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both Stack 1 and 2, make sure Cells are selected, and the view option is set to Label. 

Compare the colors of the cells in that location to determine whether a cell was wrongly 

labeled, or the original mesh was wrongly segmented. 

o If the cells on Mesh 2 had the wrong parental label, repeat steps 8 to 10 in Part A 

(Parental labeling) but only for the cells with error. Make sure Stack 2 is active and save 

the parents’ labels by running Mesh → Lineage Tracking → Save parents under the 

Process tab. We recommend saving the new version of the parental labels as a new file, 

no matter how trivial the modification may have seemed to be.  

o If the error is due to segmentation error on the original mesh, it would be because either 

a cell on Mesh 1 is under-segmented or the cell on Mesh 2 is over-segmented. Check the 

original meshes as described in Step 5, and save the modified mesh as a new, separate 

file. 

2. Errors at the cell junctions. This is likely to be the most common error in Check 

Correspondence and the junctions in question will be indicated in Mesh 1. They are usually 

due to tiny differences in how neighboring cells connect to each other in Mesh 1 and 2 (Fig. 

A9b). Zoom in on the junction in question in both Mesh 1 and 2, compare check and 

uncheck the Mesh checkbox to identify which mesh should be corrected. Then use “Add 

label to selection ” on the left tool bar, then press Alt-key and click the cell that needs 

to be corrected. Then choose “Add current seed (Alt+N) ” from the left toolbar, use the 

left click of the mouse to fill in the junction. Then under the Process tab, run Mesh → Cell 

Mesh → Fix Corners Classic, and save the modified mesh as a new, separate file. 
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Figure A9. Examples of lineage tracing errors. (a) Two major types of errors. Left: Most likely due to incorrect 
parental labeling or in correct segmentation, e.g. Stack 1 is over-segmented, but only one of the cells can be 
mapped to Stack 2. Right: Most likely due to incorrect cell junctions. (b) An example of why junction error can 
occur. In Stack 1, Cell A and D were physically connected to each other but C and B were not, while in Stack 2, C 
and B were physically connected to each other. 

DATA ANALYSIS 

After all the errors are corrected, reload Mesh 1 and 2 to Stack 1 and 2, respectively. Make 

sure Stack 2 is active and the Parents box is checked. Under the Process tab, run Mesh → Lineage 

Tracking → Load parents and load the latest version of the parental tracing file. 

For all the heat maps, the scale of the values can be changed in Process → Mesh → Heat 

Map → Heat Map Range; the styles can be changed by clicking the Colors Editor  next to the 

view option of Cells in the Surface panel; and screenshots can be taken by clicking the Save 

screenshot  on the main toolbar. All the original images from Chapter 2 were saved as .PNG in 

2700 px (width) x 2500 px (height). 
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A. Heat maps of cell area expansion and cell proliferation 

1. To create a heat map for cell area expansion, under the Process tab, run Process → Mesh → 

Heat Map → Heat Map Classic. Select “Area” for the heat map type and “Geometry” for the 

visualization. Differences in various change map options can be found on the 

MorphoGraphX manual. Also select the “Change map” checkbox. This tells 

MorphoGraphX to make a heat map comparing Stack1 and Stack2. The heat map can be 

visualized on either the first (typically, Stack1) or second (Stack2) time point. For the growth 

sample here, select “Increasing” if Stack 1 (i.e. time-point1) is active or “Decreasing” if Stack 

2 (i.e. time-point 2) is active.  

2. To create a map of cell proliferation, make sure Stack 2 is active, and run Process → Mesh → 

Lineage Tracking→ Heat Map Proliferation.  

3. To create images such as Fig. A3 in Chapter 2, in which divided cells are highlighted on a cell 

area extension heat map, first run cell area expansion heat map on Stack 2. Check “Report to 

spreadsheet” so that the values of cell area expansion for each cell can be saved. Give the 

spreadsheet an informative name, such as “r8-A1-tp1_tp2-growth-allcells.csv”. Then create a 

map of cell proliferation by running Process → Mesh → Lineage Tracking→ Heat Map 

Proliferation. Subsequently, run Process → Mesh → Heat Map → Heat Map Select, change 

the range values: Lower Threshold to 2, Upper Threshold to 3 or higher. This step will select 

all the cells that have experienced cell division. Then go to Process → Mesh → Heat Map → 

Heat Map Load, load “r8-A1-tp1_tp2-growth-allcells.csv” as the Heat Map file, and make 

sure the Column to load is set as “Value”.  

4. The aesthetics of the growth heat map and cell outlines can be changed in the Main tab. To 

change the cell outlines, go to Main → Stack 1 → the Colors Editor  by the Mesh 
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panel. To change the heat map styles, go to Main → Stack 2 (if heat map is displayed on 

Stack 2) → the Colors Editor  by the Cells in the Surface panel. Sometimes the 

heatmap color scale appears to be incorrect on the screen. This is most likely to happen 

when both Stack 1 and Stack 2 are displaying heat maps, and the color scale of Stack 1 will 

cover the color scale of Stack 2. This can be simply solved by unclicking the Surface panel 

under Stack 1. 

B. Heat maps of principle direction of growth and anisotropy

1. Make sure the parental file has been loaded to Stack 2 and then switch to Stack 1 to

designate it as the active stack. Under the Process tab, run Mesh → Cell Axis → PDG →

Check Correspondence, No error should show up since the meshes have been corrected.

Make sure the active Stack is the stack that you want to display the heat map on, so if you

want to display heat map on time-point 2, make Stack 2 as the active stack. Then run Mesh

→ Cell Axis → PDG → Compute Growth Directions. The PDG values can also be saved by

running Mesh → Cell Axis → Cell Axis Save. Detailed explanations of the PDG parameters 

can be found in the MorphGraphX manual. 

2. To change the display of the PDG map, go to Mesh → Cell Axis → PDG → Display

Growth Directions. The PDG heat maps in Chapter 2 were displayed as Anisotropy, which

is the ratio between StretchMax and StretchMin. A ratio of 1 means no deformation, 2

means an elongation by 100%, 0.8 a shrinkage of 20%. The color and size of the PDG

vectors can also be modified. By default, vectors corresponding to expansion (stretch ratio >

1) are displayed in white, while red is used to draw the direction of shrinkage (stretch ratio <

1). The “Threshold” parameter is used to display PDGs axis only in cells for which the 
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anisotropy is above a given value. Since we save each image at a relatively high resolution 

(2700 x 2500), we found that a Line Width of at least 10 px is needed for good visualization 

on the final screenshot.  

 

PERSPECTIVES 

In this study, we presented the first quantitative live-imaging protocol of floral buds of A. 

coerulea, which offers considerable potential for application to other non-traditional plant systems. 

However, there is still room for improvement to obtain higher quality quantitative data. First, our 

samples were stained with propidium iodide (PI), which generally gave good signal in most of the 

tissue, but cells in the organ boundary regions were often under-stained. Repetitive long-term 

staining with PI is known to become toxic to tissues and thus slow growth (Grandjean et al., 2004; 

Bureau et al., 2018), which was also the primary factor that restricted the length of the analyzed 

developmental window. Further development of transgenic markers for the plasma membrane 

would help to solve these issues. Second, our analysis was limited to surface reconstruction of the 

cells, although the behavior of cells under the epidermal layer is an indispensable part of fully 

understanding meristem morphogenesis. Third, due to the imaging mechanisms of the available 

confocal microscope, cell walls perpendicular to the focal axis of the microscope were often not 

detected. Combined with the fact that cells at the organ boundary were often poorly stained, we 

were often unable to segment and analyze cells in many boundary regions on the abaxial side of 

some primordia. Except for the issue with PI staining, all of the other limitations described here are, 

in fact, challenges faced by similar studies in the established model systems (Rambaud-Lavigne & 

Hay, 2020; Prunet & Duncan, 2020). Fortunately, rapid development in microscopes that allow 

long-term, deep-tissue, minimally invasive scanning, as well as software developments that can 

segment and reconstruct multiple cell layers in 3D from the imaging data, are in progress. A 
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comprehensive understanding of "the genetics of geometry" (Coen et al., 2004) of morphogenesis in 

a diverse set of plant systems is hopefully underway. 
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Figure B1. Regions used for constructing growth alignment graphs. (a) Side view of a meristem overlayed with 
surface curvature heatmap. Dashed yellow line circled the region defined by the boundary of the ITP. (b) Side 
view of a meristem overlayed with surface curvature heatmap only with the regions that will be used to construct 
the growth alignment graphs. (c) Front view of (b). (d) Cell distance heatmap that was used to determine the 
center most cell of the region of interest, and the white arrow represented the axis that would be used to 
construct the growth alignment graphs. Scale bars = 20 µm.  

 
 
Table B1. Pair-wise Tukey’s HSD test for cell area expansion rates and average cell division numbers between 
different TP intervals for the growth alignment graphs. Each interval is abbreviated as TP(first TP)(second TP): e.g. 
TP12 stands for the interval between TP1 to TP2. Cells in grey were pairs that have no significant difference. 
 

  Cell area expansion rate Average cell division 
 

pair Difference 
Lower 
bound 

Upper 
bound 

Adjusted 
P-value Difference 

Lower 
bound 

Upper 
bound 

Adjusted 
P-value 

Bin1 

TP12-TP23 -0.1038 -0.1258 -0.0819 0.0000 -0.0004 -0.0291 0.0283 1.0000 
TP12-TP34 -0.1124 -0.1355 -0.0894 0.0000 -0.0308 -0.0610 -0.0006 0.0429 
TP12-TP45 0.1128 0.0906 0.1351 0.0000 0.0369 0.0078 0.0661 0.0050 
TP12-TP56 0.0838 0.0596 0.1079 0.0000 0.0486 0.0170 0.0802 0.0003 
TP23-TP34 -0.0086 -0.0305 0.0134 0.8236 -0.0304 -0.0592 -0.0017 0.0321 
TP23-TP45 0.2167 0.1956 0.2378 0.0000 0.0373 0.0097 0.0650 0.0021 
TP23-TP56 0.1876 0.1645 0.2107 0.0000 0.0490 0.0188 0.0792 0.0001 
TP34-TP45 0.2252 0.2029 0.2476 0.0000 0.0677 0.0385 0.0970 0.0000 
TP34-TP56 0.1962 0.1720 0.2204 0.0000 0.0794 0.0477 0.1111 0.0000 
TP56-TP45 0.0291 0.0057 0.0525 0.0064 -0.0116 -0.0423 0.0190 0.8382 

Bin2 

TP12-TP23 -0.0640 -0.0880 -0.0400 0.0000 0.0020 -0.0394 0.0435 0.9999 
TP12-TP34 -0.0073 -0.0326 0.0179 0.9331 0.0039 -0.0397 0.0476 0.9992 
TP12-TP45 0.2320 0.2076 0.2563 0.0000 0.0671 0.0250 0.1092 0.0001 
TP12-TP56 0.2083 0.1818 0.2347 0.0000 0.0760 0.0303 0.1217 0.0001 
TP23-TP34 0.0567 0.0326 0.0808 0.0000 0.0019 -0.0396 0.0435 0.9999 
TP23-TP45 0.2960 0.2729 0.3191 0.0000 0.0651 0.0252 0.1050 0.0001 
TP23-TP56 0.2723 0.2470 0.2976 0.0000 0.0740 0.0303 0.1177 0.0000 
TP34-TP45 0.2393 0.2149 0.2637 0.0000 0.0632 0.0210 0.1054 0.0004 
TP34-TP56 0.2156 0.1891 0.2421 0.0000 0.0721 0.0263 0.1179 0.0002 
TP56-TP45 0.0237 -0.0019 0.0494 0.0857 -0.0089 -0.0532 0.0354 0.9821 

Bin3 
TP12-TP23 -0.0287 -0.0589 0.0015 0.0712 0.0283 -0.0249 0.0816 0.5940 
TP12-TP34 0.0352 0.0034 0.0670 0.0213 0.0762 0.0201 0.1323 0.0020 
TP12-TP45 0.2703 0.2396 0.3009 0.0000 0.1311 0.0771 0.1852 0.0000 
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TP12-TP56 0.2411 0.2079 0.2744 0.0000 0.0736 0.0150 0.1322 0.0056 
TP23-TP34 0.0639 0.0337 0.0942 0.0000 0.0479 -0.0055 0.1012 0.1030 
TP23-TP45 0.2990 0.2700 0.3281 0.0000 0.1028 0.0516 0.1541 0.0000 
TP23-TP56 0.2699 0.2381 0.3017 0.0000 0.0453 -0.0108 0.1013 0.1784 
TP34-TP45 0.2351 0.2044 0.2658 0.0000 0.0549 0.0008 0.1091 0.0449 
TP34-TP56 0.2059 0.1726 0.2393 0.0000 -0.0026 -0.0614 0.0561 1.0000 
TP56-TP45 0.0292 -0.0031 0.0614 0.0981 0.0575 0.0007 0.1144 0.0455 

Bin4 

TP12-TP23 0.0216 -0.0218 0.0650 0.6553 -0.0189 -0.0778 0.0400 0.9058 
TP12-TP34 -0.0166 -0.0624 0.0291 0.8588 0.0258 -0.0362 0.0878 0.7877 
TP12-TP45 0.2234 0.1793 0.2675 0.0000 0.0787 0.0189 0.1385 0.0031 
TP12-TP56 0.1642 0.1163 0.2120 0.0000 -0.0769 -0.1418 -0.0120 0.0108 
TP23-TP34 -0.0382 -0.0818 0.0053 0.1162 0.0447 -0.0143 0.1037 0.2345 
TP23-TP45 0.2018 0.1600 0.2436 0.0000 0.0976 0.0409 0.1542 0.0000 
TP23-TP56 0.1426 0.0968 0.1883 0.0000 -0.0580 -0.1200 0.0040 0.0798 
TP34-TP45 0.2401 0.1959 0.2843 0.0000 0.0529 -0.0070 0.1128 0.1131 
TP34-TP56 0.1808 0.1329 0.2287 0.0000 -0.1027 -0.1677 -0.0377 0.0002 
TP56-TP45 0.0593 0.0129 0.1057 0.0045 0.1556 0.0927 0.2184 0.0000 

Bin5 

TP12-TP23 0.0216 -0.0218 0.0650 0.6553 0.0176 -0.0399 0.0752 0.9195 
TP12-TP34 -0.0166 -0.0624 0.0291 0.8588 0.0462 -0.0144 0.1068 0.2279 
TP12-TP45 0.2234 0.1793 0.2675 0.0000 0.0652 0.0068 0.1237 0.0197 
TP12-TP56 0.1642 0.1163 0.2120 0.0000 -0.0583 -0.1217 0.0052 0.0892 
TP23-TP34 -0.0382 -0.0818 0.0053 0.1162 0.0286 -0.0290 0.0863 0.6566 
TP23-TP45 0.2018 0.1600 0.2436 0.0000 0.0476 -0.0077 0.1030 0.1303 
TP23-TP56 0.1426 0.0968 0.1883 0.0000 -0.0759 -0.1365 -0.0153 0.0058 
TP34-TP45 0.2401 0.1959 0.2843 0.0000 0.0190 -0.0395 0.0775 0.9021 
TP34-TP56 0.1808 0.1329 0.2287 0.0000 -0.1045 -0.1680 -0.0410 0.0001 
TP56-TP45 0.0593 0.0129 0.1057 0.0045 0.1235 0.0620 0.1849 0.0000 

Bin6 

TP12-TP23 -0.0409 -0.1025 0.0207 0.3659 0.0002 -0.0545 0.0548 1.0000 
TP12-TP34 -0.0157 -0.0806 0.0492 0.9645 0.0278 -0.0298 0.0853 0.6813 
TP12-TP45 -0.0431 -0.1057 0.0194 0.3274 -0.0081 -0.0636 0.0473 0.9946 
TP12-TP56 0.0883 0.0204 0.1562 0.0036 -0.1079 -0.1681 -0.0476 0.0000 
TP23-TP34 0.0252 -0.0365 0.0869 0.7995 0.0276 -0.0272 0.0823 0.6438 
TP23-TP45 -0.0022 -0.0615 0.0570 1.0000 -0.0083 -0.0609 0.0443 0.9928 
TP23-TP56 0.1292 0.0643 0.1940 0.0000 -0.1080 -0.1656 -0.0505 0.0000 
TP34-TP45 -0.0274 -0.0901 0.0353 0.7557 -0.0359 -0.0915 0.0197 0.3965 
TP34-TP56 0.1040 0.0360 0.1720 0.0003 -0.1356 -0.1959 -0.0753 0.0000 
TP56-TP45 -0.1314 -0.1972 -0.0656 0.0000 0.0997 0.0413 0.1581 0.0000 
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Figure C1: SWN and the position of flowers on inflorescences. Positions of flowers on inflorescences have no 
significant influence on the SWN among the F2s, but do differ in the parental species, where terminal flowers tend 
to have higher SWN.  
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Figure C2: F1-parent-of-origin has a significant impact on the distribution of SWN in their respective F2 progeny. 
Density ridgeline plots showing the distribution of SWN of F2s of different F1 parents.  
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Figure C3: Distribution of the SD of SWN among the parental and F2 populations. (a) Histogram showing that both 
parents and the F2s had a small number of individuals showing 0 variation (SD=0) in SWN while the remaining 
individuals display a large variation in SWN. (b) Density ridgeline plots showing the same patterns of SD of SWN 
distribution regardless of F1-parent-of-origin. (c) SD=0 is not an artifact of individuals with fewer flowers counted. 
There are individuals exhibiting SD=0 in SWN regardless of how many flowers were counted per plant.  
 
 

 
Figure C4: Diagram (left) and summary statistics (right) of the genetic map. 
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Figure C5: Confirmation of QTL underlying SWN variation. (a) No significant interaction between covariant and QTL 
was detected. (b) Controlling for potential QTL on chromosome 2 did not provide evidence to support the presence 
of two unlinked QTL. The real QTL on chromosome 2 was named Q2, the potential second QTL was named Q2’. 
When Q2 was controlled, the evidence for Q2’ disappeared, but when Q2’ was controlled, the evidence for Q2 
stayed significant. (c) QTL interaction between Q1 x Q6, and Q3 x Q7. C: A. canadensis allele; B: A. brevistyla allele. In 
(a) and (b), the LOD scores were from the standard interval mapping rather than the full QTL model, which assumes
the presence of a single QTL and could not include QTL interactions. This is the reason why the LOD score
distributions appear to be a bit different from Fig. 4a.

Figure C6: Effect plots of the markers that have the highest LOD score under each QTL. C: A. canadensis allele; B: A. 
brevistyla allele 
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Figure C7: Gene phylogeny for AqROXYa. Neighbor-joining phylogeny of ROXY homologs using amino acid alignment. 
Species included in this phylogeny and the prefix of their gene identifiers: A. coerulea (“Aqcoe”), Vitis vinifera 
(“VIT”), A. thaliana (“AT”), Medicago truncatula (“Medtr”), Oryza sativa (“LOC_Os”), and Brachypodium distachyon 
(“Bradi”). All sequences were obtained from Phytozome (https://phytozome-next.jgi.doe.gov/). Homologs in A. 
thaliana and A. coerulea are indicated by green and purple dots, respectively. AqROXYa is highlighted in purple. This 
gene phylogeny is consistent with previously published ROXY homologs in A. thaliana (Li et al., 2009). 
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Figure C8: Gene phylogeny for AqATH1. Neighbor-joining phylogeny of BEL family members. Species included in this 
phylogeny and the prefix of their gene identifiers: A. coerulea (“Aqcoe”), Vitis vinifera (“GSVIVG”), A. thaliana (“AT”), 
and Oryza sativa (“LOC_Os”). All sequences were obtained from Phytozome (https://phytozome-next.jgi.doe.gov/). 
Homologs in A. thaliana and A. coerulea are indicated by green and purple dots, respectively. AqATH1 is highlighted 
in purple.  
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Table C1. Pairwise comparison of FM widths through early developmental stages. grp1=group1, grp2=group2 in the 
pairwise comparison. B: A. brevistyla, C: A. canadensis. Numbers in the parenthesis represented the number of 
stamen whorls initiated in the FM. Comparisons are conducted using the Wilcoxon tests and p-values are adjusted 
(p.adj) using the Bonferroni test. Pairs that are not significantly different from each other are shaded in light grey. n: 
number of the sections measured for each group. p.adj.sig: symbols indicating the adjusted p-values in the pairwise 
comparison; ns: not significant; *: p<0.05; **: p<0.01; ***: p<0.001; ****: p<0.0001. 

grp1 grp2 
n 
(grp1) 

n 
(grp2) 

mean 
(µm, grp1) 

mean 
(µm, grp2) p p.adj

p.adj.
sig

By 
stages 

B (0~2) C (0~2) 37 39 147.06 156.13 0.004 0.019 * 
B (2~4) C (2~4) 20 35 171.57 172.92 0.8 1 ns 

B (4~6) C (4~6) 15 15 161.60 186.78 5.16E-08 2.58E-07 **** 
B (6~7) C (6~7) 16 17 179.06 197.29 4.12E-04 0.00206 ** 
B (>=8) C (>=8) 20 46 174.68 191.67 4.28E-06 2.14E-05 **** 

By 
species 

B (0~2) B (2~4) 37 20 147.06 171.57 1.42E-09 2.84E-08 **** 
B (0~2) B (4~6) 37 15 147.06 161.60 3.17E-05 6.34E-04 *** 
B (0~2) B (6~7) 37 16 147.06 179.06 2.54E-08 5.08E-07 **** 

B (0~2) B (>=8) 37 20 147.06 174.68 6.46E-10 1.29E-08 **** 
B (2~4) B (4~6) 20 15 171.57 161.60 0.005 0.1 ns 
B (2~4) B (6~7) 20 16 171.57 179.06 0.157 1 ns 
B (2~4) B (>=8) 20 20 171.57 174.68 0.425 1 ns 
B (4~6) B (6~7) 15 16 161.60 179.06 8.96E-04 0.018 * 
B (4~6) B (>=8) 15 20 161.60 174.68 0.002 0.04 * 

B (6~7) B (>=8) 16 20 179.06 174.68 0.381 1 ns 
C (0~2) C (2~4) 39 35 156.13 172.92 1.96E-06 3.92E-05 **** 
C (0~2) C (4~6) 39 15 156.13 186.78 6.93E-12 1.39E-10 **** 
C (0~2) C (6~7) 39 17 156.13 197.29 2.04E-14 4.08E-13 **** 
C (0~2) C (>=8) 39 46 156.13 191.67 4.31E-19 8.62E-18 **** 
C (2~4) C (4~6) 35 15 172.92 186.78 2.97E-04 5.94E-03 ** 

C (2~4) C (6~7) 35 17 172.92 197.29 3.12E-09 6.24E-08 **** 
C (2~4) C (>=8) 35 46 172.92 191.67 1.56E-08 3.12E-07 **** 
C (4~6) C (6~7) 15 17 186.78 197.29 0.005 0.1 ns 
C (4~6) C (>=8) 15 46 186.78 191.67 0.169 1 ns 
C (6~7) C (>=8) 17 46 197.29 191.67 0.057 1 ns 
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Table C2: No significant evidence supporting the presence of a second QTL on any chromosome. The two-
dimensional genome scan method scans for all marker pairs of a given chromosome and calculate the LOD scores of 
the potential two-QTL models based on the marker pairs. The LOD values shown in the table for each chromosome 
are the highest LOD scores between all pairwise markers of a given chromosome.  
LOD.fv1: the log10 likelihood ratio comparing the two-QTL full model (including both additive effects and 
interactions) to the one-QTL model. Large LOD.fv1 scores indicate evidence for a second QTL, allowing for the 
possibility of interaction.  
LOD.av1: the log10 likelihood ratio comparing the two-QTL model but only considering additive effects to the one-
QTL model. Large LOD.av1 scores indicate evidence for a second QTL, assuming no interaction.  
LOD.int: the difference between LOD.fv1 and LOD.av1, indicating evidence for interactions between potential QTL.  
“10% sig cut off” are the values of LOD.fv1, LOD.av1, and LOD.int above the 90% of their respective distributions 
generated from 1000 permutations. LOD values that are bigger than the 10% cut off are considered significant. 
 

 LOD.fv1 LOD.av1 LOD.int 
Chromosome 1 3.69 1.01 2.69 
Chromosome 2 3.86 2.31 1.55 
Chromosome 3 2.71 2.47 0.24 
Chromosome 4 3.65 2.21 1.44 
Chromosome 5 2.83 1.71 1.12 
Chromosome 6 3.24 1.15 2.08 
Chromosome 7 3.68 2.20 1.48 
10% sig cut off 5.99 5.04 5.25 

 
 
Table C3: Summary of number of genes under each potential QTL. Percentages shown in the parentheses are the 
percentage of the number of genes found in the RNA-seq data (Min & Kramer, 2020) to the total number of genes 
that are in the respective genomic interval. A gene was considered as expressed if its transcript had more than 1 
million read counts in more than 1 samples in the RNA-seq experiment. 
 

QTL Chr  size 
(Mb) 

Interval on the genome No. of 
genes 

Exp at any 
RNAseq stage 

Q1 1 6 38,000,001..44,000,000 964 676 (70.12%) 
Q2 2 36.5 3,500,001.. 40,000,000 3242 2315 (71.41%) 
Q3 3 26.5 8,000,001..34,500,000 1844 1265 (68.60%) 
Q4 4 3.8 2,000,001..5,800,000 383 176 (46.21%) 
Q5 5 26.5 9,000,001..35,500,000 1919 1393 (72.59%) 
Q6 6 1.5 6,000,001..7,500,000 226 170 (75.22%) 
Q7 7 2.5 7,000,001..9,500,000 315 242 (76.83%) 
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Table C4: Expressed genes under Q4. A gene was considered as expressed if its transcript had more than 1 million 
read counts in more than 1 samples in the RNA-seq experiment (Min & Kramer, 2020). Best.hit.At: Top BLAST hit A. 
thaliana gene identifier. Genes under the 1 Mb region that contained the marker with the highest LOD are 
highlighted in blue.  
 

Locus ID Best.hit.At Symbol Annotation 
Aqcoe4G024000 AT4G18960 AG1 K-box region and MADS-box transcription factor family protein  
Aqcoe4G024300 AT3G58770 AG1 K-box region and MADS-box transcription factor family protein  
Aqcoe4G024600 AT2G42790 CSY3 citrate synthase 3 
Aqcoe4G024700 AT5G59840  Ras-related small GTP-binding family protein 
Aqcoe4G024800 AT5G65750  2-oxoglutarate dehydrogenase, E1 component 
Aqcoe4G025200 AT3G54950 PLA  patatin-like protein 6 
Aqcoe4G025400 AT1G07650  Leucine-rich repeat transmembrane protein kinase 
Aqcoe4G025600 AT1G29050 TBL38 TRICHOME BIREFRINGENCE-LIKE 38 
Aqcoe4G026000 AT3G14840 LIK1 Leucine-rich repeat transmembrane protein kinase 
Aqcoe4G026500 AT1G53440  Leucine-rich repeat transmembrane protein kinase 
Aqcoe4G026600 AT1G53440  Leucine-rich repeat transmembrane protein kinase 
Aqcoe4G027000 AT4G19840 PP2-A1 phloem protein 2-A1 
Aqcoe4G027100 AT1G78700 BEH4 BES1/BZR1 homolog 4 
Aqcoe4G027200 AT1G53460   
Aqcoe4G027300 AT4G18880 HSFA4A heat shock transcription factor A4A 
Aqcoe4G027400 AT1G78680 ATGGH2 gamma-glutamyl hydrolase 2 
Aqcoe4G027500    
Aqcoe4G027900 AT1G78680 ATGGH2 gamma-glutamyl hydrolase 2 
Aqcoe4G028000    
Aqcoe4G028600 AT1G06410 TPS7 trehalose-phosphatase/synthase 7 
Aqcoe4G028700 AT1G53380  Plant protein of unknown function (DUF641) 
Aqcoe4G028800 AT5G61970  signal recognition particle-related / SRP-related 
Aqcoe4G028900 AT5G41020  myb family transcription factor 
Aqcoe4G029100 AT2G30950 FTSH2 FtsH extracellular protease family 
Aqcoe4G029200 AT4G18820  AAA-type ATPase family protein 
Aqcoe4G029300 AT1G29340 ATPUB17 plant U-box 17 
Aqcoe4G029700    
Aqcoe4G030000 AT2G42770  Peroxisomal membrane 22 kDa (Mpv17/PMP22) family protein 

Aqcoe4G031000 AT3G19720 ARC5 P-loop containing nucleoside triphosphate hydrolases 
superfamily protein 

Aqcoe4G031200    
Aqcoe4G031300 AT4G18800 RABA1D RAB GTPase homolog A1D 
Aqcoe4G031600 AT1G11330  S-locus lectin protein kinase family protein 
Aqcoe4G031700 AT2G42760   
Aqcoe4G031800    
Aqcoe4G031900 AT2G42750  DNAJ heat shock N-terminal domain-containing protein 
Aqcoe4G032000    
Aqcoe4G032200 AT5G45760  Transducin/WD40 repeat-like superfamily protein 
Aqcoe4G032300 AT4G18780 CESA8 cellulose synthase family protein 
Aqcoe4G032400 AT3G14067  Subtilase family protein 
Aqcoe4G032600 AT5G01750  Protein of unknown function (DUF567) 

Aqcoe4G032900 AT2G27260  
Late embryogenesis abundant (LEA) hydroxyproline-rich 
glycoprotein family 

Aqcoe4G033500 AT5G13690 NAGLU alpha-N-acetylglucosaminidase family / NAGLU family 
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Aqcoe4G034000 AT5G22870 Late embryogenesis abundant (LEA) hydroxyproline-rich 
glycoprotein family 

Aqcoe4G034100 AT4G35490 MRPL11 mitochondrial ribosomal protein L11 
Aqcoe4G034500 AT4G18750 DOT4 Pentatricopeptide repeat (PPR) superfamily protein 
Aqcoe4G034700 
Aqcoe4G034900 AT4G18750 DOT4 Pentatricopeptide repeat (PPR) superfamily protein 
Aqcoe4G035000 AT5G35370 S-locus lectin protein kinase family protein
Aqcoe4G035500 AT5G43470 HRT Disease resistance protein (CC-NBS-LRR class) family 
Aqcoe4G035600 AT1G78770 APC6 anaphase promoting complex 6 
Aqcoe4G035700 AT4G14440 ATECI3 3-hydroxyacyl-CoA dehydratase 1
Aqcoe4G035800 AT3G14570 ATGSL04 glucan synthase-like 4 
Aqcoe4G035900 AT3G25780 AOC3 allene oxide cyclase 3 
Aqcoe4G036000 AT2G30970 ASP1 aspartate aminotransferase 1 
Aqcoe4G036100 AT5G16860 Tetratricopeptide repeat (TPR)-like superfamily protein 
Aqcoe4G036200 AT3G59500 Integral membrane HRF1 family protein 
Aqcoe4G036300 AT5G45780 Leucine-rich repeat protein kinase family protein 
Aqcoe4G036400 AT2G30980 BIL1 SHAGGY-related protein kinase dZeta 
Aqcoe4G036600 AT3G58690 Protein kinase superfamily protein 
Aqcoe4G036700 AT5G26830 Threonyl-tRNA synthetase 
Aqcoe4G036800 AT4G20020 
Aqcoe4G036900 
Aqcoe4G038100 
Aqcoe4G038200 

Aqcoe4G038400 AT1G06620 2-oxoglutarate (2OG) and Fe(II)-dependent oxygenase
superfamily protein

Aqcoe4G038600 AT2G34960 CAT5 cationic amino acid transporter 5 
Aqcoe4G039000 AT4G17760 damaged DNA binding;exodeoxyribonuclease IIIs 
Aqcoe4G039600 AT5G48620 Disease resistance protein (CC-NBS-LRR class) family 
Aqcoe4G040000 AT3G06240 F-box family protein
Aqcoe4G040200 AT5G48620 Disease resistance protein (CC-NBS-LRR class) family 
Aqcoe4G040300 AT2G42690 alpha/beta-Hydrolases superfamily protein 
Aqcoe4G040400 AT1G53530 Peptidase S24/S26A/S26B/S26C family protein 
Aqcoe4G040500 AT5G45840 Leucine-rich repeat protein kinase family protein 
Aqcoe4G040600 AT1G78810 
Aqcoe4G040700 AT2G42670 Protein of unknown function (DUF1637) 
Aqcoe4G040800 
Aqcoe4G040900 AT3G14910 
Aqcoe4G041300 AT5G17540 HXXXD-type acyl-transferase family protein 
Aqcoe4G042300 AT5G17540 HXXXD-type acyl-transferase family protein 
Aqcoe4G042400 AT1G09850 XBCP3 xylem bark cysteine peptidase 3 
Aqcoe4G042500 
Aqcoe4G042700 AT3G58640 Mitogen activated protein kinase kinase kinase-related 
Aqcoe4G043000 AT1G14990 
Aqcoe4G043100 AT1G29195 
Aqcoe4G043200 AT5G54750 Transport protein particle (TRAPP) component 
Aqcoe4G043300 AT3G04600 Nucleotidylyl transferase superfamily protein 
Aqcoe4G043400 AT3G04040 
Aqcoe4G043700 AT3G58630 sequence-specific DNA binding transcription factors 
Aqcoe4G043800 AT2G42610 LSH10 Protein of unknown function (DUF640) 
Aqcoe4G043900 AT1G17020 ATSRG1 senescence-related gene 1 
Aqcoe4G044000 
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Aqcoe4G044200 AT1G29170 SCAR3 Encodes a member of the SCAR family. 
Aqcoe4G045300 AT5G32440 Ubiquitin system component Cue protein 
Aqcoe4G045600 AT1G06630 F-box/RNI-like superfamily protein
Aqcoe4G045700 AT5G10770 Eukaryotic aspartyl protease family protein 
Aqcoe4G046200 AT5G10870 ATCM2 chorismate mutase 2 
Aqcoe4G046500 AT3G14940 ATPPC3 phosphoenolpyruvate carboxylase 3 
Aqcoe4G047100 AT1G29930 AB140 chlorophyll A/B binding protein 1 
Aqcoe4G047300 
Aqcoe4G047400 AT4G10780 LRR and NB-ARC domains-containing disease resistance protein 
Aqcoe4G047500 AT1G29930 AB140 chlorophyll A/B binding protein 1 
Aqcoe4G047600 AT1G29120 Hydrolase-like protein family 
Aqcoe4G047700 
Aqcoe4G047800 
Aqcoe4G048000 AT1G16890 UBC13B ubiquitin-conjugating enzyme 36 
Aqcoe4G048200 AT2G42580 TTL3 tetratricopetide-repeat thioredoxin-like 3 
Aqcoe4G048400 AT1G22870 Protein kinase family protein with ARM repeat domain 

Aqcoe4G048700 AT5G61190 
putative endonuclease or glycosyl hydrolase with C2H2-type 
zinc finger domain 

Aqcoe4G048800 AT4G16130 ARA1 arabinose kinase 
Aqcoe4G049500 AT2G15480 UGT73B5 UDP-glucosyl transferase 73B5 
Aqcoe4G049700 AT4G14850 LOI1 Pentatricopeptide repeat (PPR) superfamily protein 
Aqcoe4G049800 AT4G17410 DWNN domain, a CCHC-type zinc finger 

Aqcoe4G050000 AT4G33355 Bifunctional inhibitor/lipid-transfer protein/seed storage 2S 
albumin superfamily protein 

Aqcoe4G050300 AT1G61180 LRR and NB-ARC domains-containing disease resistance protein 
Aqcoe4G050700 AT3G09270 GSTU8 glutathione S-transferase TAU 8 
Aqcoe4G050800 AT3G58610 ketol-acid reductoisomerase 

Aqcoe4G050900 AT3G14980 ROS 
Acyl-CoA N-acyltransferase with RING/FYVE/PHD-type zinc 
finger protein 

Aqcoe4G051100 AT5G45900 APG7, ThiF family protein 
Aqcoe4G051300 AT1G53250 
Aqcoe4G051400 
Aqcoe4G051500 
Aqcoe4G051600 
Aqcoe4G051700 AT1G78750 F-box/RNI-like superfamily protein
Aqcoe4G051900 AT3G59200 F-box/RNI-like superfamily protein
Aqcoe4G052100 AT2G31130 
Aqcoe4G052600 AT4G19050 NB-ARC domain-containing disease resistance protein 
Aqcoe4G052900 AT3G50120 Plant protein of unknown function (DUF247) 
Aqcoe4G053000 AT2G34090 MEE18 maternal effect embryo arrest 18 
Aqcoe4G053100 AT3G59010 PME61 pectin methylesterase 61 
Aqcoe4G053200 AT1G56000 FAD/NAD(P)-binding oxidoreductase family protein 
Aqcoe4G053300 AT1G56000 FAD/NAD(P)-binding oxidoreductase family protein 
Aqcoe4G053600 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G053900 AT1G56000 FAD/NAD(P)-binding oxidoreductase family protein 
Aqcoe4G054200 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G054300 AT2G47730 ATGSTF8 glutathione S-transferase phi 8 
Aqcoe4G054400 AT1G55980 FAD/NAD(P)-binding oxidoreductase family protein 
Aqcoe4G054700 
Aqcoe4G054800 AT1G17120 CAT8 cationic amino acid transporter 8 
Aqcoe4G054900 AT5G48620 Disease resistance protein (CC-NBS-LRR class) family 
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Aqcoe4G055300 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G055400 
Aqcoe4G055600 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G055800 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G055900 AT5G44430 PDF1.2c plant defensin 1.2C 

Aqcoe4G056100 AT3G25750 F-box family protein with a domain of unknown function
(DUF295)

Aqcoe4G056200 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G056300 AT5G44430 PDF1.2c plant defensin 1.2C 
Aqcoe4G056500 AT1G16670 Protein kinase superfamily protein 
Aqcoe4G056800 
Aqcoe4G056900 AT1G29050 TBL38 TRICHOME BIREFRINGENCE-LIKE 38 
Aqcoe4G057100 AT3G25690 CHUP1 Hydroxyproline-rich glycoprotein family protein 
Aqcoe4G057300 AT1G78830 Curculin-like (mannose-binding) lectin family protein 

Aqcoe4G057400 AT1G78850 
D-mannose binding lectin protein with Apple-like carbohydrate-
binding domain

Aqcoe4G057900 AT5G51040 
Aqcoe4G058000 AT3G23760 
Aqcoe4G058100 
Aqcoe4G058300 AT5G20040 ATIPT9 isopentenyltransferase 9 
Aqcoe4G058400 AT5G45910 GDSL-like Lipase/Acylhydrolase superfamily protein 
Aqcoe4G058500 AT1G53240 mMDH1 Lactate/malate dehydrogenase family protein 
Aqcoe4G058600 AT1G06230 GTE4 global transcription factor group E4 

Aqcoe4G058700 AT1G50410 FRG SNF2 domain-containing protein / helicase domain-containing 
protein /zinc finger protein-related 

Aqcoe4G058900 AT5G44430 PDF1.2c plant defensin 1.2C 

Aqcoe4G059300 AT1G73170 
P-loop containing nucleoside triphosphate hydrolases
superfamily protein

Aqcoe4G059500 AT1G73170 
P-loop containing nucleoside triphosphate hydrolases
superfamily protein

Aqcoe4G059800 AT4G18480 CH-42 P-loop containing nucleoside triphosphate hydrolases
superfamily protein

Aqcoe4G059900 AT2G33980 NUDT22 nudix hydrolase homolog 22 
Aqcoe4G060500 AT3G24800 PRT1 proteolysis 1 
Aqcoe4G060600 
Aqcoe4G060700 
Aqcoe4G060900 
Aqcoe4G061000 

Aqcoe4G061200 AT1G53210 
sodium/calcium exchanger family protein / calcium-binding EF 
hand family protein 

Aqcoe4G061400 AT5G42820 U2AF35B Zinc finger C-x8-C-x5-C-x3-H type family protein 
Aqcoe4G061800 AT5G15380 DRM1 domains rearranged methylase 1 
Aqcoe4G062100 AT1G11950 Transcription factor jumonji (jmjC) domain-containing protein 
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Table C5: Candidate genes under QTL. 

Chr Locus ID Gene name Genomic location (5’) 
1 Aqcoe1G411100 AqLAS 39,117,500 
1 Aqcoe1G456700 AqPTL 42,021,250 
2 Aqcoe2G139400 AqZPR3a 12,741,500 
3 Aqcoe3G159700 AqROXYa 13,927,500 
4 Aqcoe4G024000 AqAG1 2,002,500 
5 Aqcoe5G235700 AqSEU 15,620,000 
5 Aqcoe5G237200 AqAGO5a 15,842,500 
6 Aqcoe6G121000 AqHAN 6,619,000 
7 Aqcoe7G132200 AqATH1 8,222,500 

Table C6: Primers used for constructing in situ hybridization probes. 

Locus ID Gene 
name 

Forward primer (5’to 3’) Reverse primer (5’ to 3’) Product 
size 

Aqcoe2G057900 AqWUS TGTCGAGCCATATCCATTTTTCAAC TCATGCATGATGTTATCAGTCCTTTG 300 bp 

Aqcoe2G139400 AqZPR3a CAGAGCTTTACTTGAGGAATTTG GAACTCTTGGGATTTGGAGA 196 bp 

Aqcoe3G159700 AqROXYa AAATACCAAACACACCAACT TTGACATGTATGACAACTCC 220 bp 

Aqcoe7G132200 AqATH1 GGCAGTTCTAGTTCTATTGC TGAAGCTGTTGAAACATTTA 147 bp 
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